DIGITAL CAMERA
C-770 Ultra Zoom

REFERENCE MANUAL

<Click Here>

CAMERA OPERATION MANUAL
Explanation of digital camera functions and operating instructions.

DIGITAL CAMERA - PC CONNECTION OPERATION MANUAL
Explanation of how to download images between your digital camera and PC.
Thank you for purchasing an Olympus digital camera. Before you start to use your new camera, please read these instructions carefully to enjoy optimum performance and a longer service life. Keep this manual in a safe place for future reference.

- We recommend that you take test shots to get accustomed to your camera before taking important photographs.
- In the interest of continually improving products, Olympus reserves the right to update or modify information contained in this manual.
For customers in North and South America

For customers in USA

Declaration of Conformity
Model Number : C-770 Ultra Zoom
             RM-2 (Remote control)
Trade Name   : OLYMPUS
Responsible Party : Olympus America Inc.
Address      : 2 Corporate Center Drive, Melville, New York
             11747-3157 U.S.A.
Telephone Number : 1-631-844-5000

Tested To Comply With FCC Standards
FOR HOME OR OFFICE USE

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference.
(2) This device must accept any interference received, including interference that may cause undesired operation.

For customers in Canada

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

For customers in Europe

“CE” mark indicates that this product complies with the European requirements for safety, health, environment and customer protection.
“CE” mark cameras are intended for sales in Europe.

Trademarks

• IBM is a registered trademark of International Business Machines Corporation.
• Microsoft and Windows are registered trademarks of Microsoft Corporation.
• Macintosh is a trademark of Apple Computer Inc.
• All other company and product names are registered trademarks and/or trademarks of their respective owners.
• The standards for camera file systems referred to in this manual are the “Design Rule for Camera File System/DCF” standards stipulated by the Japan Electronics and Information Technology Industries Association (JEITA).
How to use this manual

This manual contains a list of contents, an index and a list of menus to enable you to easily find the function that you want to use or find out more about.

**Using the list of contents**  P.6

All the titles in the manual are listed here, grouped into chapters. There is a chapter containing information to read before using your camera for the first time, a chapter that describes basic shooting procedures, etc.

For example....

when you want to view a picture that you have taken
Go to Chapter 7 Playback and look for the page titled “Viewing still pictures....124”.

**Using the index**  P.229

The index lists the camera’s functions, parts and terms used in this manual in alphabetical order. When you come across a word in the manual that you do not understand or when you want to find a certain term, use the index to find the page(s) where it is used.

For example....

when you want to know more about ESP metering
Go to the index at the end of the manual and look under E for “ESP metering....85, 220”.

**Using the list of menus**  P.223

The camera’s menus are listed in the form of a tree according to tab and show the setting options for each available function. First find the menu you are looking for, and then look for the reference page number for each function.

For example....

when you want to find out which setting to choose for WB
Go through the menus until you find WB and look for the reference page number.
How to use this manual

A sample page is shown below to explain how to read the instructions in this manual. Look at it carefully before taking or viewing pictures. See the reference pages for further details on how to use the power switch or menus.

1. Slide the power switch to one of these symbols.
   “Power on/off” (P.25)

2. If you set the power switch to in step 1, set the mode dial to one of these symbols.
   “Shooting modes” (P.47)

3. Follow the arrows to perform menu operations.
   “How to use the menus” (P.35)

This shows the buttons and button positions for the function concerned.

This sample page is only for your reference. It may differ from the actual page in this manual.
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Composition of the manual</td>
<td></td>
</tr>
<tr>
<td><strong>Introduction of the camera’s functions</strong></td>
<td></td>
</tr>
<tr>
<td>Getting started</td>
<td>P.18</td>
</tr>
<tr>
<td>Using the menus</td>
<td>P.34</td>
</tr>
<tr>
<td><strong>Basic Photography</strong></td>
<td></td>
</tr>
<tr>
<td>Shooting basics</td>
<td>P.47</td>
</tr>
<tr>
<td><strong>Advanced Photography</strong></td>
<td></td>
</tr>
<tr>
<td>Flash</td>
<td>P.61</td>
</tr>
<tr>
<td>Advanced shooting</td>
<td>P.73</td>
</tr>
<tr>
<td>Adjusting the image quality and exposure</td>
<td>P.106</td>
</tr>
<tr>
<td><strong>For playing back and editing pictures</strong></td>
<td></td>
</tr>
<tr>
<td>Playback</td>
<td>P.124</td>
</tr>
<tr>
<td><strong>Settings that make the camera easier to operate.</strong></td>
<td></td>
</tr>
<tr>
<td>Useful functions</td>
<td>P.147</td>
</tr>
<tr>
<td><strong>Printing pictures</strong></td>
<td></td>
</tr>
<tr>
<td>Print setting (DPOF)</td>
<td>P.173</td>
</tr>
<tr>
<td>Direct printing (PictBridge)</td>
<td>P.184</td>
</tr>
<tr>
<td><strong>Troubleshooting and other information</strong></td>
<td></td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>P.200</td>
</tr>
<tr>
<td>List of menus</td>
<td>P.223</td>
</tr>
<tr>
<td>Index</td>
<td>P.229</td>
</tr>
</tbody>
</table>
Contents

How to use this manual ................................................. 3
Composition of the manual ........................................... 5
Names of parts .......................................................... 12
  Camera .................................................................. 12
  Viewfinder and monitor indications ............................ 14
  Memory gauge ......................................................... 17
  Battery check ......................................................... 17

1 Getting started ......................................................... 18

  Attaching the strap ................................................... 18
  Battery/card basics ................................................... 19
    Charging the battery .............................................. 19
    Card basics ......................................................... 20
    Inserting and removing the battery and card ............. 21
  Using an AC adapter (optional) .................................. 24
  Power on/off .......................................................... 25
    Startup/Shutdown screen ....................................... 26
    If the card is not recognized (card check) ................. 27
  Selecting a language 🌐.............................................. 28
  Setting the date and time 🕒...................................... 30
  Adjusting the viewfinder .......................................... 32
  Holding the camera ................................................ 33

2 Using the menus ....................................................... 34

  About the menus ..................................................... 34
  How to use the menus .............................................. 35
  Shortcut menus ...................................................... 37
  Mode Menus .......................................................... 40

3 Shooting basics ......................................................... 47

  Shooting modes ...................................................... 47
  Taking still pictures ................................................. 51
Contents

If correct focus cannot be obtained .................................................. 54
Using the Focus Lock function ....................................................... 54
Subjects that are difficult to focus on ........................................... 55
Recording movies 🎥 ................................................................. 56
Zoom ......................................................................................... 58
Using the optical zoom ............................................................... 58
SUPER ZOOM – Using the super zoom ........................................ 59
DIGITAL ZOOM – Using the digital zoom ..................................... 60

4 Flash ................................................................. 61

Flash shooting ⚡ ................................................................. 61
Using the slow synchronization flash ⚡slow ................................ 67
Flash intensity control ⚡ ............................................................ 68
External flash (optional) .............................................................. 69
  Using the external flash ........................................................... 69
  Using commercially available external flashes ....................... 71
  Compatible external flashes ..................................................... 72

5 Advanced shooting ................................................................. 73

A/S/M mode A/S/M ................................................................. 73
Aperture priority shooting A ...................................................... 74
Shutter priority shooting S ........................................................ 75
Manual shooting M ................................................................. 76
Using My Mode 🍩 ................................................................. 77
Focusing applications ............................................................... 78
  AF MODE – Changing the focus range .................................. 78
  FULLTIME AF – A reliable time-saving way to focus ............ 79
  AF AREA – Changing the position of the AF target mark ...... 80
  AF LOCK – Locking the focus ............................................... 81
  Manual focus ....................................................................... 83
Metering ⚡ ............................................................................. 85
Spot metering ........................................................................... 85
MULTI METERING .............................................................. 86
Contents

AE LOCK – Locking the exposure AEL ......................... 88
Macro mode shooting ............................................. 90
Super macro mode shooting ........................................ 91
Self-timer shooting ................................................... 92
Remote control shooting ........................................... 93
Sequential shooting HI AF BKT ................................. 95
  Sequential shooting, high speed sequential shooting and AF sequential shooting HI AF BKT .......... 95
Auto bracketing BKT ................................................. 96
PANORAMA – Panorama shooting .............................. 98
2 IN 1 – Taking two-in-one pictures 2 IN 1 ................. 100
FUNCTION – Adding special effects to pictures .............. 102
Recording sound with still pictures ............................. 103
Recording sound with movies ...................................... 104
Using commercially available external microphones ........ 105

6 Adjusting the image quality and exposure 106

Record mode ......................................................... 106
  Still Picture Record Modes ...................................... 106
  Movie Record Modes ............................................. 107
  Selecting a record mode ......................................... 109
ISO sensitivity ....................................................... 111
Exposure compensation ......................................... 112
White balance WB ............................................... 113
  Auto white balance ............................................. 113
  Preset white balance ........................................... 114
  One-touch white balance ....................................... 114
  White balance adjustment WB ................................. 116
SHARPNESS $ .......................................................... 117
CONTRAST © ........................................................... 118
SATURATION RGB .................................................... 119
NOISE REDUCTION NR .............................................. 120
REDUCE FLICKER .................................................. 121
Histogram display .................................................. 122
## 7 Playback

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewing still pictures</td>
<td>124</td>
</tr>
<tr>
<td>QUICK VIEW</td>
<td>125</td>
</tr>
<tr>
<td>Close-up playback</td>
<td>126</td>
</tr>
<tr>
<td>Index display</td>
<td>127</td>
</tr>
<tr>
<td>Selecting the number of pictures</td>
<td>128</td>
</tr>
<tr>
<td>Slideshow</td>
<td>129</td>
</tr>
<tr>
<td>Viewing movies</td>
<td>130</td>
</tr>
<tr>
<td>Editing movies</td>
<td>133</td>
</tr>
<tr>
<td>INDEX – Creating an index</td>
<td>133</td>
</tr>
<tr>
<td>EDIT – Editing a movie</td>
<td>135</td>
</tr>
<tr>
<td>Playback on TV</td>
<td>137</td>
</tr>
<tr>
<td>Picture rotation</td>
<td>138</td>
</tr>
<tr>
<td>Recording sound</td>
<td>139</td>
</tr>
<tr>
<td>Editing still pictures</td>
<td>140</td>
</tr>
<tr>
<td>Resizing</td>
<td>140</td>
</tr>
<tr>
<td>Trimming</td>
<td>141</td>
</tr>
<tr>
<td>Protecting pictures</td>
<td>143</td>
</tr>
<tr>
<td>SWITCH FRAME – <em>protected</em></td>
<td>144</td>
</tr>
<tr>
<td>Erasing pictures</td>
<td>145</td>
</tr>
<tr>
<td>Single-frame erase</td>
<td>145</td>
</tr>
<tr>
<td>All-frame erase</td>
<td>146</td>
</tr>
</tbody>
</table>

## 8 Useful functions

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL RESET – Saving the camera’s settings</td>
<td>147</td>
</tr>
<tr>
<td>CUSTOM BUTTON</td>
<td>149</td>
</tr>
<tr>
<td>Setting the custom button</td>
<td>150</td>
</tr>
<tr>
<td>Using the custom button</td>
<td>151</td>
</tr>
<tr>
<td>SHORT CUT</td>
<td>152</td>
</tr>
<tr>
<td>Setting the shortcut menu</td>
<td>153</td>
</tr>
<tr>
<td>Using the shortcut menu</td>
<td>154</td>
</tr>
<tr>
<td>MY MODE SETUP</td>
<td>155</td>
</tr>
<tr>
<td>CARD SETUP – Formatting cards</td>
<td>158</td>
</tr>
</tbody>
</table>
11 Miscellaneous

Error codes ................................................. 200
Troubleshooting ........................................... 201
List of factory default settings ............................ 209
Modes and Shooting Functions ......................... 212
Camera maintenance ..................................... 215
  How to replace the battery (CR2025) of the remote control device ....................... 216
Specifications .............................................. 217
Glossary of terms .......................................... 219
List of menus .............................................. 223
Index ....................................................... 229

Indications used in this manual

| ![Note] | Important information on factors which may lead to a malfunction or operational problems. Also warns of operations that should be absolutely avoided. |
| ![Useful] | Useful information and hints that will help you get the most out of your camera. |
| ![Reference] | Reference pages describing details or associated information. |
Names of parts

Camera

Remote control receiver  P.93
Zoom lever (W/T•Q) P.58, 126, 127
Shutter button P.51
Mode dial P.47
Self-timer/Remote control lamp P.92, 93
Flash P.61
Hot shoe P.69
Strap eyelet P.18
Microphone P.103, 104, 139
Speaker

Lens

DC-IN jack P.24
USB connector P.185
A/V OUT jack (MONO) P.137
Connector cover P.24, 137, 185
Names of parts

- **Viewfinder**: P.14, 32, 51, 161
- **Dioptr adjustment dial**: P.32
- **AE Lock/Custom button (AEL)**: P.81, 86, 88, 149
- **Rotation button**: P.138
- **Self-timer/Remote control button**: P.92, 93
- **Erase button**: P.145
- **Flash mode button**: P.61
- **Protect button**: P.143
- **Monitor button**: P.51
- **Flash button**: P.61
- **Card access lamp**: P.51
- **QUICK VIEW button**: P.125
- **Arrow pad**: P.34, 124
- **OK/Menu button**: P.34
- **Power switch**: P.25
- **Monitor**: P.14, 51, 161
- **Tripod socket**: P.21
- **Battery compartment/card cover**: P.21
Names of parts

Viewfinder and monitor indications

INFO setting allows you to select how much information to display on the screen. Screens with the Information display set to ON are shown below. “Information display” (P.160)

● Shooting modes

<table>
<thead>
<tr>
<th>Item</th>
<th>Indications</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Shooting modes</td>
<td>P, A, S, M, , , , , ,</td>
<td>P.47</td>
</tr>
<tr>
<td>2. Shutter speed</td>
<td>15&quot; – 1/1000</td>
<td>P.75</td>
</tr>
<tr>
<td>3. Aperture value</td>
<td>F2.8 – F8.0</td>
<td>P.74</td>
</tr>
<tr>
<td>4. Exposure compensation</td>
<td>Exposure differential</td>
<td>P.112</td>
</tr>
<tr>
<td></td>
<td>-2.0 – +2.0</td>
<td>P.112</td>
</tr>
<tr>
<td></td>
<td>-3.0 – +3.0</td>
<td>P.76</td>
</tr>
<tr>
<td>5. Battery check</td>
<td></td>
<td>P.17</td>
</tr>
<tr>
<td>6. Green lamp</td>
<td></td>
<td>P.52</td>
</tr>
<tr>
<td>7. Flash stand-by</td>
<td>Flash stand-by</td>
<td>P.63</td>
</tr>
<tr>
<td></td>
<td>Warning/Flash charge</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Lights)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Blinks)</td>
<td></td>
</tr>
<tr>
<td>8. Macro mode</td>
<td>Super macro mode</td>
<td>P.90</td>
</tr>
<tr>
<td></td>
<td>Manual focus</td>
<td>P.91</td>
</tr>
<tr>
<td>9. Noise reduction</td>
<td></td>
<td>P.83</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

14
<table>
<thead>
<tr>
<th>Item</th>
<th>Indications</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 Flash mode</td>
<td>![Symbol], ![Symbol], ![Symbol], SLOW1, ![Symbol], SLOW1, SLOW2</td>
<td>P.61</td>
</tr>
<tr>
<td>11 Flash intensity</td>
<td>![Symbol] -2.0 – +2.0</td>
<td>P.68</td>
</tr>
<tr>
<td>12 Drive</td>
<td>![Symbol], ![Symbol], ![Symbol], AF, BKT</td>
<td>P.95</td>
</tr>
<tr>
<td>13 Self-timer</td>
<td>![Symbol]</td>
<td>P.92, 93</td>
</tr>
<tr>
<td>14 Sound record</td>
<td>![Symbol]</td>
<td>P.103, 104, 139</td>
</tr>
<tr>
<td>15 Record mode</td>
<td>TIFF, SHQ, HQ, SQ1, SQ2, MPEG4</td>
<td>P.106</td>
</tr>
<tr>
<td>16 Resolution</td>
<td>2288 × 1712, 1280 × 960, 640 × 480 etc.</td>
<td>P.108</td>
</tr>
<tr>
<td>17 AF target mark</td>
<td>[ ]</td>
<td>P.51</td>
</tr>
<tr>
<td>18 Number of storable</td>
<td>30</td>
<td>P.108</td>
</tr>
<tr>
<td>still pictures</td>
<td>Time remaining 00:36</td>
<td>P.56</td>
</tr>
<tr>
<td>19 AE lock</td>
<td>![AEL], ![MEMO]</td>
<td>P.88</td>
</tr>
<tr>
<td>20 Spot metering</td>
<td>![Spot]</td>
<td>P.85</td>
</tr>
<tr>
<td>21 ISO</td>
<td>ISO64, ISO100, ISO200, ISO400</td>
<td>P.111</td>
</tr>
<tr>
<td>22 White balance</td>
<td>![Symbol], ![Symbol], ![Symbol], ![Symbol], ![Symbol]</td>
<td>P.113</td>
</tr>
<tr>
<td>23 White balance</td>
<td>B1 – B7, R1 – R7</td>
<td>P.116</td>
</tr>
<tr>
<td>adjustment</td>
<td>![RGB], ![Symbol] -5 – +5</td>
<td>P.119</td>
</tr>
<tr>
<td>24 Saturation</td>
<td>![RGB] -5 – +5</td>
<td>P.117</td>
</tr>
<tr>
<td>25 Sharpness</td>
<td>![Symbol] -5 – +5</td>
<td>P.118</td>
</tr>
<tr>
<td>26 Contrast</td>
<td>![Symbol] -5 – +5</td>
<td></td>
</tr>
<tr>
<td>27 Memory gauge</td>
<td>![Symbol], ![Symbol], ![Symbol], ![Symbol]</td>
<td>P.17</td>
</tr>
</tbody>
</table>
### Names of parts

#### Playback mode

<table>
<thead>
<tr>
<th>Item</th>
<th>Indications</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Battery check</td>
<td><img src="image" alt="Battery check" /></td>
<td>P.17</td>
</tr>
<tr>
<td>2 Switch frame</td>
<td><img src="image" alt="Switch frame" /></td>
<td>P.144</td>
</tr>
<tr>
<td>3 Print reservation, Number of prints Movie</td>
<td><img src="image" alt="Print reservation" /> × 10</td>
<td>P.175</td>
</tr>
<tr>
<td>4 Sound record</td>
<td><img src="image" alt="Sound record" /></td>
<td>P.103</td>
</tr>
<tr>
<td>5 Protect</td>
<td><img src="image" alt="Protect" /></td>
<td>P.143</td>
</tr>
<tr>
<td>6 Record mode</td>
<td>TIFF, SHQ, HQ, SQ1, SQ2, MPEG4</td>
<td>P.106</td>
</tr>
<tr>
<td>7 Resolution</td>
<td>2288 × 1712, 1280 × 960, 640 × 480, 320 × 240 etc.</td>
<td>P.108</td>
</tr>
<tr>
<td>8 Aperture value</td>
<td>F2.8 – F8.0</td>
<td>P.74</td>
</tr>
<tr>
<td>9 Shutter speed</td>
<td>15&quot; – 1/1000</td>
<td>P.75</td>
</tr>
<tr>
<td>10 Exposure compensation</td>
<td>-2.0 – +2.0</td>
<td>P.112</td>
</tr>
<tr>
<td>11 White balance</td>
<td>WB AUTO, <img src="image" alt="White balance" /></td>
<td>P.113</td>
</tr>
<tr>
<td>12 ISO</td>
<td>ISO64, ISO100, ISO200, ISO400</td>
<td>P.111</td>
</tr>
<tr>
<td>13 Date and time</td>
<td>'04.06.17 15:30</td>
<td>P.30</td>
</tr>
<tr>
<td>14 File number, Frame number</td>
<td>FILE : 100 – 0030, 30</td>
<td>P.169</td>
</tr>
<tr>
<td>Playing time/ Total recording time</td>
<td>00:00/00:20</td>
<td>P.131</td>
</tr>
</tbody>
</table>

**Note**

- The indications that appear on a movie picture that has been selected and displayed from the index display are different from those that appear when the movie picture is displayed using the movie playback function.
Memory gauge

The memory gauge lights up when you take a still picture. While the gauge is lit, the camera is storing the picture on the card. The memory gauge indication changes as shown below depending on the shooting status. The indication is not displayed during movie recording.

Battery check

If the remaining battery power is low, the battery check indication changes as follows when the camera is turned on or while the camera is in use.
1 Getting started

## Attaching the strap

1. Pass the lens cap string through the hole in the lens cap, then pass the other end through the loop and pull tight.

2. Pull the ends of the strap out of the stopper and ring.

3. Thread one end of the strap (A) through the string loop (attached to the lens cap in step 1). Then thread it through the strap eyelet on the camera.

4. Thread the end of the strap back through the ring and stopper as indicated by the arrows. Adjust the strap to the desired length.

5. Pull the strap through the stopper (B) to make sure it is fastened securely.

6. Attach the strap to the other eyelet following steps 3 to 5.

---

### Note

- Be careful with the strap when you carry the camera, as it can easily catch on stray objects, causing injury or damage.
- Attach the strap correctly as shown above so that the camera does not fall off. If the strap is attached incorrectly and the camera falls off, Olympus is not responsible for any damages.
Charging the battery

This camera uses an Olympus lithium-ion battery (LI-10B). Other types of batteries cannot be used.
The battery is not fully charged at the time of purchase. Be sure to use the specified battery charger (LI-10C) to charge the battery before use. For more information, read the manual supplied with the battery charger.

1. Connect the power cord to the power connector on the battery charger.

2. Plug the power cord into an AC wall outlet.

3. Insert the battery into the battery charger while aligning the + marks on both the battery and battery charger.
   • The charging indicator lights red and charging begins.
   • When charging is complete, the indicator lights green.
Battery/card basics

Getting started

• Charging of the battery usually takes 2 hours. Charging may be completed quickly depending on how much battery power remains.
• Do not use a battery charger other than the specified battery charger.
• If the charging indicator blinks red, this may indicate that the battery is not properly attached or that the battery has malfunctioned.
• Charging of the battery may cause noise on a television or radio sharing the same wall outlet; however, this is not a malfunction. If this should happen, plug the battery charger into a separate wall outlet.
• The battery may become hot during charging; however, this does not indicate a malfunction.
• This battery charger is guaranteed to operate within an ambient temperature range of 0°C to 40°C. To ensure maximum performance of the battery charger, however, you are recommended to use it between 10°C and 30°C.
• When using the battery charger in a foreign country, be sure to use a travel converter that matches the wall outlet in the area the camera is being used. Please consult a travel agency for more information on travel converters.

Card basics

“Card” in this manual refers to the xD-Picture Card. The camera uses the card to record pictures. The card corresponds to normal camera film for recording the pictures you have taken. Pictures recorded and stored on the card can easily be erased, overwritten, and/or edited on a PC.

1 Index area
   You can write down the card’s contents.
2 Contact area
   Comes into contact with the camera’s signal read contacts.

Compatible cards
• xD-Picture Card (16 – 512MB)

Note
• This camera may not recognize a non-Olympus card or a card that was formatted on another device (such as a PC, etc.). Before use, be sure to format the card on this camera. “CARD SETUP – Formatting cards” (P.158)
Inserting and removing the battery and card

1 **Make sure the camera is turned off.**
   - The power switch is set to OFF.
   - The monitor is off.
   - The viewfinder is off.
   - The lens is not extended.

2 **Slide the battery compartment/card cover in the direction of A, then lift in the direction of B.**
   - Use the ball of your finger to slide the cover. Do not use your fingernail as this could result in injury.

3 **Loading the battery**
   Align the battery as shown and insert it into the battery compartment until the battery is locked in position with the battery lock knob.

   **Removing the battery**
   Slide the knob in the direction of the arrow. When the battery is ejected, pull it out of the battery compartment.

**Low battery warning**

The amount of power consumed varies considerably depending on the operations performed on the digital camera. If you use an exhausted battery, the camera may turn off without displaying the battery level warning (P.17).
• The life of the battery may vary according to the shooting conditions, etc.
• The amount of power consumed by the camera varies considerably depending on shooting conditions, etc.
• Power is consumed continuously during the conditions described below. This discourages the power to last longer.
  • When the monitor is turned on.
  • When the monitor is in the playback mode for an extended period of time.
  • Repeated zoom adjustments.
  • Repeated auto-focus by depressing the shutter button halfway.
  • When the FULLTIME AF mode is turned on.
  • When connected to a computer or printer.

**Inserting a card**

Insert the card in the appropriate direction.
• Insert the card while keeping it straight.
• Inserting the card the wrong way or at an angle could damage the contact area or cause the card to jam.
• If the card is not inserted all the way, data may not be written to the card.
Removing the card
Push the card all the way in to unlock it, then let it return slowly.
• The card is ejected a short way and then stops. Hold the card straight and pull it out.

4 Close the battery compartment/card cover in direction C and then slide it in the direction shown D.

Notes for removing the card
Releasing your finger quickly after pushing the card all the way in may cause it to eject forcefully out of the slot.

- Do not press on the card with hard or pointed items such as ballpoint pens.
- Never open the battery compartment/card cover, or remove the card or the battery while the camera is turned on. Doing so could destroy the data stored on the card. Once destroyed, data cannot be restored.
- Do not place a sticker or label on the card as this could prevent the card from being ejected.
Using an AC adapter (optional)

An AC adapter is useful for time-consuming tasks such as image downloads to a computer.
An optional Olympus CAMEDIA-brand AC adapter allows you to power your digital camera from a common AC wall outlet. Be sure to use the specified AC adapter.
Use an AC adapter designed to operate on the AC voltage in the area the camera is being used.
Consult your nearest Olympus dealer or service center for details.

- If the battery power runs out while the camera is connected to a computer or printer, the image data may be lost or damaged. It is recommended you use the AC adapter when connected to a computer or printer. Do not connect or disconnect the AC adapter while the camera is connected to a computer or printer.
- Do not remove or load the battery or connect or disconnect the AC adapter while the camera is turned on. Doing so could affect the camera’s internal settings or functions.
- When using an AC adapter, power is supplied to the camera by the AC adapter even if the battery is loaded in the camera. The AC adapter does not charge the battery in the camera.
Power on/off

1 Press the tabs on the lens cap as indicated by the arrows and remove the lens cap.

2 Slide the power switch to 🎥, 📸 or 🎥.
   • The camera and the monitor turn on.
   • The mode in which the camera turns on varies depending on the position of the power switch. When the power is turned on in the shooting mode, the lens extends.

   **Shooting modes**
   📸: For taking still pictures. Use the mode dial to select a shooting mode.
   🎥 “Shooting modes” (P.47)
   🎥: For recording movies.
   🎥 “Recording movies” (P.56)

   **Playback mode**
   🎥: For displaying the pictures you have taken.
   🎥 “Viewing still pictures” (P.124)

3 To turn the camera off, slide the power switch to OFF.
Power on/off

TIPS

- In  or  mode, there is no need to set the mode dial. The camera will record movies or play back pictures regardless of the position of the mode dial.
- To save battery power, the camera automatically enters the sleep mode and stops the operation after about 3 minutes of non-operation. The camera activates again as soon as you operate the shutter button or zoom lever. The sleep time interval can be set in any shooting mode.  “SLEEP – Sleep Timer” (P.163)

Note

- If the camera is continuously used for a long period of time, the internal temperature of the camera may rise. In such cases, the power may automatically turn off. Please wait before using again. (Ex: When shooting MPEG4)
- If the camera is subjected to strong vibrations or shocks while it is turned on, the camera may immediately turn off and reset the date and other settings.

Startup/Shutdown screen

You can register a picture that will be displayed on the monitor and sound that will be played when turning the camera on or off. (P.167) You can also adjust the volume of the sound. (P.166)
If the card is not recognized (card check)

When the power is turned on, the camera checks the card automatically. If there is no card in the camera or a card that is not supported by this camera is inserted, the following screen is displayed.

<table>
<thead>
<tr>
<th>Monitor indication</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>◼ NO CARD</td>
<td>There is no card in the camera or the card is not inserted properly. → Insert a card or remove the card and insert it again correctly.</td>
</tr>
<tr>
<td><img src="image" alt="CARD SETUP" /></td>
<td>The card cannot record, play back or erase pictures. Format the card or replace it with a new one. → Press ◼ ◼ to select POWER OFF, then press ◼. Replace the card with a new one. → Format the card. Press ◼ ◼ to select ◼ FORMAT, then press ◼ to display the confirmation screen. Select YES and press ◼. Formatting starts. If the card was successfully formatted, the camera is ready to take pictures.</td>
</tr>
<tr>
<td><img src="image" alt="FORMAT" /></td>
<td><img src="image" alt="CARD SETUP" /></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="CARD SETUP" /></td>
</tr>
</tbody>
</table>

Note

- All data stored on the card is erased when the card is formatted.
Selecting a language

You can select a language for on-screen display. This reference manual shows the English on-screen display in the illustrations and explanations. Available languages vary depending on the area where you purchased this camera.

1 Slide the power switch to 📸 to turn the camera on.
   • Set the mode dial to any setting except AUTO.

2 Press 🎥.
   • The top menu is displayed.

3 Press ⏩ on the arrow pad to select MODE MENU.

4 Press ⏩ ⏩ to select the SETUP tab, then press 🎥.

5 Press ⏩ ⏩ to select 📨, then press 🎥.
   • The green frame moves to the selected item.
6 Press 📷🔍 to select a language, then press 📷.

7 Press 📷 again to exit the menu.

8 To turn the camera off, slide the power switch to OFF.
Getting started

1 Slide the power switch to ♂ to turn the camera on.

2 Press 🔄.
   • The top menu is displayed.

3 Press ⬅ on the arrow pad to select MODE MENU.
   • When the mode dial is set to AUTO, press 🔄 and go to Step 6.

4 Press ⬅ ⬅ to select the SETUP tab, then press 🔄.

5 Press ⬅ ⬅ to select ⬇, then press 🔄.
   • The green frame moves to the selected item.
Setting the date and time

1 Getting started

6 Press \( \text{Select} \) to select one of the following date formats: Y-M-D (Year/Month/Day), M-D-Y (Month/Day/Year), D-M-Y (Day/Month/Year). Then press \( \text{Go} \).

- Move to the year setting.
- The following steps show the procedure used when the date and time settings are set to Y-M-D.

7 Press \( \text{Select} \) to set the year, then press \( \text{Go} \) to move to the month setting.

- To move back to the previous setting, press \( \text{Select} \).
- The first two digits of the year are fixed.

8 Repeat this procedure until the date and time are completely set.

- The time is displayed in the 24-hour format. Consequently, 2 p.m. is displayed as 14:00.

9 Press \( \text{Go} \).

- For a more accurate setting, press \( \text{Go} \) when the time signal hits 00 seconds.

10 To turn the camera off, slide the power switch to OFF.

Note

- The date and time settings will be returned to the factory default settings if the camera is left without the battery for approximately one day. The settings will be canceled more quickly if the battery was only loaded in the camera for a short time before being removed. Before taking important pictures, check that the date and time settings are correct.
Adjusting the viewfinder

To make the camera easier to use, adjust the viewfinder to match the eyesight (visual acuity) of the person using the camera.

1  Slide the power switch to \( \text{\textbullet} \).
   • The camera and the monitor turn on.

2  Press \( \text{\textbullet} \).
   • The monitor turns off and the viewfinder turns on.

3  While looking through the viewfinder, slowly turn the diopter adjustment dial.

4  Turn the dial until the AF target mark can be seen clearly.
Holding the camera

Hold the camera firmly with both hands while keeping your elbows at your sides to prevent the camera from moving. When taking pictures in the vertical position, hold the camera in a position as shown in the illustration. For the best results, hold camera so that flash is positioned higher than the lens. Keep your fingers and the strap away from the lens and flash.

- Clear pictures cannot be obtained if the camera moves as the shutter button is pressed. Hold the camera correctly, and press the shutter button gently.

Note
When you turn on the camera and press ( ), the top menu is displayed on the monitor. The functions of this camera are set from the menus. This chapter explains how the menus work, using the P screens in mode.

### SHORTCUT MENUS
- Take you directly to the setting screens.
- Display operational buttons at the bottom of the screen.
- The functions registered in the shortcut menus can also be accessed from the MODE MENU.
- The functions registered in the shortcut menus can be changed in mode (except AUTO).

### MODE MENU
- Lets you access the menu selections to set the ISO, sharpness, etc.
- Categorizes the settings into 4 tabs.
- Press ( ) to select a tab and display the associated menu items.
- There is no mode menu for AUTO in mode.
How to use the menus

1 Press  to display the top menu, then press .

Top menu

2 Press  to select a tab, then press .

CAMERA tab

Press  to return to the tab selection screen.

PICTURE tab

CARD tab

SETUP tab

continued overleaf
How to use the menus

3 Press \( \text{\textcircled{a}} \) to select the item, then press \( \text{\textcircled{b}} \).

4 Press \( \text{\textcircled{a}} \) to select a setting. Press \( \text{\textcircled{b}} \) to complete setting. Press \( \text{\textcircled{b}} \) again to exit the menu and return to shooting status.

- Not all items can be selected depending on the status of the camera and the settings performed.
- If you want to save the settings after the camera is turned off, set ALL RESET to OFF. “ALL RESET – Saving the camera’s settings” (P.147)
**Shortcut menus**

The menu that is displayed varies depending on the position of the power switch. In **K** mode, the menu that is displayed also varies depending on the position of the mode dial.

### **K** mode

![Menu Diagram](image)

**DRIVE**

Selects a shooting mode from **(single-frame shooting)**, **(sequential shooting)**, **(high speed sequential shooting)**, **AF** (AF sequential shooting) and **BKT** (auto bracketing).

P.95

**ESP/**

Selects the metering method (ESP, or MULTI).

P.85

**CARD SETUP**

Used to take pictures of a close subject. Selects OFF, or **.**

P.90

**Sets the date and time.**

P.30

**CARD SETUP**

Formats a card.

P.158
Shortcut menus

Using the menus

● mode

**DIGITAL ZOOM**

Extends telephoto capability beyond maximum optical zoom.  

|  | P.60 |

-selected-

Selects the image quality and resolution from MPEG4, SHQ, HQ and SQ.  

|  | P.106 |

**WB**

Sets the appropriate white balance according to the light source.  

|  | P.113 |
• The functions registered in the shortcut menus can also be accessed from the MODE MENU. The functions registered in the shortcut menus can be changed in \textit{\textbf{auto}} mode (except \textbf{auto}). \textit{“SHORT CUT” (P.152)}
The MODE MENU has 4 tabs. Press 📷 📷 to select a tab and display the associated menu items.

### 📷 mode

#### CAMERA tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESP/☑️</td>
<td>Selects the metering method (ESP, ☑️ or MULTI).</td>
<td>P.85</td>
</tr>
<tr>
<td>🌷</td>
<td>Used to take pictures of a close subject. Selects OFF, 🌷, 🌷.</td>
<td>P.90</td>
</tr>
<tr>
<td>DRIVE</td>
<td>Selects a shooting mode from ☑️ (single-frame shooting), ☏️ (sequential shooting), HI (high speed sequential shooting), AF (AF sequential shooting) and BKT (auto bracketing).</td>
<td>P.95</td>
</tr>
<tr>
<td>ISO</td>
<td>Selects the ISO sensitivity from AUTO, 64, 100, 200 and 400.</td>
<td>P.111</td>
</tr>
<tr>
<td>A/S/M</td>
<td>Selects a shooting mode from A (Aperture priority shooting), S (Shutter priority shooting) and M (Manual shooting).</td>
<td>P.73</td>
</tr>
<tr>
<td>🐈 1/2/3/4</td>
<td>Selects a mode to be activated when taking pictures in 🐈 mode.</td>
<td>P.77</td>
</tr>
<tr>
<td>🎩</td>
<td>Adjusts the amount of light emitted by the flash.</td>
<td>P.68</td>
</tr>
<tr>
<td>🌬️ SLOW</td>
<td>Selects from 🌬️ SLOW1 (1st curtain), ☑️ SLOW1 (1st curtain with red-eye reduction) and 🌬️ SLOW2 (2nd curtain) when the flash mode is set to 🌬️ SLOW (slow synchronization).</td>
<td>P.67</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>Reduces the noise that affects pictures during long exposures.</td>
<td>P.120</td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>Extends the maximum optical zoom up to approximately 40× magnification.</td>
<td>P.60</td>
</tr>
</tbody>
</table>
## Mode Menus

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>FULLTIME AF</td>
<td>Keeps the image in focus at all times without having to press the shutter button halfway.</td>
<td>P.79</td>
</tr>
<tr>
<td>AF MODE</td>
<td>Selects the auto focus method (iESP or SPOT).</td>
<td>P.78</td>
</tr>
<tr>
<td>PANORAMA</td>
<td>Allows panorama pictures to be taken with Olympus CAMEDIA-brand cards.</td>
<td>P.98</td>
</tr>
<tr>
<td>2 IN 1</td>
<td>Combines two still pictures taken in succession and stores them as a single picture.</td>
<td>P.100</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>Adds special effects to pictures (BLACK &amp; WHITE, SEPIA, WHITE BOARD, BLACK BOARD).</td>
<td>P.102</td>
</tr>
<tr>
<td>AF AREA</td>
<td>Changes the position of the AF target mark using the arrow pad.</td>
<td>P.80</td>
</tr>
<tr>
<td>INFO</td>
<td>Selects whether to display all the information such as shutter speed and white balance, or only the minimum information.</td>
<td>P.160</td>
</tr>
<tr>
<td>INFO histogram</td>
<td>Displays a histogram showing the luminance distribution of still pictures.</td>
<td>P.122</td>
</tr>
<tr>
<td>INFO sound</td>
<td>Sound can be recorded when taking still pictures.</td>
<td>P.103</td>
</tr>
<tr>
<td>SUPER ZOOM</td>
<td>Extends the optical zoom, making possible up to 14× zoom in 1600 × 1200 record mode.</td>
<td>P.59</td>
</tr>
</tbody>
</table>

### PICTURE tab

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Selects the image quality and resolution from TIFF, SHQ, HQ, SQ1 and SQ2.</td>
<td>P.106</td>
</tr>
<tr>
<td>WB</td>
<td>Sets the appropriate white balance according to the light source.</td>
<td>P.113</td>
</tr>
<tr>
<td>WB²</td>
<td>Makes fine changes to the white balance.</td>
<td>P.116</td>
</tr>
<tr>
<td>SHARPNESS</td>
<td>This function adjusts the sharpness of the image.</td>
<td>P.117</td>
</tr>
<tr>
<td>CONTRAST</td>
<td>This function adjusts the contrast of images.</td>
<td>P.118</td>
</tr>
<tr>
<td>SATURATION</td>
<td>Adjusts the level of color depth without changing the tint.</td>
<td>P.119</td>
</tr>
</tbody>
</table>

### CARD tab

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CARD SETUP</td>
<td>Formats a card.</td>
<td>P.158</td>
</tr>
</tbody>
</table>
## SETUP tab

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ALL RESET</strong></td>
<td>Selects whether to keep the current camera settings when you turn off the power.</td>
<td>P.147</td>
</tr>
<tr>
<td><strong>🇵。「」</strong></td>
<td>Selects a language for on-screen display.</td>
<td>P.28</td>
</tr>
<tr>
<td><strong>PW ON/OFF SETUP</strong></td>
<td>Selects the picture and sound that are output when the power is turned on or off.</td>
<td>P.167</td>
</tr>
<tr>
<td><strong>REC VIEW</strong></td>
<td>Selects whether to display pictures on the monitor while saving them to a card.</td>
<td>P.162</td>
</tr>
<tr>
<td><strong>SLEEP</strong></td>
<td>Sets the sleep timer.</td>
<td>P.163</td>
</tr>
<tr>
<td><strong>MY MODE SETUP</strong></td>
<td>Customizes settings which are activated in the 📚 mode.</td>
<td>P.155</td>
</tr>
<tr>
<td><strong>FILE NAME</strong></td>
<td>Changes how file names are assigned.</td>
<td>P.169</td>
</tr>
<tr>
<td><strong>PIXEL MAPPING</strong></td>
<td>Checks the CCD and image processing functions for errors.</td>
<td>P.170</td>
</tr>
<tr>
<td><strong>밝기</strong></td>
<td>Adjusts the brightness of the viewfinder or monitor.</td>
<td>P.161</td>
</tr>
<tr>
<td><strong>⏰</strong></td>
<td>Sets the date and time.</td>
<td>P.30</td>
</tr>
<tr>
<td><strong>מ/פ</strong></td>
<td>Sets the measurement unit (m/ft) used during manual focus.</td>
<td>P.171</td>
</tr>
<tr>
<td><strong>VIDEO OUT</strong></td>
<td>Selects NTSC or PAL according to your TV’s video signal type. TV video signal types differ depending on the region.</td>
<td>P.172</td>
</tr>
<tr>
<td><strong>SHORT CUT</strong></td>
<td>Assigns frequently used functions as shortcut menus.</td>
<td>P.152</td>
</tr>
<tr>
<td><strong>CUSTOM BUTTON</strong></td>
<td>Assigns a frequently used function to the camera’s custom button.</td>
<td>P.149</td>
</tr>
<tr>
<td><strong>🔔</strong></td>
<td>Sets the beep sound used for button operations and warnings, and adjusts the volume.</td>
<td>P.164</td>
</tr>
<tr>
<td><strong>SHUTTER SOUND</strong></td>
<td>Sets the sound made when the shutter button is pressed and adjusts the volume.</td>
<td>P.165</td>
</tr>
</tbody>
</table>
### Mode Menus

#### Using the menus

- **CAMERA tab**
  - **ESP/**
    - Selects the metering method (ESP or ).
    - P.85
  - **
    - Used to take pictures of a close subject. Selects OFF, , .
    - P.90
  - **ISO**
    - Selects the ISO sensitivity from AUTO, 64, 100, 200 and 400.
    - P.111
  - **FULLTIME AF**
    - Keeps the image in focus at all times without having to press the shutter button halfway.
    - P.79
  - **FUNCTION**
    - Adds special effects to pictures (BLACK & WHITE, SEPIA).
    - P.102
  - **(movies)**
    - Selects whether to record sound when shooting a movie.
    - P.104
  - **REDUCE FLICKER**
    - Reduces the flickering that occurs when recording movies under fluorescent light.
    - P.121

- **PICTURE tab**
  - **WB**
    - Makes fine changes to the white balance.
    - P.116
  - **SHARPNESS**
    - This function adjusts the sharpness of the image.
    - P.117
  - **CONTRAST**
    - This function adjusts the contrast of images.
    - P.118
  - **SATURATION**
    - Adjusts the level of color depth without changing the tint.
    - P.119

- **CARD tab**
  - **CARD SETUP**
    - Formats a card.
    - P.158
### SETUP tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL RESET</td>
<td>Selects whether to keep the current camera settings when you turn off the power.</td>
<td>P.147</td>
</tr>
<tr>
<td>🎤(IOException)</td>
<td>Selects a language for on-screen display.</td>
<td>P.28</td>
</tr>
<tr>
<td>PW ON/OFF SETUP</td>
<td>Selects the picture and sound that are output when the power is turned on or off.</td>
<td>P.167</td>
</tr>
<tr>
<td>FILE NAME</td>
<td>Changes how file names are assigned.</td>
<td>P.169</td>
</tr>
<tr>
<td>PIXEL MAPPING</td>
<td>Checks the CCD and image processing functions for errors.</td>
<td>P.170</td>
</tr>
<tr>
<td>📡(Brightness)</td>
<td>Adjusts the brightness of the viewfinder or monitor.</td>
<td>P.161</td>
</tr>
<tr>
<td>🕒(Date and Time)</td>
<td>Sets the date and time.</td>
<td>P.30</td>
</tr>
<tr>
<td>VIDEO OUT</td>
<td>Selects NTSC or PAL according to your TV's video signal type. TV video signal types differ depending on the region.</td>
<td>P.172</td>
</tr>
<tr>
<td>🔔(Beep)</td>
<td>Sets the beep sound used for button operations and warnings, and adjusts the volume.</td>
<td>P.164</td>
</tr>
</tbody>
</table>
## Mode Menus

### PLAY tab*1
- **q** Stores the necessary information on the card to allow you to print the pictures taken. [P.173](#)
- **R** Displays a histogram showing the luminance distribution. [P.122](#)
- **z** Adds sound to a still picture already taken. [P.139](#)

*1 The PLAY tab is not displayed during movie playback.

### EDIT tab*2
- **R** Makes the file size smaller and saves it as a new file. [P.140](#)
- **P** Crops part of a picture and saves it as a new file. [P.141](#)

*2 The EDIT tab is not displayed during movie playback.

### CARD tab
- **CARD SETUP** Erases all image data stored on the card or format the card. [P.146, 158](#)

### SETUP tab
- **ALL RESET** Selects whether to keep the current camera settings when you turn off the power. [P.147](#)
- **W** Selects a language for on-screen display. [P.28](#)
- **PW ON/OFF SETUP** Selects the picture and sound that are output when the power is turned on or off. [P.167](#)
### Mode Menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCREEN SETUP</td>
<td>Registers a stored picture for use as the picture displayed when the power is turned on and off.</td>
<td>P.168</td>
</tr>
<tr>
<td>![Brightness]</td>
<td>Adjusts the brightness of the viewfinder or monitor.</td>
<td>P.161</td>
</tr>
<tr>
<td>![Date]</td>
<td>Sets the date and time.</td>
<td>P.30</td>
</tr>
<tr>
<td>VIDEO OUT</td>
<td>Selects NTSC or PAL according to your TV’s video signal type. TV video signal types differ depending on the region.</td>
<td>P.172</td>
</tr>
<tr>
<td>![Index]</td>
<td>Selects the number of frames in the index display.</td>
<td>P.128</td>
</tr>
<tr>
<td>![Beep]</td>
<td>Sets the beep sound used for button operations and warnings, and adjusts the volume.</td>
<td>P.164</td>
</tr>
<tr>
<td>VOLUME</td>
<td>Adjusts the sound volume during playback. Also adjusts the volume of the sound selected in PW ON/OFF SETUP.</td>
<td>P.166</td>
</tr>
</tbody>
</table>
3 Shooting basics

Shooting modes

In mode, use the mode dial to select a still picture shooting mode. Set the mode dial to the best position for the situation and shooting conditions. The shooting modes include modes where the optimal settings for the situation are automatically selected, and modes where you can select the settings best suited to the shooting conditions and the effect you wish to achieve.

You can change the shooting mode before and after turning the camera on.

Situation-related modes

**Full-auto shooting**

Allows you to take still pictures using no special functions or manual adjustments. The camera sets the optimal focusing and exposure. This is the simplest of all shooting modes.

**Portrait shooting**

Suitable for taking a portrait-style shot of a person. This mode features an in-focus subject against a blurred background. The camera automatically sets the optimal shooting conditions.
Shooting modes

Sports shooting

Suitable for capturing fast-moving action (such as sports) without blur. Even a fast-moving subject will be clear and sharp, as if it is not moving, enabling you to capture facial expressions and detailed activity. The camera automatically sets the optimal shooting conditions.

Landscape+Portrait shooting

Suitable for taking pictures of both your subject and the landscape. The picture is taken with the background as well as the subject in the foreground in focus. You can take pictures of your subject against a beautiful sky or landscape. The camera automatically sets the optimal shooting conditions.

Landscape shooting

Suitable for taking pictures of landscapes and other outdoor scenes. Both the foreground and the background are in focus. Since blues and greens are vividly reproduced in this mode, it is excellent for shooting natural scenery. The camera automatically sets the optimal shooting conditions.

Night Scene shooting

Suitable for shooting pictures in the evening or at night. The camera sets a slower shutter speed than is used in normal shooting. For example, if you take a picture of a street at night in AUTO mode, the lack of brightness will result in a dark picture with the background underexposed and without details. In the Night Scene shooting mode, the true appearance of the street is captured. The camera automatically selects the optimal settings for this type of shooting condition. Since the shutter speed is slow, make sure you stabilize the camera by using a tripod.

Self-Portrait shooting

Enables you to take a picture of yourself while holding the camera. Point the lens towards yourself and the focus will be locked on you. The camera automatically sets the optimal shooting conditions. The zoom is fixed in the wide position and cannot be changed.
Setting-related modes

**P Program shooting**

Allows you to take still pictures. The camera sets the aperture and shutter speed. Other functions, such as flash modes and drive modes, can be adjusted manually.

**A/S/M Aperture priority/Shutter priority/Manual shooting**

When the mode dial is set to **A/S/M**, the following items can be set with the menus. [“A/S/M mode” (P.73)]

**A Aperture priority shooting**

Allows you to set the aperture manually. The camera sets the shutter speed automatically. By decreasing the aperture value (F-number), the camera will focus within a smaller range, producing a picture with a blurred background. Increasing the value forces the camera to focus over a wider range in the forward and backward directions, resulting in increased “depth of field”, in which both the subject and the background are in focus.

[“Aperture priority shooting” (P.74)]

Aperture (F-number) is decreased.

Aperture (F-number) is increased.
Shooting modes

S Shutter priority shooting
Allows you to set the shutter speed manually. The camera sets the aperture automatically. Set the shutter speed according to the subject and the type of effect you want.

Setting the shutter speed higher lets you capture fast-moving action without blur. The subject will be clear and sharp, as if it is not moving.

Setting the shutter speed lower blurs a moving subject, giving the impression of movement.

M Manual shooting
Allows you to set the aperture and shutter speed manually. To check the exposure, refer to the exposure differential. This mode gives you more creative control, allowing you to make the settings you need to get the type of picture you want, regardless of optimum exposure.

My Mode
Allows you to save your favorite settings as your own personal mode and use these customized settings when taking pictures. Current settings can also be saved for retrieving by this mode.

Note
• The available settings vary depending on the mode.
Taking still pictures

You can take still pictures using either the monitor or the viewfinder.

1. Slide the power switch to "Power on/off" (P.25)

   • The monitor turns on.

   To shoot using the viewfinder, press [Shutter button] to turn the viewfinder on.

2. Turn the mode dial and select a shooting mode.

3. Decide the composition of the picture.
4 Press the shutter button gently (halfway) to adjust the focus.

- When the focus and exposure are locked, the green lamp lights (focus lock).
- The AF target mark moves to the focused position.
- The shutter speed and aperture value automatically set by the camera are displayed (except in M mode).
- $\bigcirc$ blinks to warn of camera movement.
  Press the flash button to open the flash. (P.61)
- When $\bigcirc$ lights after the flash has popped up, the flash is ready to fire. The flash fires automatically when the shutter button is pressed all the way.

5 Press the shutter button all the way (fully).
- The camera takes the picture.
- The card access lamp blinks while the picture is stored on the card.

TIPS

The subject cannot be focused on.
- “If correct focus cannot be obtained” (P.54)

The green lamp blinks.
- You are too close to the subject. Take the picture at least 7 cm/2.8” (wide-angle) (1.2 m/3.9 ft. (telephoto)) away from the subject. If you use the super macro mode, you can take pictures as close as 3 cm/1.2” from the subject. (P.91)
- Depending on the subject, the focus and exposure may not be locked. “Subjects that are difficult to focus on” (P.55)

$\bigcirc$ blinks when the shutter button is pressed halfway.
- The flash is charging. Wait until the lamp goes off.

To check the picture you have just taken immediately
- Set Rec View to ON. “REC VIEW” (P.162)
To record sound with the picture
→ You can record sound when taking still pictures. Set 🎧 to ON. 📺 “Recording sound with still pictures” (P.103) You can also add sound to a picture that has already been taken. 🎧 “Recording sound” (P.139)

The monitor or viewfinder turns off automatically.
→ If the camera is not used for over 3 minutes, the monitor and viewfinder turn off automatically. Operate the shutter button or zoom lever to turn the viewfinder or monitor on. 🕳️ “SLEEP – Sleep Timer” (P.163)

To adjust the brightness of the monitor or viewfinder
→ Go to “Monitor brightness Adjustment” and adjust the brightness. 📺 “Monitor/viewfinder brightness adjustment” (P.161)

The monitor or viewfinder is hard to see.
→ Bright light, such as direct sunlight, may cause vertical lines (smears) to appear on the image in the monitor or viewfinder. This does not affect recorded pictures.

To check the area the camera is focusing on
→ If you press 📸 while pressing the shutter button halfway, the area you are focusing on is enlarged. Pressing 📸 once more returns the size to normal. This function is not available in the digital zoom range. 🕳️ “DIGITAL ZOOM – Using the digital zoom” (P.60)

・Press the shutter button gently using the ball of your finger. If it is pressed hard, the camera may move and pictures may come out blurred.
・Recorded pictures will be saved on the card regardless of whether the camera is turned off or the batteries are replaced or removed.
・Never open the battery compartment/card cover, remove the battery or disconnect the AC adapter while the card access lamp is blinking. Doing so could destroy stored pictures and prevent storage of pictures you have just taken.
・When taking pictures against strong backlight, the area of the picture in shadow may appear colored.
If correct focus cannot be obtained

When the subject cannot be focused on, you can focus the camera on another point at roughly the same distance (focus lock) and take the picture as explained below.

Using the Focus Lock function

1 Position the AF target mark on the subject you want to focus on.
   • When shooting a hard-to-focus subject or a fast-moving subject, point the camera at an object about the same distance away as the subject.

2 Press the shutter button halfway until the green lamp lights.
   • When the focus and exposure are locked, the green lamp lights.
   • The AF target mark moves to the focused position.
   • When the green lamp blinks, the focus and exposure are not locked. Release your finger from the shutter button, re-position your subject and press the shutter button halfway again.

3 Keeping the shutter button pressed halfway, recompose your shot.
4 Press the shutter button fully.

TIPS

The frame in which you focus on a subject is different from the frame in which you lock the exposure.  
 предусмотрен "AE LOCK – Locking the exposure" (P.88) 

Fix the focus position.  
 предусмотрен "AF LOCK – Locking the focus" (P.81) 

Focus on the subject in the center of the frame.  
 предусмотрен "AF MODE – Changing the focus range" (P.78)

Subjects that are difficult to focus on

Under certain types of conditions, the auto focus may not work properly. If this happens, focus on an object with high contrast at the same distance as the intended subject (focus lock), recompose your shot and then take the picture. If the subject has no vertical lines, hold the camera vertically and focus the camera using the focus lock function by pressing the shutter button halfway, then return the camera to the horizontal position while keeping the button pressed halfway and take the picture. If the subject still cannot be focused on, use the manual focus. предусмотрено "Manual focus" (P.83)

The green lamp blinks. The subject cannot be brought into focus.

Subject with low contrast

Subject with an extremely bright area in the center of the frame

Subject without vertical lines

The green lamp lights, but the subject cannot be brought into focus.

Subjects at different distances

Fast-moving subject

The subject to be focused on is not in the center of the frame
This function allows you to record movies. If \( \bullet \) is set to ON, sound is recorded at the same time.
If you select MPEG4 for the record mode, you can record a long movie in MPEG format.

“Record mode” (P.106)

1. **Slide the power switch to \( \bullet \).**
   - The monitor turns on.
   - The available recording time on the card that you are using is displayed.

2. **Decide the composition of the picture.**
   - You can use the zoom lever to enlarge your subject.

3. **Press the shutter button fully to start recording.**
   - You can adjust the zoom during movie recording.
   - The card access lamp blinks while the movie is stored on the card.
   - During movie recording, \( \bullet \) lights red.
4 **Press the shutter button again to stop recording.**

- When the remaining recording time has been used up, recording stops automatically.
- When there is space in the card memory, the remaining recording time (P.109) is displayed, and the camera is ready to shoot.

**TIPS**

- **To record sound at the same time**
  
  → Set \( \text{R} \) to ON.
  
  \[ \text{“Recording sound with movies” (P.104) } \]

- **To use the zoom during movie recording**
  
  → Set DIGITAL ZOOM to ON.
  
  \[ \text{“DIGITAL ZOOM – Using the digital zoom” (P.60) } \]
  
  → If you set \( \text{R} \) to OFF, you can use the optical zoom during movie recording.
  
  \[ \text{“Recording sound with movies” (P.104) } \]

- If you attach an external microphone (optional), you can use the optical zoom while recording sound with a movie.
  
  \[ \text{“Using commercially available external microphones” (P.105) } \]

**Notes for recording movies over a long time**

- Recording will continue until the card is full unless stopped by pressing the shutter button.
- A long recorded movie cannot be edited. (P.133)
- If a single movie recording uses up all of the card’s memory, create space on the card by deleting the movie or downloading it to a PC.

- Depending on the card, the remaining recording time may drop rapidly during recording. Try using the card again after formatting it with your camera. \[ \text{“CARD SETUP – Formatting cards” (P.158) } \]

- In \( \text{ } \) mode, the flash and manual focus (MF) cannot be used.
In addition to the optical zoom, this camera is equipped with a super zoom and digital zoom for taking telephoto and wide-angle shots. You can increase the zoom magnification by combining the super zoom or digital zoom with the optical zoom. The super zoom and digital zoom cannot be used at the same time. Camera movement is likely to occur at higher magnifications. Stabilize the camera with a tripod, etc. to avoid camera movement.

The characteristics and maximum magnification of each zoom are shown below.

**Optical zoom**
- Use for normal zoom shooting.
- Max. magnification: 10× (equivalent to 38 mm to 380 mm on a 35 mm camera)

**Super zoom**
- Use to extend the optical zoom up to 14× magnification.
- However, the resolution is automatically fixed at 1600 × 1200.
- Max. magnification: 14×

**Digital zoom**
- Use to extend the maximum optical zoom. However, pictures taken with the digital zoom may appear grainy.
- Max. magnification: Approx. 40×
  (Digital zoom magnification during movie recording is 2.5×)

**Using the optical zoom**

1. Push or pull the zoom lever.

   - Wide-angle: Push the zoom lever toward W to zoom out.
   - Telephoto: Pull the zoom lever toward T to zoom in.
SUPER ZOOM – Using the super zoom

1 In the top menu, select MODE MENU → CAMERA → SUPER ZOOM → ON, and press .

• When ON is selected, the record mode is automatically set to 1600 × 1200.
• Press again to exit the menu.

2 Pull the zoom lever toward T until the optical zoom reaches its limit.

• When 10× magnification is reached, zoom adjustment stops. To zoom in further, keep pulling the zoom lever toward T.

3 Push the zoom lever toward W to zoom out.

• When the zoom reaches 10× magnification, zoom adjustment stops. To zoom out further, keep pushing the zoom lever toward W.

Note

• Setting DIGITAL ZOOM to ON or changing the record mode setting automatically disables the super zoom.
DIGITAL ZOOM – Using the digital zoom

1. In the top menu, select MODE MENU → CAMERA → DIGITAL ZOOM → ON, and press ( ).
   "How to use the menus" (P.35)
   • Press ( ) again to exit the menu.

2. Pull the zoom lever toward T.
   • The white area of the zoom indicator indicates the optical zoom. If the digital zoom is set to ON, a red area appears on the zoom indicator. When you reach the limit of the optical zoom, the digital zoom is enabled.

Note

• Pictures taken with the digital zoom may appear grainy.
Select the flash mode best suited to the light conditions and the effect you want to achieve. You can also adjust the amount of light emitted using the flash intensity control. This camera is equipped with two flashes. The camera automatically selects which flash to fire depending on the zoom magnification.

1. **Press the flash button.**
   - The flash pops up.

2. **Select a flash mode by repeatedly pressing ↓.**
   - The flash mode changes in the sequence shown below (when all modes are available).
   - If no operation is performed for about 3 seconds, the flash mode is set and the mode selector screen is automatically exited.
   - To prevent the flash from firing, press down on the top of the flash to retract it.
3 Press the shutter button halfway.
   • In conditions where the flash will fire, mark lights.

4 Press the shutter button fully to take the picture.

Flash working range
W (max.): Approx. 0.3 m to 4.5 m (1.0 ft. to 14.8 ft.)
T (max.): Approx. 1.2 m to 5.2 m (3.9 ft. to 17 ft.)

Function restrictions according to mode

<table>
<thead>
<tr>
<th>Flash mode</th>
<th>AUTO</th>
<th>Place</th>
<th>A/S/M</th>
<th>P</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

✓ : Available, – : Not available, : Factory default setting

* The factory default settings and available modes vary depending on the selected mode.
TIPS

The (flash charge) indication blinks.
→ The flash is charging. Wait until goes off.

Shutter speed when using the flash (Auto-flash, red-eye reduction, fill-in flash).
→ When (camera movement warning) lights, the shutter speed locks at its current level. This helps prevent camera shake problems (shutter speeds that are too slow can cause blur). However, if the zoom magnification is increased, the camera will increase the locked shutter speed accordingly.

<table>
<thead>
<tr>
<th>Zoom position</th>
<th>Shutter speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>W (max.)</td>
<td>30 sec.</td>
</tr>
<tr>
<td>T (max.)</td>
<td>320 sec.</td>
</tr>
</tbody>
</table>

Note

• The flash does not fire in the following situations:
  In mode, during auto bracketing, during super-macro shooting, when FUNCTION is set to WHITE BOARD/BLACK BOARD, and during Panorama shooting
• The flash may not give you the optimum result in macro mode, especially with wide-angle shooting. Check the resulting picture on the monitor.
• If a conversion lens is attached to the camera, do not use the flash.
**Auto-flash (No indication)**
The flash fires automatically in low light or backlight conditions.

**Red-eye reduction flash (Eye)**
The light from the flash may make the subject’s eyes appear red in the picture. The red-eye reduction flash mode significantly reduces this phenomenon by emitting pre-flashes before firing the regular flash. This helps accustom the subject’s eyes to the bright light and minimizes the red-eye phenomenon.

The subject’s eyes appear red.

- After the pre-flashes, it takes about 1 second before the shutter is released. Hold the camera firmly to avoid camera movement.
- Effectiveness may be limited if the subject is not looking directly at the pre-flashes, or if the shooting range is too far. Individual physical characteristics may also limit effectiveness.

**Fill-in flash (△)**
The flash fires regardless of the available light. This mode is useful for eliminating shadows on the subject’s face (such as shadows from tree leaves), in a backlight situation, or for correcting the color shift produced by artificial lighting (especially fluorescent light).

- The fill-in flash may not have the desired effect under excessively bright light.
● Flash off (Flash off)
The flash does not fire even in low light conditions. Use this mode in situations where flash photography is not desired or is prohibited. You can also use this mode when you want to shoot a natural-looking twilight or night scene.

- Since a slow shutter speed is automatically selected in low light situations when in the flash off mode, the use of a tripod is recommended to prevent your pictures from being blurred by camera movement.

● Slow Synchronization (Slow Synchronization)
The slow synchronization flash is designed for slow shutter speeds. Normally, when shooting with a flash, shutter speeds cannot go below a certain level to prevent camera movement. But when shooting a night scene background, fast shutter speeds can make the background too dark. Slow synchronization flash allows both a slow shutter speed for the background and a flash for the subject. Since the shutter speed is slow, make sure you stabilize the camera by using a tripod. Otherwise, camera movement may cause the picture to be blurred.

1st curtain (front curtain) ❄️ SLOW1
Usually, regardless of the shutter speed, the flash fires right after the shutter fully opens. This is called 1st curtain. Unless you change it, this is how the flash always fires. The slow synchronization factory default setting is ❄️ SLOW1.
2nd curtain (rear curtain) SLOW2

With 2nd curtain, the flash fires just before the shutter closes. Changing the flash timing can create interesting effects in your picture, such as expressing the movement of a car by showing the tail-lights streaming backwards. The slower the shutter speed, the better the effects turn out.

The slowest possible shutter speed depends on the shooting mode:
- **M** mode : 15 sec.
- **P, A, S, S** mode : 4 sec.

When the shutter speed is set to 4 sec.

1st curtain with red-eye reduction SLOW1

This mode is for when you want to use slow synchronization, yet also reduce the red-eye phenomenon. For instance, when shooting a person against a brightly lit night background. A normal flash might make the person’s eyes red, but 1st curtain with red-eye reduction lets you capture the background correctly and reduce the red-eye phenomenon at the same time. 2nd curtain with red-eye reduction is not available.
1. In the top menu, select MODE MENU → CAMERA → SLOW → SLOW1, SLOW or SLOW2, and press OK.

   - Press OK again to exit the menu.
Flash intensity control

You can adjust the amount of light emitted by the flash. In some situations, you may get better results by adjusting the light emission. Examples include small subjects, distant backgrounds, or situations when increased contrast is desired. You can adjust the exposure in the range of ±2.0 in 1/3 EV steps.

1. In the top menu, select MODE MENU → CAMERA → , and press .
   "How to use the menus" (P.35)

2. Press to adjust the exposure, then press .
   - : Light emission is increased by 1/3 EV each time you press the button. (EV : Exposure Value)
   - : Light emission is decreased by 1/3 EV each time you press the button.

   - Press again to exit the menu.

   • The flash adjustment effect may not be sufficient if the shutter speed is too fast.

Note
External flash (optional)

Using the external flash

Various types of flash shooting are possible with the Olympus FL series external flashes. If the external flash is used, flash mode and exposure compensation will be detected automatically by the camera, allowing the built-in flash and external flash to function together. The external flash is mounted on the camera by attaching it to the hot shoe on the top of the camera. You cannot use the built-in flash and the external flash together.

This section explains how to use the FL-20 when attached to the hot shoe.

1 Slide the shoe cover off in the direction of the arrow and attach the external flash.
   • For instructions on how to attach the flash, refer to the manual for the external flash.
   • Keep the shoe cover in a safe place to prevent it getting lost, and replace it on the camera when you have finished using the external flash.
External flash (optional)

2 Turn on the external flash.
   • Set the mode dial to TTL-AUTO.
   • Be sure to attach the flash to the camera before turning the flash on.

3 Press ‡ to set the flash mode.
   “Flash shooting” (P.61)

   • If close-up pictures are overexposed, use the built-in flash.

Note
Using commercially available external flashes

Provided that the flash can be connected to the hot shoe, a commercially available external flash may be used. For details on compatible commercially available external flashes, refer to the next page. The amount of light emitted cannot be adjusted on commercially available external flashes except Olympus FL series.

1 Attach the external flash to the hot shoe and connect it to the camera.
   • For instructions on how to attach the flash, refer to the manual for the external flash.

2 Select M mode. Adjust the shutter speed and aperture.
   “Manual shooting” (P.76)
   • Remember that a slow shutter speed can produce blurred images. For the best results, we recommend that you set the shutter speed from 1/200 to 1/300 seconds.

3 Turn on the external flash.
   • Be sure to attach the flash to the camera before turning the flash on.

4 Set the mode that automatically controls the amount of light emitted by the external flash. Also set ISO and aperture on the external flash to match the camera’s settings.
   • Refer to the user’s manual for the external flash to select its mode.
External flash (optional)

- The camera’s flash mode will have no effect on the external flash. The external flash will fire even when the camera’s flash mode is set to (off).
- Confirm in advance that the external flash you are using is synchronized with the camera.

Compatible external flashes

When selecting an external flash, use products which meet the following basic conditions.

1. Some flashes available on the market operate with a high voltage synchro terminal. If one of these is used, it may damage the camera, and/or the camera may not function normally. Contact the manufacturer of the flash you are using concerning the specifications of the flash’s synchro terminal.

2. Some flashes available on the market have the polarity of the synchro terminal reversed. In this case, even if the flash is connected, it will not fire. Contact the manufacturer of the flash for more information.

3. Exposures when using an external flash require that adjustments be made on the external flash unit. If an external flash is used in the auto mode, match it with the F value and ISO settings on the camera.

4. Even if the auto F value and ISO of the external flash are set to the same conditions as those on the camera, depending on the photographic conditions, it is possible that the correct exposure may not be obtained anyway. In such a case, adjust the auto F value or ISO value on the external flash unit or calculate the distance in the manual mode and use it that way.

5. Use a flash whose illuminating angle covers the angle of view of the lens. However, in close-up photography with the lens on the wide setting, the bottom of the image may not expose correctly. The ideal is to have a wide angle adapter to fit on the flash and spread the illumination angle so it is wider.

6. Use a flash unit with a flash time of 1/200 sec. or less when using the flash at full strength. For devices with a long flash time, a portion of the light emitted will not contribute to the exposure.

7. If a flash unit or other accessory TTL flash that has additional communications functions other than an Olympus FL series flash is used, it may not only fail to function normally, but may also cause damage to the camera’s circuitry. Do not use such a device.
5 Advanced shooting

A/S/M mode

Select the shooting mode to be used when the mode dial is set to A/S/M.

1 In the top menu, select MODE MENU → CAMERA → A/S/M → A, S or M, and press OK.

- Press OK again to exit the menu.
1. Select A mode.
   - “A/S/M mode” (P.73)

2. Press 

   - : Increases the aperture value.
   - : Decreases the aperture value.

If the aperture value is displayed in red, the aperture setting is unsuitable for the conditions. Take the following steps. (When the aperture value is displayed in green, the setting will provide optimum exposure.)

- 

  - appears: The image is overexposed. Press 
  - appears: The image is underexposed. Press 

Aperture range:
- Toward W: f2.8 to f8.0
- Toward T: f3.7 to f8.0

Note

- When the flash is set to the auto-flash mode, the slowest shutter speed is fixed at the level at which lights. (P.63)
1 Select S mode.
“A/S/M mode” (P. 73)

2 Press ◀ to set the shutter speed.
   ◀: Sets a faster shutter speed.
   ▶: Sets a slower shutter speed.

If the shutter speed is displayed in red, the setting is unsuitable for the conditions. Take the following steps. (When the shutter speed is displayed in green, the setting will provide optimum exposure.)

Shutter speed range: 1" to 1/1000

Appears: The image is overexposed. Press ◀ to set a faster shutter speed.

Appears: The image is underexposed. Press ▶ to set a slower shutter speed.

Shutter speeds that can be set differ according to the flash setting.
1 Select M mode.
   ➔ “A/S/M mode” (P.73)

2 Use the arrow pad to set the aperture value and shutter speed.
   ➔ The aperture value increases.
   ➔ The aperture value decreases.
   ➔ Sets a faster shutter speed.
   ➔ Sets a slower shutter speed.

- When the shutter button is halfway pressed, the difference (ranging from -3.0 to +3.0 EV) between the exposure determined by the currently selected aperture and shutter speed compared to the exposure level considered optimal by the camera is displayed.
- If the exposure differential appears in red, it indicates that the exposure differential is less than -3.0 EV or more than +3.0 EV.
- When you press AEL/ейчас, the screen on the right appears with the bar indicating current exposure differential.

Aperture value : f2.8 to f8.0 (W)
                f3.7 to f8.0 (T)
Shutter speed  : 15" to 1/1000

Note
- To avoid camera movement, you are recommended to use a tripod when taking pictures requiring a slow shutter speed.
Using My Mode

When you use My mode, the settings you selected with the menus in My Mode are activated. Saving the shooting mode or function settings you want to use in advance lets you shoot with your favorite settings straightaway. You can also save the settings you are currently using. You can create and save up to 4 different patterns. “MY MODE SETUP” (P.155)

1 In the top menu, select MODE MENU → CAMERA → My 1/2/3/4 → MY MODE 1 to MY MODE 4, and press .

   “How to use the menus” (P.35)

   • Press again to exit the menu.
   • Only the settings in MY MODE 1 have already been saved. You cannot select MY MODE 2 to MY MODE 4 if no settings have been saved in them. “MY MODE SETUP” (P.155)

Note

   • Although the settings you are using can be saved, the zoom saved may not be the same as the one being used.
Focusing applications

AF MODE – Changing the focus range

This function allows you to select the focus range of your subject.

iESP
Focus selection is based on the entire picture on the screen. Even when the subject is not in the center of the screen, focusing is possible.

SPOT
Focus selection is based on the subject within the AF target mark.

1 In the top menu, select MODE MENU → CAMERA → AF MODE → iESP or SPOT, and press .

• Press again to exit the menu.

Note
• In mode and when AUTO is selected in mode, the AF MODE is fixed at iESP and cannot be changed.
FULLTIME AF – A reliable time-saving way to focus

FULLTIME AF keeps the subject in front of the lens in focus at all times, without having to press the shutter button halfway. When ON is selected, the focusing time is reduced, letting you take successive snapshots. The subject is also automatically kept in focus during movie recording.

1. In the top menu, select MODE \( \rightarrow \) CAMERA \( \rightarrow \) FULLTIME AF \( \rightarrow \) ON, and press \( \circ \).

   “How to use the menus” (P.35)

   - Press \( \circ \) again to exit the menu.

• Battery consumption increases when FULLTIME AF is used.
• FULLTIME AF cannot be used when \( \) is set to ON in \( \) mode.

Note
Focusing applications

AF AREA – Changing the position of the AF target mark

You can select the area you want to focus on by changing the position of the AF target mark.

1. Set the AF MODE to SPOT.
   “AF MODE – Changing the focus range” (P.78)

2. In the top menu, select MODE MENU → CAMERA → AF AREA, and press .
   “How to use the menus” (P.35)

3. Use the arrow pad to move the AF target mark to the area you want to focus on.
   • The AF target mark at the center of the screen can be moved vertically or horizontally.

4. Take the picture.
   • To restore the AF target mark to its original position (at the center), press .
   • Press again to exit AF target mark selection mode.

Note

• AF AREA is not available when the super zoom or digital zoom is set to ON.
• The location of the AF target mark cannot be saved.
AF LOCK – Locking the focus

Registering the AF lock function on the AEL/ﬁ in advance enables easy locking of the focus.

1 Register the AF lock function on AEL/ﬁ. “Setting the custom button” (P.150)

2 Position the AF target mark on the subject you want to focus on and press AEL/ﬁ.
   • The focus is locked and the AF LOCK mark is displayed.
   • To reset the AF LOCK, press AEL/ﬁ again to cancel the AF LOCK. Each time you press AEL/ﬁ, AF lock is alternately engaged and canceled.

   When AEL/ﬁ is pressed

   When focus is locked

3 Press the shutter button fully.
How to save the locked focus after shooting (AF MEMORY)

→ Hold down AEL/ brides for more than 1 second. The AF MEMORY mark appears. When the mark appears, the locked focus is memorized. To cancel AF MEMORY, press AEL/ again.

AF lock was canceled.

→ Do not operate any of the buttons or the mode dial after performing AF LOCK. AF LOCK will be canceled.
→ The camera had emerged from sleep mode or the power was turned off.

Note

• The focus may be compromised by operating the zoom after setting the AF LOCK. Complete zoom operations before setting the AF LOCK.
• AF lock is not available when a menu is displayed on the screen. Exit the menu. “How to use the menus” (P.35)
Manual focus

If auto focus is unable to focus on a subject, use manual focus.

1. Hold down \( \text{for more than 1 second.} \)

2. When the focus distance selection screen appears on the monitor, press \( \) to select MF.

3. Press \( \) to set the focus distance.
   - During operation, the area you are focusing on is enlarged. This lets you check whether the focus is in the right position.
   - The distance indicator on the left of the monitor is for reference only.
   - When the indicator is moved to less than 2 m (6.6 ft.), the display automatically switches to the 7 cm (2.8") to 2 m (6.6 ft.) display.
4 Hold down  for more than 1 second to save the setting.
   • MF is displayed in red on the monitor.

5 Take the picture.
   • The focus is locked at the distance you have set.

To cancel manual focus

1 Hold down  for more than 1 second to display the focus distance selection screen.

2 Press  to select AF, then press .
   • Manual focus is canceled.

TIPS

How to shoot while keeping the same focus distance at all times
   → The focus can be fixed at the same distance as when you perform focus lock.
      1 Position the AF target mark on a subject at the desired distance and press the shutter button halfway.
      2 Keeping the shutter button half-pressed, press .
         • The distance indicator is displayed.
         • MF is selected and the focus is locked at the same distance as when you performed focus lock.

Even if you move the cursor to the top of the distance indicator, focusing is not possible at ∞.
   → Adjust the cursor position by pressing while watching the monitor.

! Note
   • If the zoom lever is pressed after performing manual focus, the saved focus distance may be changed. Perform setting again.
There are three ways of measuring the brightness of a subject.

**ESP metering**
Meters the center of the subject and the surrounding area separately.

**Spot metering**
Exposure is determined by metering within the AF target area. In this mode, a subject can be shot with optimal exposure regardless of the background light. P.85

**Multi-metering**
Meters the brightness of the subject at up to 8 different points to set the optimal exposure based on the average brightness. This method is useful with a high contrast subject. P.86

### Spot metering

1. In the top menu, select ESP/\(\text{ESP} \) and press \(\text{OK}\).
   - In the top menu, the setting can be made in the same way as selecting MODE MENU \(\rightarrow\) CAMERA \(\rightarrow\) ESP/\(\text{ESP} \) \(\rightarrow\) \(\text{ESP}\).

"How to use the menus" (P.35)
MULTI METERING

1  When using the camera in the A/S/M mode, multi-metering is not available in the M mode. Set to any mode except M.

   “A/S/M mode” (P.73)

   • If a function other than AE lock is registered on AEL/ē, set AE lock to the button.

   “Setting the custom button” (P.150)

2  In the top menu, select ESP/ē → MULTI, and press ē.

   • In the top menu, the setting can be made in the same way as selecting MODE MENU → CAMERA → ESP/ē → MULTI.

   “How to use the menus” (P.35)

   • Press ē again to exit the menu.

3  Position the AF target mark on the area you want to meter and press AEL/ē. The brightness is metered at up to 8 different points.

   • Multi-metering bar appears.
   • Brightness meter readings are ignored after the 9th reading.
   • To perform metering again, press AEL/ē for more than 1 second to display MEMO. Press AEL/ē again to cancel the metering values.
Ex: When metering 2 points (pressing AEL/ENTS twice)

The aperture and shutter speed as calculated from the average values obtained by metering at 2 points. These values are recalculated every time another metering point is added.

The average for the 2 metering points. The average is always shown at the center of the bar.

The reading when AEL/ENTS was pressed. The number of ◇ indicates the number of times you have pressed the button. The distance ◇ is from the center of the bar indicates the difference between the metered and average readings.

When ◇ moves more than ±3 from the center of the bar (the average reading), red ◆◆ appear.

---

**TIPS**

To save the locked multi-metering exposure after shooting (AE memory)

→ After metering in Step 3, hold down AEL/ENTS for more than 1 second. MEMO appears. While MEMO is displayed, the exposure is saved. Press AEL/ENTS again to cancel the AE memory.

The multi-metering exposure is canceled.
→ If you operate any of the buttons or the mode dial after metering in step 3, the multi-metering exposure is canceled.
This function is suitable for situations when optimal exposure is difficult to achieve, such as when there is excessive contrast between the subject and the surroundings.
For example, when the sky takes up much of the frame, shooting with automatic exposure sometimes results in a dark subject. Recompose your shot so that not much sky is in the frame. Then press AEL to lock the metered value (exposure) temporarily. Next, compose your shot again with the sky in the frame and take the picture.

1. When using the camera in the A/S/M mode, AE lock is not available in the M mode. Set to any mode except M.
   - “A/S/M mode” (P.73)
   - If a function other than AE lock is registered on AEL, set AE lock to the button.
   - “Setting the custom button” (P.150)

2. Compose the picture where you want to lock the metered value (exposure), then press AEL.
   - The exposure is memorized.
   - If you want to lock a different exposure, press AEL again to cancel AE lock. Each time you press AEL, AE lock is alternately engaged and canceled.
3 Position the AF target mark on the subject you want to focus on and press the shutter button halfway.
   • The green lamp lights.
   • AE lock cannot be canceled while the shutter button is pressed halfway.

4 Press the shutter button fully.
   • AE lock is automatically canceled after one shot.

TIPS

To save the locked metered value (exposure) after shooting (AE memory)
→ After Step 2 or 3, hold down AEL/ Thường for more than 1 second. MÉMO appears. While MÉMO is displayed, the exposure is saved. Press AEL/ Thường again to cancel the AE memory.

AE lock was canceled.
→ Do not operate any of the buttons or the mode dial after performing AE lock. Doing so will cancel AE lock.
→ The camera had emerged from sleep mode or the power was turned off.

Note
• AE lock is not available when multi-metering is enabled. Turn multi-metering off.
   説明 “MULTI METERING” (P.86)
• AE lock is not available when a menu is displayed on the screen. Exit the menu. 説明 “How to use the menus” (P.35)
Macro mode shooting

Focusing is usually slow when you get close to a subject (W: 7 cm/2.8” to 60 cm/2.0 ft., T: 1.2 m/3.9 ft. to 2m/6.6 ft.). However, in the mode focusing is performed quickly. When the optical zoom lever is at the maximum wide position and you are as close as 7 cm/2.8” to your subject, you can fill the entire frame with your subject.

If the center of the frame (within the AF target mark) is metered when you are close to the subject and you shoot with the optimal exposure, the picture will turn out well. "Spot metering" (P.85)

1. In the top menu, select , and press .
   - In the top menu, the setting can be made in the same way as selecting MODE MENU → CAMERA → .
   - “How to use the menus” (P.35)

   • Press again to exit the menu.
   • You cannot select in manual focus mode.
   • Set to AF.
   - “Manual focus” (P.83)
Super macro mode shooting

This mode lets you shoot from as close as 3 cm/1.2" to your subject. Subjects measuring up to approximately 4 × 3 cm (1.6" × 1.2") can be captured on the monitor.

In the shooting mode, normal shooting is also possible, but the position of the zoom is fixed automatically and cannot be changed.

1. In the top menu, select \( \text{ } \rightarrow \text{ } \rightarrow \text{ } \), and press .
   - In the top menu, the setting can be made in the same way as selecting MODE MENU → CAMERA → \( \text{ } \rightarrow \text{ } \rightarrow \text{ } \).
     “How to use the menus” (P.35)
   - Press again to exit the menu.

TIPS

The subject is in shadow.

→ When taking pictures close to the subject, shadows may become conspicuous, and the auto focus may not be able to maintain correct focus. If this happens, use the manual focus. “Manual focus” (P.83)

Note

- During super macro shooting, zoom is not available.
- During super macro shooting, the built-in flash is not available. You can use an external flash, but vignetting may occur. Check the recorded image on the monitor.
Self-timer shooting

This function lets you take pictures using the self-timer. Fix the camera securely on a tripod for self-timer shooting. This function is useful for taking pictures where you want to be included in the photograph.

1. Select  by repeatedly pressing .
   - If no operation is performed for about 3 seconds, the selected mode is set and the mode selector screen is automatically exited.

2. Press the shutter button fully to take the picture.
   - Pressing the shutter button halfway locks the focus and exposure.
   - The self-timer/remote control lamp lights for approximately 10 seconds, then starts blinking. After blinking for approximately 2 seconds, the picture is taken.
   - To stop shooting while in mode, press the shutter button fully again.
   - To cancel the self-timer, press .
   - The self-timer mode is automatically canceled after one shot.

Note

- If sequential shooting is attempted in self-timer mode, the camera shoots max. 5 frames regardless of the setting.
Remote control shooting

Shooting is possible using the remote control device provided with the camera. This is useful when you want to take a picture with yourself in it, or a night scene, without touching the camera.

1. Mount the camera on a tripod or place it on a stable, flat surface.

2. Select \( \text{Self-timer/Remote control} \) by repeatedly pressing (Self-timer/Remote control button).
   - If no operation is performed for about 3 seconds, the selected mode is set and the mode selector screen is automatically exited.

3. Press the shutter button on the remote control device.
   - The focus and exposure are locked. The self-timer/remote control lamp blinks for about 2 seconds before taking the picture.

Self-timer/Remote control lamp
Remote control receiver

5m(16.4ft) 3m(9.8ft) 15°
3m(9.8ft) 5m(16.4ft) 15°
Remote control shooting

TIPS - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

The self-timer/remote control lamp does not blink after pressing the shutter button on the remote control device.
→ The remote control device may be too far from the camera. Move closer to the camera and press the shutter button on the remote control device again.
→ The battery in the remote control device is running low. Replace with a new battery. "How to replace the battery (CR2025) of the remote control device" (P.216)

How to cancel the remote control mode.
→ The remote control mode is not canceled automatically after shooting. Perform Step 2 and set the mode to OFF.

Note
- If the remote control receiver is exposed to strong light, the effective signal distance may be reduced or shooting may not take place.
- To shoot sequential shots using the remote control device, press and hold the shutter button on the remote control device. If the camera does not receive the remote control signal properly, sequential shooting may stop.
Sequential shooting, high speed sequential shooting and AF sequential shooting

1 In the top menu, select MODE MENU → CAMERA → DRIVE → , HI or AF, and press .
   “How to use the menus” (P.35)

In the top menu, select DRIVE → , HI or AF, and press .
   “How to use the menus” (P.35)

• Press again to exit the menu.
2 **Take the picture.**
   - Press the shutter button fully and keep it pressed. The camera will take pictures in sequence until you release the button.

### Auto bracketing

Under some conditions, you may obtain better results shooting with exposure compensation than by using the exposure setting considered optimal by the camera. When auto bracketing is set, the exposure is changed automatically for each frame when you start shooting. The exposure differential and number of frames can be selected in the menus. The focus and white balance are locked at the first frame.

Ex: When **BKT** is set to \( \pm 1.0 \times 3 \)

1. In the top menu, select **MODE MENU → CAMERA → DRIVE → BKT**, and press \( \odot \).

   - “How to use the menus” (P.35)
2 Select the exposure differential. Press \( \uparrow \) \( \downarrow \) to select ±0.3, ±0.7 or ±1.0, then press \( \circ \).

3 Select the number of shots. Press \( \uparrow \) \( \downarrow \) to select \( \times 3 \) or \( \times 5 \), then press \( \circ \).
   • Press \( \circ \) repeatedly until the menu disappears.

4 Take the picture.
   • Press the shutter button fully and keep it pressed to shoot the preset number of pictures. You can stop shooting at any time by releasing the shutter button.

- Sequential shooting (\( \uparrow \), \( \uparrow \), \( \uparrow \), \( \uparrow \), \( \uparrow \), \( \uparrow \), \( \uparrow \), \( \uparrow \)) is not possible in the following situations:
  - When the record mode is set to TIFF or ENLARGE SIZE in SHQ mode.
  - When NOISE REDUCTION is set to ON.
- Auto bracketing is not possible in M mode.
- The built-in flash and external flash do not fire in BKT mode.
- In modes other than S and M, since the shutter speed is set to max. 1/30 sec., exposure is decreased when shooting a dark subject.
- In BKT mode other than S mode, if the shutter speed is set to longer than 1/30 sec. when the exposure differential is 0, the shutter speed is fixed at 1/30 sec. and the picture is taken in BKT mode.
- If the battery power is low and the battery check blinks during sequential shooting, shooting stops and the camera starts saving the pictures you have taken. Whether or not all of the shots are saved depends on how much battery power remains.
- If there is not enough space available on the card for the number of frames you have set during auto bracketing, you cannot continue shooting.
PANORAMA – Panorama shooting

You can take advantage of panorama shooting with Olympus CAMEDIA-brand cards (xD-Picture Card). Panorama shooting lets you connect pictures with overlapping edges into a single panoramic picture, using the CAMEDIA Master software.

1. In the top menu, select MODE MENU → CAMERA → PANORAMA, and press .

   • The PANORAMA mode is set.

2. Use the arrow pad to choose at which edge you want to connect the pictures.

   - : The next picture is connected at the right edge.
   - : The next picture is connected at the left edge.
   - : The next picture is connected at the top.
   - : The next picture is connected at the bottom.
3 Make sure that the edge of the pictures overlap, then take pictures.

- Focus, exposure and white balance are set by the first picture. Do not select an extremely bright subject (such as the sun) for the first picture.
- You cannot adjust the zoom after the first picture.
- Panorama shooting is possible for up to 10 pictures.

![Panorama shooting diagram](image)

The part of the previous picture where it will be joined to the next picture does not remain in the frame on the edge of the screen. You have to remember what the part in the frame looked like and take the next picture so it overlaps. Compose your shots so that the right edge of the previous picture overlaps with the left edge of the next picture if you are connecting pictures from left to right (or vice versa if you are connecting pictures from right to left).

- When you have taken 10 pictures, a warning mark appears.

4 Press 📷 to finish panorama shooting.

- The frame on the screen disappears and the camera returns to the normal shooting mode.

![Hand gesture](image)

Note

- The panorama mode is only available with Olympus CAMEDIA-brand cards.
- Your computer’s memory may be insufficient if you take too many panorama pictures in HQ or SHQ mode. You are recommended to use SQ mode for panorama shooting.
- During panorama shooting, the flash and sequential shooting are not available.
- Images are saved in JPEG format when panorama shooting is done in the TIFF mode. The size of the image does not change.
- If the mode dial is operated during panorama shooting, the camera cancels the panorama mode and returns to normal shooting.
- The camera itself cannot connect panorama pictures. The CAMEDIA Master software is necessary to connect the pictures.
This function allows you to combine two pictures taken in succession and store them as a single picture. You can combine two different subjects in one picture.

1 In the top menu, select MODE MENU → CAMERA → 2 IN 1, and press .

• The 2 IN 1 picture mode is set.

2 Take the first shot.

• The subject will be positioned on the left in the combined picture.

3 Take the second shot.

• The subject will be positioned on the right in the combined picture.
• The BUSY bar is displayed during processing. After the image is saved, the camera returns to the mode menu.
• During 2 IN 1 picture shooting, the panorama and sequential shooting modes are not available.
• To cancel the 2 IN 1 picture mode after the first shot has been taken, press (③). The first shot will not be saved.
• Operating the mode dial will exit 2 IN 1 picture mode.
• If the camera enters sleep mode after the first shot, 2 IN 1 picture mode will be canceled.
FUNCTION – Adding special effects to pictures

This feature lets you add special effects to your pictures during shooting.
4 effects are available.

BLACK & WHITE Takes pictures in black and white.
SEPIA Gives pictures a sepia tone.
WHITE BOARD Pictures are in black and white, with black letters on a white background emphasized to make them easier to read.
BLACK BOARD Pictures are in black and white, with white letters on a black background emphasized to make them easier to read.

1 In the top menu, select MODE → CAMER A → FUNCTION, then select a mode and press .

- WHITE BOARD and BLACK BOARD are not available in " mode.
- Press again to exit the menu.

TIPS
Letters do not show clearly with WHITE BOARD or BLACK BOARD.
→ Use exposure compensation.

Note
- When WHITE/BLACK BOARD is selected, the flash is automatically set to off.
- WB, \[WB\^2\] and SATURATION cannot be used in Function shooting.
Sound can be recorded when taking still pictures. Recording starts about 0.5 seconds after the shutter is released and lasts about 4 seconds. When this function is enabled, sound is recorded automatically every time you take a picture.

1. In the top menu, select MODE MENU → CAMERA → \( \text{ON} \), and press \( \text{MODE} \).
   “How to use the menus” (P.35)
   - Press \( \text{MODE} \) again to exit the menu.

2. When recording starts, turn the camera microphone towards the source of the sound you want to record.
   - The BUSY bar is displayed during recording.

**TIPS**

- \[ \text{M} \] appears when still pictures and movies that have recorded sound are played back. During playback, sound is output from the speaker. The volume can be adjusted. “VOLUME – Playback volume” (P.166)
- Sound can be added later to still pictures. Recorded sound can also be changed. “Recording sound” (P.139)
Recording sound with movies

• If the camera is more than 1 m (3.3 ft.) away from the source of the sound, sound may not be recorded clearly by the built-in microphone.
• Pictures cannot be taken during sound recording.
• Sound recording is not possible in the following cases:
  - the record mode is set to TIFF/the drive mode is set to sequential shooting (., HI., AF., BKT)
• Sound recording may also pick up camera noises, such as button operations, shutter movement, etc.
• Sound recording may not be possible if there is insufficient space in the card memory.

Recording sound with movies

Sound can be recorded while shooting a movie.

1 In the top menu, select MODE MENU → CAMERA → • ON, and press OK.

“How to use the menus” (P.35)

2 Recording starts at the same time as shooting.

• When • is set to ON, the focus and optical zoom are locked during movie recording. If you wish to use the zoom during movie recording, set DIGITAL ZOOM to ON. If • is set to OFF, you can use both the optical zoom and digital zoom during movie recording.
Using commercially available external microphones

You can attach an external microphone to the camera and record sound. When [R] is set to ON, sound is recorded with the picture or movie.

1 Turn the camera off and connect the terminal of the external microphone to the A/V OUT jack.
   • Attaching an external microphone disables the built-in microphone.

2 Set the camera’s sound recording function to ON to record sound.
   • See the following pages for details.
     “Recording sound with still pictures” (P.103)
     “Recording sound with movies” (P.104)
     “Recording sound” (P.139)

TIPS
   • For more details on supported external microphones, refer to the Olympus Web site.
     http://www.olympus.com/

• When [R] is set to OFF, you can use FULLTIME AF during movie recording.
• If you attach an external microphone (optional), you can use the optical zoom and FULLTIME AF while recording sound with a movie.
• If the camera is more than 1 m (3.3 ft.) away from the source of the sound, sound may not be recorded clearly by the built-in microphone.
You can select a record mode in which to take pictures or shoot movies. Choose the best record mode for your purpose (printing, editing on a PC, website editing, etc.). For information on the image size for each record mode and the number of remaining pictures and remaining recording time for the card, see the table on P.108.

Still Picture Record Modes

Normal image mode

<table>
<thead>
<tr>
<th>Application</th>
<th>Resolution</th>
<th>Compression</th>
<th>Un-compressed</th>
<th>Low compression</th>
<th>High compression</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select for the print size</td>
<td></td>
<td>TIFF</td>
<td>SHQ</td>
<td>HQ</td>
<td></td>
</tr>
<tr>
<td>2288 × 1712</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2048 × 1536</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1600 × 1200</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SQ1</td>
</tr>
<tr>
<td>1280 × 960</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>HIGH</td>
</tr>
<tr>
<td>1024 × 768</td>
<td></td>
<td></td>
<td>SQ1</td>
<td>SQ2</td>
<td>NORMAL</td>
</tr>
<tr>
<td>For small sized prints and website</td>
<td>640 × 480</td>
<td></td>
<td>SQ2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>HIGH</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NORMAL</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

●Resolution

The number of pixels (horizontal × vertical) used when saving an image. If the image will be printed, higher resolutions (larger numbers) are recommended so that the image will be clearer. However, higher resolutions make the file size (amount of data) larger, so the number of pictures that can be saved will be fewer.

●Compression

In record modes other than TIFF, image data are compressed. The higher the compression, the less clear the image will be.

●Resolution and picture size on a computer screen

When a picture is transferred to a computer, the size of the picture on the computer screen varies depending on the computer’s monitor setting. For instance, a picture taken in 1024 × 768 resolution is the same size as the screen if you set the picture to 1× when the monitor setting is 1024 × 768. However, if the monitor setting is over 1024 × 768 (such as 1280 × 1024), the picture only takes up part of the screen.
Special record modes

<table>
<thead>
<tr>
<th>Record mode</th>
<th>Features</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENLARGE SIZE</td>
<td>Increases the resolution. This is useful for printing large-sized prints.</td>
<td>3200 × 2400</td>
</tr>
<tr>
<td>(SHQ, HQ)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3:2</td>
<td>This is useful for ordering prints from a photo lab.</td>
<td>2288 × 1520</td>
</tr>
<tr>
<td>(TIFF, SHQ, HQ)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

● 3:2 Resolution
The image aspect ratio is normally 4:3. If the aspect ratio is changed to 3:2, the image can be printed at a photo lab without losing the image borders. The 3:2 aspect ratio setting is not available in AUTO mode.

● ENLARGE SIZE
When ENLARGE SIZE is selected, the actual 4 million pixels used by this camera can be increased to the equivalent of approx. 8 million pixels (3200 × 2400). This allows you to make quality prints in larger sizes, such as A3 (297 mm × 420 mm/11.7” × 16.5”). However, file sizes also become larger. ENLARGE SIZE is not available in the AUTO mode.

• If the SHQ record mode is set to ENLARGE SIZE, sequential shooting modes (l, Hi l, AF l, BKT) are not available.

Movie Record Modes

● MPEG4
If you select MPEG4 in mode, you can record long movies. As movies are recorded at 30 frames per second in MPEG format, action is captured more smoothly than movies recorded in Motion-JPEG format.

● SHQ, HQ, SQ
Movies are recorded in Motion-JPEG format. The quality is better than movies recorded in MPEG4 format, but the file size is larger.
Record modes and the number of storable still pictures/remaining recording time

The number of storable still pictures and remaining recording time is also displayed on the monitor when a card is in the camera.

<table>
<thead>
<tr>
<th>Record mode</th>
<th>Resolution</th>
<th>Compression</th>
<th>File format</th>
<th>Memory capacity in no. of shots</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>With sound</td>
<td>Without sound</td>
</tr>
<tr>
<td>TIFF</td>
<td>2288 × 1712</td>
<td>Uncompressed</td>
<td>TIFF</td>
<td>16MB</td>
</tr>
<tr>
<td></td>
<td>2288 × 1520</td>
<td></td>
<td></td>
<td>3:2 1</td>
</tr>
<tr>
<td></td>
<td>2048 × 1536</td>
<td></td>
<td></td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>1600 × 1200</td>
<td></td>
<td></td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>1280 × 960</td>
<td></td>
<td></td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>1024 × 768</td>
<td></td>
<td></td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>640 × 480</td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>SHQ</td>
<td>2288 × 1712</td>
<td>Low compression</td>
<td>JPEG</td>
<td>16MB</td>
</tr>
<tr>
<td></td>
<td>2288 × 1520</td>
<td></td>
<td></td>
<td>3:2 5</td>
</tr>
<tr>
<td></td>
<td>3200 × 2400</td>
<td></td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>HQ</td>
<td>2288 × 1712</td>
<td>High compression</td>
<td>JPEG</td>
<td>16MB</td>
</tr>
<tr>
<td></td>
<td>2288 × 1520</td>
<td></td>
<td></td>
<td>3:2 15</td>
</tr>
<tr>
<td></td>
<td>3200 × 2400</td>
<td></td>
<td></td>
<td>16</td>
</tr>
<tr>
<td>SQ1</td>
<td>2048 × 1536</td>
<td>HIGH</td>
<td>JPEG</td>
<td>16MB</td>
</tr>
<tr>
<td></td>
<td>1600 × 1200</td>
<td>NORMAL</td>
<td></td>
<td>3:2 19</td>
</tr>
<tr>
<td></td>
<td>1280 × 960</td>
<td>HIGH</td>
<td></td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>1024 × 768</td>
<td>NORMAL</td>
<td></td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>640 × 480</td>
<td>HIGH</td>
<td></td>
<td>66</td>
</tr>
<tr>
<td>SQ2</td>
<td>1024 × 768</td>
<td>NORMAL</td>
<td></td>
<td>58</td>
</tr>
<tr>
<td></td>
<td>640 × 480</td>
<td>NORMAL</td>
<td></td>
<td>25</td>
</tr>
</tbody>
</table>

*HIGH uses low compression/NORMAL uses high compression
Record mode

Movie Record Modes

<table>
<thead>
<tr>
<th>Record mode</th>
<th>Resolution</th>
<th>File format</th>
<th>16MB</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>With sound</td>
</tr>
<tr>
<td>MPEG4</td>
<td>640 × 480 (30 frames/sec.)</td>
<td>MPEG4</td>
<td>46 sec.</td>
</tr>
<tr>
<td>SHQ</td>
<td>640 × 480 (15 frames/sec.)</td>
<td>Motion-JPEG</td>
<td>17 sec.</td>
</tr>
<tr>
<td>HQ</td>
<td>320 × 240 (15 frames/sec.)</td>
<td></td>
<td>46 sec.</td>
</tr>
<tr>
<td>SQ</td>
<td>160 × 120 (15 frames/sec.)</td>
<td></td>
<td>186 sec.</td>
</tr>
</tbody>
</table>

- The number of storable still pictures and remaining recording time listed in the table are approximate.
- The number of storable still pictures may change according to the subject or factors like whether print reservations have been made or not. In certain instances, the number of remaining pictures does not change even when you take pictures or stored images are erased.
- If movies are shot with VIDEO OUT set to PAL and the AV cable connected, the movie recording time will differ from the time listed in the Movie Record Modes table.

Selecting a record mode

1. In the top menu, select MODE MENU → PICTURE → ▼, and press ．
   ① “How to use the menus” (P.35)

   - If ▼ is displayed on the top menu as a shortcut menu, press the arrow pad in the same direction as the arrow shown next to ▼．
   ① “SHORT CUT” (P.152)
Record mode

1. In the top menu, press \( \text{\textcircled{b}} \) to select \( \text{\textcircled{K}} \), and choose SHQ 2288 × 1712, HQ 2288 × 1712, SQ1 1280 × 960 or SQ2 640 × 480. Go to Step 4.

2. In the top menu, press \( \text{\textcircled{b}} \) to select \( \text{\textcircled{K}} \), then press \( \text{\textcircled{ac}} \) to select MPEG4, SHQ, HQ or SQ. Go to Step 4.

3. Press \( \text{\textcircled{ac}} \) to select the desired record mode from TIFF, SHQ, HQ, SQ1 and SQ2, then press \( \text{\textcircled{d}} \).

4. Press \( \text{\textcircled{e}} \).

   • Press \( \text{\textcircled{e}} \) again to exit the menu.
ISO sensitivity

The higher the ISO value, the greater the camera’s light sensitivity and the better its ability to shoot in low light conditions. However, higher values also introduce electrical noise into the resulting image, which may give them a grainy appearance.

**AUTO**
Sensitivity is automatically adjusted according to the light conditions and the subject brightness.

**64/100/200/400**
With a lower ISO setting, you can shoot clear, sharp images in daylight. With a higher ISO setting, you can use faster shutter speeds with the same amount of light.

1. In the top menu, select MODE MENU → CAMERA → ISO. Use the arrow pad to choose the most suitable ISO sensitivity and press the OK button.

   - AUTO is not available in A/S/M mode.
   - Press the OK button again to exit the menu.

**Note**
- Higher ISO settings produce more electrical noise.
- ISO is standardized based on the sensitivity of normal camera film. The scale is approximate.
- When ISO is set to AUTO and you are shooting in dark conditions without a flash, the sensitivity automatically increases, otherwise the shutter speed will be reduced, possibly resulting in camera movement and blurred images.
- If the subject is too far away for the flash illumination to reach when ISO is set to AUTO, the sensitivity is automatically increased.
This function allows you to make fine changes to the present exposure setting using the arrow pad. In some situations, you may get better results when the exposure that the camera sets is compensated (adjusted) manually. You can adjust the exposure in the range of ±2.0 in 1/3 EV steps. When the setting is changed, you can check the result on the monitor or viewfinder.

1. **Press [ Exposure Compensation ] to select a setting.**
   - Adjust toward +: Press [ Exposure Compensation ] to adjust up to +2.0 in 1/3 EV steps.
   - Adjust toward −: Press [ Exposure Compensation ] to adjust up to -2.0 in 1/3 EV steps.

**TIPS**

- Often bright subjects (such as snow) will turn out darker than their natural colors. Adjusting toward + makes these subjects closer to their real shades. For the same reason, adjust toward − when shooting dark subjects.

- You can set the aperture by pressing [ Aperture Compensation ] in M mode.

- If the flash is used, the image brightness (exposure) may differ from the intended brightness.
- Exposure compensation cannot correct the image if the surroundings of the subject are extremely bright or dark.
White balance

Color reproduction differs depending on the light conditions. For instance, when daylight, the setting sun or tungsten lighting are reflected on white paper, the shade of white produced will be slightly different for each. By setting the WB (white balance), you can achieve more natural-looking colors.

1 In the top menu, select MODE MENU → PICTURE → WB, and press .
   "How to use the menus" (P.35)

   In the top menu, press  to select WB.

2 Press  to select AUTO, PRESET or  according to the shooting conditions.

   AUTO Press . Press again to exit the menu.

   PRESET Press  to display the next selection screen.
   "Preset white balance" (P.114)

   Press  to display the next selection screen.
   "One-touch white balance" (P.114)

Auto white balance

Automatically adjusts the white balance for any light source.
Preset white balance

Select a preset white balance setting according to the type of light. Press ☀️ to select one of the following settings, then press 🎥. Press 🎥 again to exit the menu.

- ☀️: For shooting on a sunny day.
- ☁️: For shooting on a cloudy day.
- ⛅️: For shooting under a tungsten light.
- 💡: For shooting under a daylight fluorescent lamp. This type of lamp is used mainly in homes.
- ☁️: For shooting under a neutral white fluorescent lamp. This type of lamp is generally used in desk lamps, etc.
- ☁️: For shooting under a cool white fluorescent lamp. This type of lamp is generally used in offices, etc.

**TIPS**
- You can also preview different color tones by trying the different PRESET WB settings under the actual light source and checking the result on the monitor.

One-touch white balance

This function is useful when you need a more precise white balance than PRESET WB can provide. To set the optimum white balance for the shooting conditions, point the camera at a white object under the light source you want to use and adjust the white balance.

1. Display 📺 screen and point the camera at a sheet of white paper.
   - Position the paper so that it fills the screen, making sure there are no shadows.
2 Press \(\mathcal{W}\).

- The white balance is set and the screen returns to the mode menu.
- To cancel one-touch white balance, press \(\mathcal{W}\).

3 Press \(\mathcal{W}\) repeatedly until the menu disappears.

\(\mathcal{W}\) button

One-touch white balance

Note

- When setting the white balance by pointing the camera at a sheet of white paper, the correct setting may not be obtained if the light reflected by the paper is too bright or too dark.
- White balance may not be effective under some special light sources.
- After setting a white balance other than AUTO, play back the picture and check the colors on the monitor.
- When the flash is fired with a white balance setting other than AUTO, colors may appear different in the resulting picture from the colors you see on the monitor.
White balance adjustment

This function lets you make fine changes to the current white balance setting.

1. In the top menu, select MODE MENU → PICTURE → \( \text{WB}\% \), and press \( \text{OK} \).
   (See “How to use the menus” (P.35))
   • The white balance adjustment indicator appears on the screen.

2. The color becomes bluer each time you press \( \text{\textbf{A}} \), and redder each time you press \( \text{\textbf{T}} \), depending on the original white balance conditions. Press \( \text{\textbf{OK}} \) to save your adjustment.
   • The white balance can be adjusted in 7 increments in both red and blue directions.
   • After saving the adjustment, press \( \text{\textbf{OK}} \) again to exit the menu.
Adjusting the image quality and exposure

SHARPNESS

This function adjusts the sharpness of the image.

1. In the top menu, select MODE > MENU → PICTURE → SHARPNESS, and press .

2. Press to adjust the sharpness between +5 and -5.
   • To increase the sharpness (+) :
     Press . The image contours are emphasized, making the image appear sharper and more vivid. Use this setting when you want to print pictures.
   • To reduce the sharpness (–) :
     Press . The image contours are softened. Use this setting when you want to edit images on a PC.

   • When you have finished setting the sharpness, press . Press again to exit the menu.

   Note
   • If you adjust the sharpness too far toward +, noise may become conspicuous in the picture.
This function adjusts the contrast of images. For example, you can make images with marked differences in light and shadow softer, and those with less differences more vivid.

1. In the top menu, select MODE MENU → PICTURE → CONTRAST, and press (.

2. Press ( to adjust the contrast between +5 and -5.
   - To increase the contrast (+) :
     Press ( . The light and dark areas are defined more clearly, making the image look crisper.
   - To reduce the contrast (−) :
     Press ( . The light and dark areas become less defined, giving the image a softer impression. Use this setting when you want to edit images on a PC.

   - When you have finished setting the contrast, press ( . Press ( again to exit the menu.
This function adjusts the color depth.

1 In the top menu, select MODE MENU → PICTURE → SATURATION, and press OK.

How to use the menus” (P.35)

2 Press to adjust the saturation between +5 and -5.
- To increase the saturation (+) : Press . Colors become darker and more intense.
- To reduce the saturation (–) : Press . Colors become lighter.

When you have finished setting the saturation, press OK. Press OK again to exit the menu.
This function reduces the noise that is generated during long exposures. When shooting night scenes, shutter speeds become slower and noise tends to appear on images. When noise reduction is set to ON, the camera automatically reduces noise to produce clearer images. However, shooting time is approximately twice as long as usual. Noise reduction can only be used when the shutter speed is set slower than 1/2 sec.

1 In the top menu, select MODE MENU → CAMERA → NOISE REDUCTION → ON or OFF, and press OK button.

“How to use the menus” (P.35)

- Press OK button again to exit the menu.

Note
- Noise reduction is always fixed to ON in the mode.
- When noise reduction is set to ON, the camera implements noise-reducing processes after each shot to produce clearer images. However, shooting time is approximately twice as long as usual. During this time, the next shot cannot be taken.
- When noise reduction is set to ON, sequential shooting (HI, AF, BKT) and 2 IN 1 are not possible.
- This function may not work effectively with some shooting conditions or subjects.
- As the shutter speed is relatively slow, the use of a tripod is recommended.
This function reduces the flickering that may appear on the monitor when recording movies under fluorescent light.

1. In the top menu, select MODE MENU → CAMERA → REDUCE FLICKER → ON, and press .
   “How to use the menus” (P.35)
   • Press again to exit the menu.

- When REDUCE FLICKER is ON, picture quality may be affected.
- The correct exposure may not be obtained if REDUCE FLICKER is set to ON in sunny weather.
- When REDUCE FLICKER is ON, the ISO sensitivity is automatically set to AUTO.
During shooting and playback of still pictures, you can display a histogram showing the brightness and contrast of your subject in the viewfinder or monitor. Checking the histogram enables precise exposure control when taking pictures. During playback, you can display a histogram showing the brightness and contrast of recorded pictures. The histogram display can be set separately for shooting mode and playback mode.

Ex: When a histogram is displayed in P mode

![Histogram display](image)

When the image is bright

- If the peak fills too much of the right frame, the image will appear mostly white.

When the image is dark

- If the peak fills too much of the left frame, the image will appear mostly black.
1 In the top menu, select MODE
MENU → CAMERA → ON or OFF, and press OK.
▶ “How to use the menus” (P.35)

• When ON is selected, the histogram is displayed.
• Press OK again to exit the menu.

Note

• The histogram is not displayed in the following situations even if histogram display is set to ON.
  During M mode, panorama shooting, 2 IN 1 shooting and multi-metering
• The histogram displayed during shooting may differ from the histogram displayed during playback.
• A histogram may not appear when you play back pictures shot on another camera.
1 Slide the power switch to \(\text{\textbullet}\). [“Power on/off” (P.25)]

- The monitor turns on and displays the last picture taken. (Single-frame playback)

2 Use the arrow pad to play back other pictures.

- Displays the previous picture.
- Displays the next picture.
- Jumps to the picture 10 frames back.
- Jumps to the picture 10 frames ahead.

Note

- If the camera is not used for over 3 minutes, the camera enters the sleep mode and the monitor turns off.
QUICK VIEW

This function lets you play back pictures while the camera is in the shooting mode. This is useful when you want to check shooting results and resume shooting quickly. Functions available in normal playback mode are also available in QUICK VIEW.

1. Press the QUICK VIEW button in the shooting mode.
   - The camera immediately enters the playback mode and displays the last picture taken. (Single-frame playback)

2. Press the QUICK VIEW button again to return to the shooting mode.
   - You can also return to the shooting mode when the shutter button is gently pressed.
Pictures displayed on the monitor can be enlarged 1.5, 2, 2.5, 3, 3.5 or 4 times.

1. Select the still picture you want to enlarge.
   • You cannot enlarge pictures with 📷.

2. Pull the zoom lever toward T (🔍).
   • Each time you pull the zoom lever, the picture is enlarged gradually.
   • By using the arrow pad while the enlarged picture is displayed, you can shift the picture in the desired direction, enabling you to view a different portion.
   • To return the picture to the original size (1×), push the zoom lever toward W.

Note
• Pictures cannot be stored in an enlarged state.
Index display

This function lets you show several pictures at the same time on the monitor. The number of pictures shown can be 4, 9 or 16. “Selecting the number of pictures” (P.128)

1 In the single-frame playback mode, push the zoom lever toward W ( ).

- Use the arrow pad to select the picture.
  - : Moves to the previous frame.
  - : Moves to the next frame.
  - : Jumps to the previous index display (the frames before the top left frame).
  - : Jumps to the next index display (the frames following the bottom right frame).
- To return to the single-frame playback, pull the zoom lever toward T.
Selecting the number of pictures

This function lets you select the number of pictures in an index display from 4, 9 and 16.

1. In the top menu, select MODE MENU → SETUP → \[ \] → 4, 9 or 16, and press \[ \].
   - Press \[ \] again to exit the menu.

≈ “How to use the menus” (P.35)
This function displays still pictures stored in the card one after another. Only the first frame of movies is played back.

1  Select a still picture, then press \( \text{ \( \text{\textbullet} \) \}} \) to display the top menu.

2  Press \( \text{ \( \text{\textbullet} \) \}} \) to start the slideshow.

3  Press \( \text{ \( \text{\textbullet} \) \}} \) to stop the slideshow.
   - The slideshow will not stop until you cancel it by pressing \( \text{ \( \text{\textbullet} \) \}} \).

Note

- You are recommended to use the optional AC adapter when running a slideshow for a long period of time. If batteries are used, the camera will enter the sleep mode after about 30 minutes and stop the slideshow automatically.
Viewing movies

This function lets you play back movies. You can fast forward the movie, play it back one frame at a time or save selected frames as still pictures (capture, MPEG4/SHQ only).

1 Use the arrow pad to display the picture with  you want to play back.
   “Viewing still pictures” (P.124)

2 Press .
   • The top menu is displayed.

3 Press  to select MOVIE PLAY.

4 Press  to select MOVIE PLAYBACK, then press .
   • The movie is played back. When playback ends, the display automatically returns to the beginning of the movie.
The following operations can be performed during movie playback.

appears on movies that have sound recorded. Pressing lets you adjust the sound volume during playback.

: Increases the volume.

: Reduces the volume.

: Plays the movie at double the normal speed. Holding the button down increases the speed to 20 times the normal speed.

: Plays the movie in reverse at double the normal speed. Holding the button down increases the speed to 20 times the normal speed.

: Pauses the movie and displays the MOVIE PLAYBACK menu.

5 Press .

- The MOVIE PLAYBACK menu is displayed.

PLAYBACK Plays back the entire movie again.

FRAME BY FRAME Plays back the movie manually one frame at a time.

CAPTURE Takes one frame from the movie and saves it as a still picture.

If the movie is recorded in the record mode other than MPEG4/SHQ, this cannot be selected.

EXIT Leaves the movie playback mode.

6 Press to select PLAYBACK, FRAME BY FRAME, CAPTURE or EXIT, then press .

When FRAME BY FRAME is selected

: Displays the first frame of the movie.

: Displays the last frame of the movie.

: Displays the next frame. The movie can be played continuously by holding the button down.

: Displays the previous frame. The movie can be played continuously in reverse by holding the button down.

: Displays the MOVIE PLAYBACK menu.
If you selected CAPTURE

1. Play back the movie one frame at a time until the frame you want to save as a still picture is displayed.
2. Press 🎥.
3. Press 🚪 to select CAPTURE, then press 🎥.
4. Press 🚪 to select OK, then press 🎥.
   • A still picture is created from the extracted movie frame and is displayed on the screen.

TIPS

- Movies can also be played back in the shooting mode using QUICK VIEW. “QUICK VIEW” (P.125)

Note

- Pictures created from movies are saved in 640 × 480 resolution. Pictures may appear grainier than still pictures of the same size.
- You cannot create an index if there is insufficient memory space on the card.
- The card access lamp blinks while the camera is reading the movie from the card. Reading of movies may take considerable time. Do not open the battery compartment/card cover while the card access lamp is blinking, as this may cause not only the data on the card to be damaged, but may render the card unusable.
- When playing back movies shot in MPEG4 format, the following restrictions apply.
  • The playback functions are slow to start.
  • The movie does not play back smoothly in reverse.
  • Movie frames are captured in 0.5-second intervals.
Editing movies

This function lets you create indexes as well as edit movies. However, you cannot edit movies longer than the following:

Movies without sound: Approx. 80 sec. in MPEG4 mode.
Approx. 20 sec. in SHQ mode.
Approx. 70 sec. in HQ mode.
Approx. 300 sec. in SQ mode.

Movies with sound: Approx. 70 sec. in MPEG4 mode.
Approx. 20 sec. in SHQ mode.
Approx. 70 sec. in HQ mode.
Approx. 300 sec. in SQ mode.

INDEX 9 frames extracted from a movie are displayed as an index to show the movie at a glance. Indexes can be stored on the card as a still picture.

EDIT This function lets you erase parts of the movie that you do not want.

1 Use the arrow pad to select a picture with ∇.

2 In the top menu, select MOVIE PLAY, then choose each item.
   “How to use the menus” (P.35)
   • Select INDEX P.133
   • Select EDIT P.135

INDEX – Creating an index

3 Press ∇ to select INDEX, then press ∇.
   • When there is insufficient card memory, a warning screen appears and the display returns to the setting screen.
4 Use the arrow pad to select the first frame of the index and press  
   : Jumps to the first frame of the movie.
   : Jumps to the last frame of the movie.
   : Displays the next frame. The movie can be played continuously by holding the button down.
   : Displays the previous frame. The movie can be played continuously in reverse by holding the button down.

5 As in Step 4, use the arrow pad to select the last frame of the index and press  

6 Press  to select OK, then press  
   • The 9 frames extracted from the movie appear as an index display, then the camera returns to the playback mode. The index is stored as a new picture.
   • If you want to select different frames, select RESET and press  and repeat the procedure from Step 4.
   • To quit the editing function, select CANCEL and press .

TIPS
   • The index is stored as a still picture in a different record mode from the original movie.

<table>
<thead>
<tr>
<th>Record mode when the movie was shot</th>
<th>Record mode when stored as an index</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPEG4</td>
<td>SQ2 (1024 × 768 pixels: HIGH)</td>
</tr>
<tr>
<td>SHQ</td>
<td>SQ2 (1024 × 768 pixels: HIGH)</td>
</tr>
<tr>
<td>HQ</td>
<td>SQ2 (1024 × 768 pixels: HIGH)</td>
</tr>
<tr>
<td>SQ</td>
<td>SQ2 (640 × 480 pixels: HIGH)</td>
</tr>
</tbody>
</table>
• The interval between the frames that are automatically picked out varies depending on the length of the movie.
• An index consists of 9 frames.
• You cannot create an index if there is insufficient memory space on the card.

**EDIT – Editing a movie**

3 Press EDIT to select EDIT, then press 

4 Use the arrow pad to select the first frame of the part you want to keep and press .

: Jumps to the first frame of the movie.
: Jumps to the last frame of the movie.
: Displays the next frame. The movie can be played continuously by holding the button down.
: Displays the previous frame. The movie can be played continuously in reverse by holding the button down.

5 As in Step 4, use the arrow pad to select the last frame of the part you want to keep and press .
6 Press \( \text{GO} \) to select OK, then press \( \text{OK} \).
- If you want to select different frames, select RESET and press \( \text{GO} \) and repeat the procedure from Step 4.
- To quit the editing function, select CANCEL and press \( \text{GO} \).

7 Press \( \text{GO} \) to select NEW FILE or OVERWRITE, then press \( \text{OK} \).

NEW FILE Stores the edited movie as a new movie.
OVERWRITE Stores the edited movie with the same name as the original. The original movie is not stored.

- The edited movie is stored and the screen returns to the playback mode.

⚠️ Note
- You cannot edit movies with sound which were taken with another digital camera.
- You cannot select NEW FILE if there is insufficient memory space on the card.
- You cannot create an index or edit a movie when the movie is played back setting SWITCH FRAME to \( \text{On} \).
- Movies shot in MPEG4 format are edited in 0.5-second intervals.
Use the AV cable provided with the camera to play back recorded images on your TV. You can play back both still pictures and movies on your TV.

1. Make sure that the TV and camera are turned off. Connect the A/V OUT jack on the camera to the Video input terminal on the TV using the AV cable.

2. Turn the TV on and set it to the video input mode.
   - For details of switching to video input, refer to your TV’s instruction manual.

3. Slide the power switch to to turn the camera on.
   - The last picture taken is displayed on the TV. Use the arrow pad to select the picture you want to display.
   - The close-up playback, index display and slideshow functions can also be used on a TV screen.

**TIPS**
- You are recommended to use the optional AC adapter when using the camera with a TV.

**Note**
- Make sure that the camera’s video output signal type is the same as the TV’s video signal type.
  - “VIDEO OUT – Video output selection” (P.172)
- The camera’s monitor or viewfinder turns off automatically when the AV cable is connected to the camera.
- Be sure to use the AV cable provided to connect the camera to the TV.
- The picture may appear off-center on the TV screen.
When pictures are compressed in order to fit the entire picture on the TV screen, a black frame may appear around the picture. If the picture is output to a video printer via the TV, the black frame may be printed.

**Picture rotation**

Pictures taken with the camera held vertically are displayed horizontally. This function lets you turn such pictures 90 degrees counterclockwise or clockwise so that they are displayed vertically.

**1 In the single-frame playback mode, press ▼.**

- Each pressing rotates the image in the following sequence: 90 degrees counterclockwise, 90 degrees clockwise, and back to the original.

- The following pictures cannot be rotated.
  - Movies, protected pictures, pictures being played with [M], pictures that have been edited on a PC, and pictures taken with another camera.
  - New picture orientations are saved even when the power is turned off.
Recording sound

Sound can be added to a still picture that you have already taken. (This is known as “after-recording”.) You can also re-record over the sound that has already been recorded. Total recording time per picture is approximately 4 seconds.

1. Use the arrow pad to select the still picture you want to add sound to.

2. In the top menu, select MODE
   MENU → PLAY → 🎧.
   “How to use the menus” (P.35)

3. Press 🎧 to display START.

4. Turn the camera microphone toward the sound you want to record and press 🎧 to start recording.
   - The BUSY bar is displayed during recording.

Note

- If the microphone is placed farther than 1 m (3.3 ft.) from the subject, sound may not be recorded properly.
- If you re-record the sound, the original sound is erased.
- You may not be able to record sound when there is insufficient card memory (the “CARD FULL” message is displayed).
- Sound recording may pick up camera noises, such as button operation or shutter movement.
- Once sound is added to a picture, it is not possible to erase only the sound. In this case, make a re-recording with silence.
Editing still pictures

This function lets you edit still pictures and store them as new pictures. The following editing operations are possible.

Resizing  
Changes the picture size to 640 × 480 or 320 × 240 and stores the picture as a new file.

Trimming  
Crops part of a picture and saves it as a new file.

1 Use the arrow pad to select the still picture you want to edit.

2 In the top menu, select MODE MENU → EDIT, then choose each item.

• Select Resizing  P.140
• Select Trimming  P.141

Resizing

3 Select  , then press .

4 Press  to select the picture size, then press .

• The BUSY bar is displayed during resizing. After the image is saved, the camera returns to the playback mode.
• To quit the resizing function, select CANCEL, then press .

Note

• Resizing is not possible in the following cases.
  Movies, pictures that have been edited on a PC, or when there is insufficient memory space on the card.
• If the size of the selected picture is 640 × 480, you cannot select 640 × 480.
Trimming

3 Select □, then press ◦.

4 Press ◇◇ to select □, then press ◦.

5 Use the arrow pad and zoom lever to decide the trimming position and size.
   • Press ◇◇◇ to move the trimming frame.
   • Use the zoom lever to decide the trimming size. The trimming frame changes from horizontal to vertical and vice versa when the maximum or minimum size is reached.

6 Press ◦.

7 Press ◇◇ to select OK, then press ◦.
   • The BUSY bar is displayed during trimming. After the image is saved, the camera returns to the playback mode.
   • The trimmed picture is stored as a separate picture from the original.
   • If you want to trim the picture again, select RESET and press ◦ and repeat the procedure from Step 5.
   • To quit the trimming function, select CANCEL and press ◦.
• Trimming is not possible in the following cases.
  Movies, when there is insufficient memory space on the card, or
  when the picture was taken with the record mode set to
  ENLARGE SIZE

• It may not be possible to trim pictures taken with another camera.
• If a trimmed picture is printed out, it may appear grainy.
Protecting pictures

You are recommended to protect important pictures to avoid accidentally erasing them. You can play back only protected pictures.

“SWITCH FRAME – Playing back only protected pictures” (P.144)

Protected pictures cannot be erased by the single-frame/all-frame erase function.

1 Use the arrow pad to display the picture you want to protect.

“Viewing still pictures” (P.124)

2 Press Protect.

• To cancel protection, press Protect again.

Note

 Protected pictures cannot be erased by the single-frame/all-frame erase function, but they are all erased by formatting.
SWITCH FRAME – Playing back only protected pictures

You can play back only protected pictures. This can be used to separately manage pictures taken as a travel memo and separate those pictures you want to show to others.

**ALL**  All pictures are played back.

**On**  Only protected pictures are played back.

1. **In the top menu, select SWITCH FRAME → On, and press OK.**

   - Only protected pictures are played back.
   - When ALL is selected, all pictures stored in the card are played back.

---

**Note**

- Images selected from On and played back are protected and cannot be erased. To erase a picture, press On to cancel the protection setting, then select ALL and erase the desired picture.
- If On is pressed during playback of a picture selected from On, the protection setting for the displayed picture is canceled and the picture cannot be played back even by selecting On.
- Images selected from On and played back cannot be rotated.

See “Picture rotation” (P.138)
Erasing pictures

This function erases recorded pictures. Pictures can be erased either one frame at a time or all the pictures in the card.

- You cannot erase protected pictures. Cancel protection before erasing such pictures.
- Pictures played back with 0 cannot be deleted. “SWITCH FRAME – Playing back only protected pictures” (P.144)
- Once erased, pictures cannot be restored. Check each picture before erasing to avoid accidentally erasing pictures you want to keep. “Protecting pictures” (P.143)

Single-frame erase

1 Use the arrow pad to display the picture you want to erase. “Viewing still pictures” (P.124)

2 Press ．
   • The ERASE screen is displayed.

3 Press  to select YES, then press ．
   • The picture is erased and the menu is closed.
All-frame erase

This function erases all the pictures on the card.

1. In the top menu, select MODE MENU → CARD → CARD SETUP and press .
   "How to use the menus" (P.35)

2. Press to select ALL ERASE, then press .

3. Press to select YES, then press .
   • All the pictures are erased.
8 Useful functions

ALL RESET – Saving the camera’s settings

This function lets you choose whether or not to save the current camera settings after the power is turned off. The settings affected by ALL RESET are listed on the next page.

The All Reset setting (ON/OFF) applies to all the modes. If ALL RESET is set to OFF in one shooting mode, this setting applies to all the other modes, both shooting and playback.

ON All settings are returned to the factory default settings after the power is turned off. (Factory default settings)

Example: If ALL RESET is set to ON and the record mode is changed to SQ1, the record mode returns to the default factory setting (HQ) when the camera is turned on again.

OFF The settings made before the power is turned off are saved.

1 In the top menu, select MODE MENU → SETUP → ALL RESET → OFF or ON, and press (ok).

• Press (ok) again to exit the menu.

• MY MODE settings and the settings in the SETUP tab in the MODE MENU (ALL RESET, etc.) are saved even when ALL RESET is set to ON.
## Functions that All Reset ON setting affects

<table>
<thead>
<tr>
<th>Function</th>
<th>Factory default setting</th>
<th>Ref. Page</th>
<th>Function</th>
<th>Factory default setting</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>F No</td>
<td>F2.8</td>
<td>P.74</td>
<td>AF MODE</td>
<td>iESP</td>
<td>P.78</td>
</tr>
<tr>
<td>SHUTTER</td>
<td>1/1000</td>
<td>P.75</td>
<td>(still pictures)</td>
<td>OFF</td>
<td>P.103</td>
</tr>
<tr>
<td>0.0</td>
<td>P.112</td>
<td></td>
<td>(movies)</td>
<td>OFF</td>
<td>P.104</td>
</tr>
<tr>
<td>FLASH MODE</td>
<td>AUTO</td>
<td>P.61</td>
<td>SUPER ZOOM</td>
<td>OFF</td>
<td>P.59</td>
</tr>
<tr>
<td>0.0</td>
<td>P.68</td>
<td></td>
<td>FUNCTION</td>
<td>OFF</td>
<td>P.102</td>
</tr>
<tr>
<td>AF/MF</td>
<td>AF</td>
<td>P.83</td>
<td>INFO</td>
<td>OFF</td>
<td>P.160</td>
</tr>
<tr>
<td>LCD*</td>
<td>ON (Lights)</td>
<td>—</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OPTICAL ZOOM</td>
<td>38mm</td>
<td>P.58</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ESP/ESP</td>
<td>ESP</td>
<td>P.85</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🌱 OFF</td>
<td>P.90</td>
<td></td>
<td>SHARPNESS</td>
<td>±0</td>
<td>P.117</td>
</tr>
<tr>
<td>DRIVE</td>
<td></td>
<td>P.95</td>
<td>CONTRAST</td>
<td>±0</td>
<td>P.118</td>
</tr>
<tr>
<td>BKT</td>
<td>±1.0, 3 pictures</td>
<td>P.96</td>
<td>REDUCE FLICKER</td>
<td>OFF</td>
<td>P.121</td>
</tr>
<tr>
<td>ISO</td>
<td>AUTO/64</td>
<td>P.111</td>
<td>SATURATION</td>
<td>±0</td>
<td>P.119</td>
</tr>
<tr>
<td>A/S/M</td>
<td>A</td>
<td>P.73</td>
<td>TIFF, SHQ, HQ</td>
<td>2288 × 1712</td>
<td>P.109</td>
</tr>
<tr>
<td>🌱 SLOW</td>
<td>🌱 SLOW1</td>
<td>P.67</td>
<td>SQ1</td>
<td>1280 × 960 NORMAL</td>
<td>P.109</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>OFF</td>
<td>P.120</td>
<td>SQ2</td>
<td>640 × 480 NORMAL</td>
<td>P.109</td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>OFF</td>
<td>P.60</td>
<td>INFO</td>
<td>OFF</td>
<td>P.160</td>
</tr>
<tr>
<td>FULLTIME AF</td>
<td>OFF</td>
<td>P.79</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* This sets whether the monitor turns on or not when the camera is turned on.
Functions listed in the table below can be assigned to the custom button on the camera. This makes it easy to jump to frequently used functions simply by pressing the custom button without having to select a shortcut menu or MODE MENU from the top menu.

<table>
<thead>
<tr>
<th>Available functions</th>
<th>Settings</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>AE LOCK (factory default setting)</td>
<td></td>
<td>P.88</td>
</tr>
<tr>
<td>AF LOCK</td>
<td></td>
<td>P.81</td>
</tr>
<tr>
<td>AE Lock/Custom button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ESP, SPOT</td>
<td></td>
<td>P.85</td>
</tr>
<tr>
<td>OFF, SLOW</td>
<td></td>
<td>P.90</td>
</tr>
<tr>
<td>DRIVE</td>
<td>○, ●, HI, ●, AF, BKT</td>
<td>P.95</td>
</tr>
<tr>
<td>ISO</td>
<td>AUTO, 64, 100, 200, 400</td>
<td>P.111</td>
</tr>
<tr>
<td>A/S/M</td>
<td>A, S, M</td>
<td>P.73</td>
</tr>
<tr>
<td>SLOW</td>
<td>SLOW1, SLOW1, SLOW2</td>
<td>P.67</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>OFF, ON</td>
<td>P.120</td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>OFF, ON</td>
<td>P.60</td>
</tr>
<tr>
<td>FULLTIME AF</td>
<td>OFF, ON</td>
<td>P.79</td>
</tr>
<tr>
<td>AF MODE</td>
<td>iESP, SPOT</td>
<td>P.78</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>OFF, BLACK &amp; WHITE, SEPIA, WHITE BOARD, BLACK BOARD</td>
<td>P.102</td>
</tr>
<tr>
<td>INFO</td>
<td>OFF, ON</td>
<td>P.160</td>
</tr>
<tr>
<td>TIFF, SHQ, HQ, SQ1, SQ2</td>
<td></td>
<td>P.106</td>
</tr>
<tr>
<td>WB</td>
<td>AUTO, 5, 3, 1, w, x, y</td>
<td>P.113</td>
</tr>
<tr>
<td>(still pictures)</td>
<td>OFF, ON</td>
<td>P.103</td>
</tr>
<tr>
<td>SUPER ZOOM</td>
<td>OFF, ON</td>
<td>P.59</td>
</tr>
</tbody>
</table>
Setting the custom button

1. In the top menu, select MODE MENU → SETUP → CUSTOM BUTTON, and press .
   “How to use the menus” (P.35)

2. Press to select a function, then press .
   - Press again to exit the menu.
Using the custom button

1 Press AEL/ Exposure Lock.
   • The monitor turns on and the function currently set to the custom button appears.

Ex: When DRIVE is set on the custom button

TIPS

When ISO is set to the custom button but you want to use AE lock
   → The AE lock function cannot be used when a different function is set to the custom button. Reset AE lock to the custom button by following “Setting the custom button” (P. 150).

• You cannot set the custom button separately in each mode.
You can set three shortcut menus (A, B, C) on the top menu in "Camera" mode (except AUTO).
This is useful when you want to go quickly to frequently used functions.

### Functions that can be set in the shortcut menu

<table>
<thead>
<tr>
<th>Functions that can be set in the shortcut menu</th>
<th>Ref. Page</th>
<th>Functions that can be set in the shortcut menu</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESP/5</td>
<td>P.85</td>
<td>2 IN 1</td>
<td>P.100</td>
</tr>
<tr>
<td>A/S/M</td>
<td>P.73</td>
<td>FUNCTION</td>
<td>P.102</td>
</tr>
<tr>
<td>1/2/3/4</td>
<td>P.77</td>
<td>AF AREA</td>
<td>P.80</td>
</tr>
<tr>
<td>SLOW</td>
<td>P.68</td>
<td>INFO</td>
<td>P.160</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>P.67</td>
<td>WB</td>
<td>P.113</td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>P.60</td>
<td>SHARPNESS</td>
<td>P.116</td>
</tr>
<tr>
<td>FULLTIME AF</td>
<td>P.79</td>
<td>CONTRAST</td>
<td>P.118</td>
</tr>
<tr>
<td>AF MODE</td>
<td>P.78</td>
<td>SATURATION</td>
<td>P.119</td>
</tr>
<tr>
<td>PANORAMA</td>
<td>P.98</td>
<td>(still pictures)</td>
<td>P.103</td>
</tr>
</tbody>
</table>

**Default setting**
- A: ESP/5
- B: 1/2/3/4
- C: SLOW

---

**Top menu**

- MODE MENU
- ESP
- A
- B
- C
- Default setting
  - A: ESP/5
  - B: 1/2/3/4
  - C: SLOW
Setting the shortcut menu

You can set the three shortcut menus designated by A, B and C on the diagram shown right.

1. In the top menu, select MODE MENU → SETUP → SHORT CUT, and press OK.
   “How to use the menus” (P.35)

2. Press OK to select A, B or C, then press OK.

3. Press OK to select a function, then press OK.
   • The shortcut menu is set.
   • Press OK again to exit the menu.
Using the shortcut menu

When you have set a shortcut menu, you can use it to jump to the setting screen for that function.

1. Press \( \text{OK} \) to display the top menu.
   • The shortcut menu you have set appears on the top menu.

2. Press \( \text{\textcircled{a}} \) or \( \text{\textcircled{b}} \) or \( \text{\textcircled{c}} \) to select the shortcut menu.
   • The monitor jumps directly to the setting screen for that function.

Ex: When \( \text{WB} \) is set in shortcut menu A

Top menu

Press \( \text{\textcircled{a}} \).

Pressing \( \text{\textcircled{a}} \) takes you directly to \( \text{WB} \) screen.

- You cannot set the shortcut menu separately in each mode.

Note
MY MODE SETUP

You can set shooting-related functions in MY MODE. When the camera is in P, A, S or M mode, you can also save the current settings in MY MODE. When the mode dial is set to [MY], your customized settings are activated. You can save up to 4 different settings in MY MODE 1 to 4. Only MY MODE 1 has a factory default setting.

Functions affected by MY MODE SETUP

<table>
<thead>
<tr>
<th>Functions that can be set in MY MODE</th>
<th>Default setting</th>
<th>Ref. Page</th>
<th>Functions that can be set in MY MODE</th>
<th>Default setting</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>P/A/S/M/S-Prg</td>
<td>P</td>
<td>P.47</td>
<td>DIGITAL ZOOM</td>
<td>OFF</td>
<td>P.60</td>
</tr>
<tr>
<td>F No</td>
<td>F 2.8</td>
<td>P.74</td>
<td>FULLTIME AF</td>
<td>OFF</td>
<td>P.79</td>
</tr>
<tr>
<td>SHUTTER</td>
<td>1/1000</td>
<td>P.75</td>
<td>AF MODE</td>
<td>iESP</td>
<td>P.78</td>
</tr>
<tr>
<td></td>
<td>0.0</td>
<td>P.112</td>
<td>PANORAMA</td>
<td>OFF</td>
<td>P.98</td>
</tr>
<tr>
<td>LCD *1</td>
<td>ON</td>
<td>—</td>
<td>2 IN 1</td>
<td>OFF</td>
<td>P.100</td>
</tr>
<tr>
<td>ZOOM *2</td>
<td>38mm</td>
<td>—</td>
<td>FUNCTION</td>
<td>OFF</td>
<td>P.102</td>
</tr>
<tr>
<td>FLASH MODE</td>
<td>AUTO</td>
<td>P.61</td>
<td>INFO</td>
<td>OFF</td>
<td>P.160</td>
</tr>
<tr>
<td></td>
<td>OFF</td>
<td>P.92, 93</td>
<td>WX</td>
<td>OFF</td>
<td>P.122</td>
</tr>
<tr>
<td>AF/MF</td>
<td>AF</td>
<td>P.83</td>
<td>HQ</td>
<td>None</td>
<td>P.106</td>
</tr>
<tr>
<td>ESP/</td>
<td>ESP</td>
<td>P.85</td>
<td>WB</td>
<td>AUTO</td>
<td>P.113</td>
</tr>
<tr>
<td></td>
<td>OFF</td>
<td>P.90</td>
<td>WB*</td>
<td>None</td>
<td>P.116</td>
</tr>
<tr>
<td>DRIVE</td>
<td></td>
<td>P.95</td>
<td>SHARPNESS</td>
<td>±0</td>
<td>P.117</td>
</tr>
<tr>
<td>ISO</td>
<td>AUTO</td>
<td>P.111</td>
<td>CONTRAST</td>
<td>±0</td>
<td>P.118</td>
</tr>
<tr>
<td></td>
<td>0.0</td>
<td>P.68</td>
<td>SATURATION</td>
<td>±0</td>
<td>P.119</td>
</tr>
<tr>
<td>SLOW</td>
<td>SLOW1</td>
<td>P.67</td>
<td>(still pictures)</td>
<td>OFF</td>
<td>P.103</td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>OFF</td>
<td>P.120</td>
<td>SUPER ZOOM</td>
<td>OFF</td>
<td>P.59</td>
</tr>
</tbody>
</table>

*1 This will set the monitor to ON or OFF when the camera is turned on.
*2 In [MY] mode, available zoom positions are 38mm/50mm/100mm/200mm/380mm (these numbers are based on the focal length of a 35mm camera).
MY MODE SETUP

1. In the top menu, select MODE MENU → SETUP → MY MODE SETUP, and press  
   “How to use the menus” (P.35)

2. Press  to select the type of setting, then press  
   CURRENT Saves the current camera settings.  
   RESET Restores the factory default settings.  
   CUSTOM Saves settings one by one.  
   • The MY MODE SETUP screen appears.

3. Select a MY MODE number.  
   • Press  to select a MY MODE number from 1 to 4, then press  

●When selecting CURRENT in Step 2

4. Press  to select SET, then press  
   • The current camera settings are saved in the selected MY MODE.
● When selecting RESET in Step 2

4 Press ◀ ▶ to select ALL RESET, then press ◐.
   • The settings in the selected MY MODE are reset.
   If no settings are saved, MY MODE settings cannot be selected.

● When selecting CUSTOM in Step 2

4 Press ◀ ▶ to select the item you want to save in MY MODE, then press ◐.
   • For the available items, see “Functions affected by MY MODE SETUP” (P.155).

Press ◀ ▶ to change the setting, then press ◐.
   • The setting is saved.
   • You can also change the other custom settings.

5 When you have made all the settings you want, press ◐.
   • The screen displayed in Step 2 appears.
   • Press ◐ again to exit the menu.

Note

• Although the settings you are using can be saved, the zoom position you are currently using may not be saved. The zoom position will be the closest of the 5 zoom settings in MY MODE to the position currently being used.
This function lets you format a card. Formatting prepares cards to receive data. Before using non-Olympus cards or cards which have been formatted on a PC, you must format them with this camera.

All existing data, including protected pictures, are erased when the card is formatted. Make sure that you save or transfer important data to a PC before formatting a card.

1 In the top menu, select MODE MENU → CARD → CARD SETUP, and press .
   “How to use the menus” (P.35)

   • The FORMAT screen is displayed.

In the top menu, press to select CARD SETUP.

In the top menu, select MODE MENU → CARD → CARD SETUP, and press . Press to select FORMAT, then press .
   “How to use the menus” (P.35)
2 Press \text{n} to select YES, then press \text{on}.

- The \text{BUSY} bar is displayed and the card is formatted.

\text{Note}

- Never do the following during formatting, as they may cause the card to malfunction.
  - Open the battery compartment/card cover. Remove the battery.
  - Connect or disconnect the AC adapter.
Information display

This function lets you display detailed shooting information on the monitor for approx. 3 seconds in the playback mode. For details of the information displayed, see “Viewfinder and monitor indications” (P.14).

1 In the top menu, select MODE
MENU → CAMERA → INFO → ON or OFF, and press .
“How to use the menus” (P.35)

Pressing in the top menu displays the full amount of shooting information on the monitor (ON).
• To turn INFO off, press to display the top menu and press again.

Ex. Playback mode

When INFO is ON When INFO is OFF

Note
• If the picture has been taken with a different camera, setting INFO to ON in mode may still not display all the information.
• If is set, the histogram is displayed regardless of whether INFO is set to ON or OFF.
• If you are using a print service without DPOF, the specified file numbers are displayed when INFO is set to ON in mode.
“How to print pictures” (P.173)
Monitor/viewfinder brightness adjustment

This function lets you adjust the brightness of the monitor and viewfinder respectively.

1 In the top menu, select MODE MENU → SETUP → !, and press .
   “How to use the menus” (P.35)

2 Press  to adjust the brightness while looking in the monitor or viewfinder, and when you have set the desired level, press .
   • Pressing  brightens the monitor or viewfinder, and pressing  darkens it.
   • Press  again to exit the menu.
You can choose whether or not to display the picture you have just taken on the monitor.

**ON**  The picture being recorded to the card is displayed. This is useful for making a brief check of the picture you have just taken. Pressing the shutter button halfway during Rec View lets you resume shooting immediately.

**OFF**  The picture being recorded to the card is not displayed. This is useful when you want to prepare for your next shot while the previous picture is being recorded.

1. In the top menu, select MODE MENU → SETUP → REC VIEW → ON or OFF, and press (OK).  
   “How to use the menus” (P.35)
   - Press (OK) again to exit the menu.
SLEEP – Sleep Timer

The camera automatically enters the sleep mode and stops the operation when the preset time has elapsed with no operations performed. The camera activates again as soon as you touch the shutter button or arrow pad.

1. In the top menu, select MODE MENU → SETUP → SLEEP → 30 SEC, 1 MIN, 3 MIN, 5 MIN or 10 MIN, and press \( \text{\textcopyright} \).

   - Press \( \text{\textcopyright} \) again to exit the menu.

   - The sleep mode is not activated when using the AC adapter.
   - In \( \text{\textcopyright} \) mode, the sleep mode is activated after 3 minutes regardless of the setting and the monitor turns off.
   - If a slideshow lasts more than 30 minutes, the camera automatically enters the sleep mode and the monitor turns off.
You can set the kind of beep sound used for button operations or warnings. You can also set the volume of each kind of sound to LOW or HIGH. You can turn the sound off completely by setting OFF.

1 In the top menu, select MODE MENU → SETUP → RJ)), and press .
   “How to use the menus” (P.35)

2 Select 1 or 2 and press . Then select LOW or HIGH and press OK.
   • To turn off the beep sound, select OFF and press .
   • Press again to exit the menu.
Useful functions

SHUTTER SOUND

You can select from 2 kinds of sound for the shutter button. You can also set the volume of each kind of sound to LOW or HIGH. You can turn the sound off completely by setting OFF.

1  In the top menu, select MODE MENU → SETUP → SHUTTER SOUND, and press .

“How to use the menus” (P.35)

2  Select 1 or 2 and press . Then select LOW or HIGH and press .

• To turn off the shutter sound, select OFF and press .
• Press again to exit the menu.
VOLUME – Playback volume

You can adjust the volume when playing back a still picture with sound or a movie, as well as the volume of the sound generated when the power is turned on or off. There are 5 levels to choose from.

1. In the top menu, select MODE → MENU → SETUP → VOLUME, and press ő.
   "How to use the menus" (P.35)

2. Press ő ő to set the volume, then press ő.
   • Press ő again to exit the menu.

Selecting this level will mute the sound completely.
Useful functions

POWER ON/OFF SETUP – Power on/off display/sound setting

You can select a picture and/or sound to be displayed/output when the power is turned on and off. It is also possible to register your favorite picture. “SCREEN SETUP” (P.168)

1 In the top menu, select MODE > MENU Æ SETUP Æ PW ON/OFF SETUP, and press . “How to use the menus” (P.35)

2 Press to select SCREEN, then press . Press to select OFF, 1 or 2, then press .

OFF No picture is displayed.
1 Factory default setting
2 Selects a picture already registered. If there is no picture registered, nothing is displayed when the power is turned on or off.

3 Press to select SOUND, then press . Press to select OFF or ON, then press .

OFF There is no startup/shutdown sound.
ON Factory default setting
• The volume level is the same as that set for the playback volume. “VOLUME – Playback volume” (P.166)
• When you have made all the settings you want, press . Press repeatedly until the menu disappears.
SCREEN SETUP

You can register your favorite picture to be displayed when the power is turned on and off. The desired picture can be registered from the card. Make the POWER ON/OFF SETUP to display the registered picture.

“POWER ON/OFF SETUP – Power on/off display/sound setting” (P.167)

1 In the top menu, select MODE MENU → SETUP → SCREEN SETUP, and press .

“How to use the menus” (P.35)
• If a picture is already registered, the IMAGE EXISTING screen is displayed asking if you want to cancel the currently registered picture and register a new one. To register a new picture, select RESET and press . If you select KEEP, the screen returns to the menu.

2 Select the picture you want to register using the arrow pad and press .

3 Press to select OK, then press .
• The picture is registered and the screen returns to the menu.
• Press again to exit the menu.

- You cannot register pictures and movie frames that cannot be played back on this camera.
The camera automatically creates file names and folder names for images to be stored in. Files can be numbered from 0001 to 9999 and folders can be numbered from 100 to 999. Examples are shown below.

<table>
<thead>
<tr>
<th>Folder name</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>\DCIM***OLYMP</td>
<td>\P m d d ***.jpg</td>
</tr>
<tr>
<td>Folder No. (100 – 999)</td>
<td>Month (1 – C)</td>
</tr>
<tr>
<td>Day (01 – 31)</td>
<td></td>
</tr>
</tbody>
</table>


There are two settings from which you can choose: RESET or AUTO. Choose the one that is best for you when transferring images to a PC.

**File name settings**

**RESET** The file number and folder number are reset every time a new card is inserted in the camera. The folder number returns to No. 100 and the file number returns to No. 0001. This method is useful when grouping files on separate cards.

**AUTO** Even if a new card is inserted, the folder number and file number are retained from the previous card, so the same file number is not used on different cards. This helps you to manage multiple cards. This method is useful when you want to manage all your files with sequential numbers.

**1 In the top menu, select MODE MENU → SETUP → FILE NAME → RESET or AUTO, and press .**

- “How to use the menus” (P.35)

  - Press again to exit the menu.
PIXEL MAPPING

- When the File No. reaches 9999, the file number returns to 0001 and the folder number changes.
- When both the Folder and File No. reach their respective maximum number (999/9999), the number of storable pictures becomes 0 even if the card is not full. No more pictures can be taken. Replace the card with a new one.

Note

PIXEL MAPPING

The Pixel Mapping feature allows the camera to check and adjust the CCD and image processing functions. It is not necessary to operate this function frequently. Approximately once a year is recommended. Wait at least one minute after taking or viewing pictures to allow for proper performance of the Pixel Mapping function.

1 In the top menu, select MODE MENU → SETUP → PIXEL MAPPING, and press .

- START appears.

2 Press .
- The BUSY bar is displayed during Pixel Mapping. When Pixel Mapping is finished, the screen returns to the mode menu.

Note

- If you accidentally turn the camera off during Pixel Mapping, start again from Step 1.
Measurement units

The measurement unit can be selected from either meters or feet in the manual focus mode.

\[ \text{m} \quad \text{At long ranges, the camera measures in meters, and at short ranges in centimeters.} \]

\[ \text{ft} \quad \text{At long ranges, the camera measures in feet, and at short ranges in inches.} \]

1. In the top menu, select MODE \( \text{MENU} \rightarrow \text{SETUP} \rightarrow \text{m/ft} \rightarrow \text{m or ft}, \) and press \( \text{OK} \).

   “How to use the menus” (P.35)

   • Press \( \text{OK} \) again to exit the menu.
VIDEO OUT – Video output selection

You can select NTSC or PAL according to your TV’s video signal type. When playing back pictures while connected to a TV in a foreign country, be sure to set the VIDEO OUT setting accordingly. Select the video signal type before connecting the AV cable. If you select the wrong video signal type, you will not be able to play back the recorded pictures properly on the TV.

1. In the top menu, select MODE MENU → SETUP → VIDEO OUT → NTSC or PAL, and press OK.

   “How to use the menus” (P.35)

   • Press OK again to exit the menu.

TIPS

TV video signal types & main regions
Check the video signal type before connecting the camera to the TV.

- NTSC  Japan, Taiwan, Korea, North America
- PAL    European countries, China
Print reservation allows you to save printing data (the number of prints and the date/time information) with the pictures stored on the card. With print reservation, you can print out pictures easily either at home using a personal DPOF-compatible printer or at a print shop that supports DPOF. DPOF is a standard format used to record automatic print information from digital cameras. You can print out pictures automatically, at home or in a print shop, by storing such data as which pictures you wish to print and the number of prints on a card.

Pictures taken with print reservation can be printed using the following procedures.

**Printing using a DPOF-compatible print shop.**
You can print the pictures using the print reservation data.

**Printing using a DPOF-compatible printer.**
Printing is possible directly from a card containing print reservation data without using a PC. For more details, refer to the printer’s instruction manual. A PC card adapter may also be necessary.
Picture size and printing

The resolution of a computer/printer is generally based on the number of dots (pixels) per square inch. This is called dpi (dots per inch). The higher the dpi value, the better the printed results. Keep in mind, however, that the dpi of the picture does not change. This means that when you print an image with a higher resolution, the size of the printed picture will be smaller. Although you can print magnified images, picture quality will decrease.

If you want to print large, high-quality pictures, set the record mode as high as possible when taking the pictures. “Record mode” (P.106)

- DPOF reservations set by another device cannot be changed by this camera. Make changes using the original device.
- If a card contains DPOF reservations set by another device, entering reservations using this camera may overwrite the previous reservations.
- If there is not enough space in the card memory, you may not be able to enter the reservation data. CARD FULL will be displayed.
- You can make DPOF print reservations for up to 999 images per card.
- Even if an image appears with the message “PICTURE ERROR”, it may be possible to make print reservations. In this case, the print reservation icon (HDR) does not appear when the image is displayed for full view. HDR appears when multiple images are displayed (index display), allowing you to confirm the print reservation.
- Not all functions may be available on all printers, at all print shops, or at all photo labs.
- Some TIFF images cannot be printed.
- Print reservation may take considerable time when saving printing data to a card.
All-frame reservation

Use this feature to print all the pictures stored on the card. Select the desired number of prints and whether you want the date and time included.

1. **Play back a still picture.**
   - “Viewing still pictures” (P.124)
   - You cannot make the print reservation for pictures with 📸.

2. **In the top menu, select MODE MENU → PLAY → ☘, and press 🔄.**
   - “How to use the menus” (P.35)
   - If print reservation data is already stored on the card, the ☘ PRINT ORDER SETTING screen appears, giving you the choice of resetting the data or keeping it.

3. **Press 📚 📚 to select ☘ALL, then press ☄.**

4. **Press 📚 📚 to select ☘× (number of prints) or ☃ (date/time), then press 🔄.**
5 Perform each setting as illustrated.

Set the number of prints
Press \(\uparrow\uparrow\) to set the number of prints, then press \(\downarrow\).
\(\uparrow\) : Increases the number.
\(\downarrow\) : Decreases the number.

Set the date/time printing data
Press \(\uparrow\uparrow\) to select NO, DATE or TIME, then press \(\downarrow\).
NO The pictures are printed without the date and time.
DATE All the pictures are printed with the shooting date.
TIME All the pictures are printed with the shooting time.
• After completing all the print reservations, press \(\downarrow\) to return to the menu screen.
Single-frame reservation

Use this feature to print only selected pictures. Display the picture to be printed and select the desired number of prints.

1. Play back a still picture.
   
   “Viewing still pictures” (P.124)
   
   • You cannot make the print reservation for pictures with " ◦."

2. In the top menu, select MODE MENU → PLAY → ◦, and press ◦.
   
   “How to use the menus” (P.35)
   
   • If data is already stored on the card, the ◦ PRINT ORDER SETTING screen appears, giving you the choice of resetting the data or keeping it.

3. Press ◦ ◦ to select ◦, then press ◦.

4. Select the frame you want to print using the arrow pad and press ◦.
5 Select the appropriate item using the arrow pad.

MORE
Sets the number of prints, date/time and trim size. The print reservation data is set and the screen proceeds to Step 6.

SINGLE PRINT
Sets single-frame print. The date/time and trimming settings are not available. → Go to Step 9.

CANCEL
Cancels the print reservation for the displayed picture. “Resetting print reservation data” (P.182)

END
Completes the print reservation. → Go to Step 11.

6 Press \[ \text{\(\times\)} \] to select \[ \text{\(\times\)} \] (number of prints), \[ \text{\(\times\)} \] (date/time) or \[ \text{\(\times\)} \] (trimming), then press \[ \text{\(\times\)} \] .

7 Perform each setting.

● Set the number of prints
Press \[ \text{\(\times\)} \] to set the desired number of prints, then press \[ \text{\(\times\)} \] .
\[ \text{\(\times\)} \] : Increases the number.
\[ \text{\(\times\)} \] : Decreases the number.

● Set the date/time printing data
Press \[ \text{\(\times\)} \] to select NO, DATE or TIME, then press \[ \text{\(\times\)} \] .

NO
The pictures are printed without the date and time.

DATE
All the selected pictures are printed with the shooting date.

TIME
All the selected pictures are printed with the shooting time.
Trim the picture

“Trimming” (P.180)

8 After setting the number of prints and date/time printing data and trimming the picture, press \( \text{ } \) to complete the print reservations and return to the screen in Step 4.
   • The \( \text{ } \) icon appears on the displayed picture.
   • Repeat Steps 4 to 8 to make print reservations for other images.

9 Press \( \text{ } \) to display the single-frame reservation menu.

10 Press \( \text{ } \).
   • The \( \text{ } \) PRINT ORDER screen appears.

11 Press \( \text{ } \) again to display the \( \text{ } \) PRINT ORDER SETTING screen, then press \( \text{ } \) once more to complete the print reservations.
Trimming

This function enables you to crop part of a recorded picture and print out the enlarged section only.

1. **Press 📷 📷 on the single-frame reservation screen to select 📷 (trimming) and press 📷.**
   - If trimming has already been set, the 📷 screen appears. Press 📷 📷 to select RESET, then press 📷.

2. **Use the arrow pad and zoom lever to decide the trimming position and size.**
   - Press 📷 📷 📷 📷 to move the trimming frame.
   - Use the zoom lever to decide the trimming size. The trimming frame changes from horizontal to vertical and vice versa when the maximum or minimum size is reached.

3. **Press 📷.**
4 **Press**  to select OK, then press  .

- **OK** Saves the current trimming size and returns to the single-frame reservation screen.
- **RESET** Sets a new trimming size. → Go to Step 2.
- **CANCEL** Cancels the current trimming setting and returns to the single-frame reservation screen.

5 **Press**  to complete the print reservations and return to the picture selection screen. Press  again.

6 **Press**  to select END.

- The  PRINT ORDER screen appears.
- Press  repeatedly until the playback screen appears.

---

**Note**

- The size of the printed picture varies depending on the printer settings. If the trimmed picture size is small, printing magnification increases accordingly, resulting in a printed picture with lower resolution.
- For the best results in enlarged prints, you are recommended to use the TIFF, SHQ or HQ mode.
- The original picture is not trimmed. If your printer does not have the trimming function, the picture will be printed untrimmed.
- Do not rotate pictures that have been trimmed, otherwise the cropped area will change.
Reseting print reservation data

This function allows you to reset the print reservation data for pictures stored on the card.
You can reset all the print reservation data or just for selected pictures.

**To reset the print reservation data for all the pictures**

1. In the top menu, select MODE MENU → PLAY → , and press .
   - “How to use the menus” (P.35)

2. Press to select RESET, then press .
   - If there is no print reservation data stored on the card, the PRINT ORDER SETTING screen does not appear.

3. Press to return to the mode menu.
   - Press again to exit the menu.
To reset the print reservation data for a selected picture

1. In the top menu, select MODE MENU → PLAY → <, and press.
   “How to use the menus” (P.35)

2. Press to select KEEP, then press.
   • If there is no print reservation data stored on the card, the PRINT ORDER SETTING screen does not appear.

3. Press to select , then press.

4. Select the frame for which you want to reset the print reservation using the arrow pad and press.
   • The single-frame reservation menu is displayed.

5. Press to select CANCEL.
   • The print reservation data is canceled and the screen returns to Step 4.

6. If you are finished resetting print reservation data, press.
   • The single-frame reservation menu is displayed.

7. Press.
   • Press repeatedly until the menu screen appears. Press again to exit the menu.
10 Direct printing (PictBridge)

Using the direct printing function

By connecting the camera to a PictBridge-compatible printer with the USB cable, you can print out recorded pictures directly. With the camera connected to the printer, select the pictures you want to print and the number of prints on the camera’s monitor. It is also possible to print out pictures using the print reservation data. “Print setting (DPOF)” (P.173)

To find out if your printer is compatible with PictBridge, refer to the printer’s instruction manual.

What is PictBridge? … It is the standard for connecting digital cameras and printers of different manufacturers and printing out pictures directly.

STANDARD … All printers that support PictBridge have standard print settings. Selecting STANDARD on the settings screens (P.189 to 196), images are printed according to this setting. See the instruction manual for your printer for its standard settings or inquire with the printer manufacturers.

TIPS

• For details of printing paper types, ink cassettes, etc., refer to the printer’s instruction manual.

Note

• You are recommended to use the optional AC adapter when printing pictures. If you use the battery, make sure that it is fully charged. If the camera stops operating while communicating with the printer, the printer may malfunction or image data may be lost.
• Images recorded in movie mode cannot be printed.
• The camera will not enter sleep mode when connected to the USB cable.
Connecting the camera to a printer

Use the USB cable provided to connect the camera to a PictBridge-compatible printer.

1. **Turn the printer on and plug the printer end of the USB cable into the printer’s USB port.**
   - For details of how to turn the printer on and the position of the USB port, refer to the printer’s instruction manual.

2. **Plug the USB cable into the camera’s USB connector.**

3. **Slide the power switch to \( \Rightarrow \) to turn the camera on.**
   - The monitor turns on and the selection screen for the USB connection is displayed.

4. **Press \( \Rightarrow \Rightarrow \) to select PRINT, then press \( \Rightarrow \).**
   - ONE MOMENT is displayed and the camera and printer are connected. The PRINT MODE SELECT screen is displayed on the monitor. Make the print settings on the camera’s monitor. \( \Rightarrow \Rightarrow \) Go to “Printing pictures” (P.186).

- When the USB mode is set to PC, the PRINT MODE SELECT screen is not displayed. Remove the USB cable, and repeat the procedure from Step 1.
When the camera is connected to a PictBridge-compatible printer, the PRINT MODE SELECT screen is displayed on the monitor. Use this screen to select the print mode. You can choose from the following print modes.

**PRINT**
- Prints the selected picture.
  - “PRINT mode/MULTI PRINT mode” (P.189)

**ALL PRINT**
- Prints all the pictures stored on the card.
  - “ALL PRINT mode” (P.193)

**MULTI PRINT**
- Prints one picture in multiple layout format.
  - “PRINT mode/MULTI PRINT mode” (P.189)

**ALL INDEX**
- Prints an index of all the pictures stored on the card.
  - “ALL INDEX mode/PRINT ORDER mode” (P.195)

**PRINT ORDER**
- Prints the pictures according to the print reservation data on the card. If no print reservations (P.173) have been made, this option is not available.
  - “ALL INDEX mode/PRINT ORDER mode” (P.195)

---

### Print modes and each setting

Available printing modes, paper sizes etc., vary depending on the printer you use. Please consult with the services of your printer's manufacture or to the printer manual.
Easy printing

The method described below is the easiest way to print out pictures. The selected picture is printed without the date, time or file name.

1. In the PRINT MODE SELECT screen (P.186), press \( \triangleright \triangleright \) to select PRINT, then press \( \triangleright \).
   - The PRINT PAPER screen is displayed.

2. Press \( \triangleright \triangleright \) to select the paper size, then press \( \triangleright \).
   - When the PRINT PAPER screen is not displayed, SIZE, BORDERLESS and PICS/SHEET are set to \( \leq \) STANDARD. \( \rightarrow \) Go to Step 4.

3. Use \( \triangleright \triangleright \) to select framed or unframed, then press \( \triangleright \).
   - OFF (\( \square \)) The image is printed inside a blank frame.
   - ON (\( \square \)) The image is printed filling the entire page.

4. Use \( \triangleright \triangleright \) or the control dial to select the image you want to print and press \( \triangleright \).
   - The PRINT screen is displayed.
5  Press \( \text{OK} \) to select OK, then press \( \text{OK} \).

- Printing starts.
- To cancel printing, select CANCEL and press \( \text{OK} \). The PRINT MODE SELECT screen is displayed.
- When printing is finished, the screen returns to Step 4. Repeat Steps 4 and 5 and print all the pictures you want to print.
PRINT mode/MULTI PRINT mode

1 In the PRINT MODE SELECT screen, press \( \leftrightarrow \) to select PRINT or MULTI PRINT, then press \( \circ \).
- The PRINT PAPER screen is displayed.

2 Press \( \leftrightarrow \) to select the paper size, then press \( \bullet \).
- PRINT mode: Go to Step 3.
- MULTI PRINT mode: Go to Step 4.
- When the PRINT PAPER screen is not displayed, SIZE, BORDERLESS and PICS/SHEET are set to \( \circ \), STANDARD. Go to Step 5.

3 Use \( \leftrightarrow \) to select framed or unframed, then press \( \bullet \). Go to Step 5.

   - OFF ( ) The image is printed inside a blank frame.
   - ON ( ) The image is printed filling the entire page.

4 Press \( \leftrightarrow \) to select PICS/SHEET, then press \( \bullet \).
- PICS/SHEET depends on the paper size set in Step 2 and the capabilities of your printer.
5 Press \( \mathcal{C} \) to select the picture you want to print.
• Turn the zoom lever toward W to display the pictures in index format. You can also select the pictures you want to print from the index.

6 Select the print reservation method.
**SINGLE PRINT** Makes a single-frame print reservation for the selected picture according to standard settings.
**MORE** Sets the number of prints of the selected picture in the print reservation data. You can also add the date or file name, and trim the picture.

● Set a SINGLE PRINT reservation
Press \( \mathcal{C} \).
• Press \( \mathcal{C} \) when a picture with \( \mathcal{C} \) is displayed to cancel the reservation.
● Set MORE print reservations

1. Press \(\odot\).
   • Print information settings screen is displayed.

2. Press \(\odot\) to select the item you want to set, then press \(\odot\).
   • Press \(\odot\) to select the item, then press \(\odot\).

   - \(\otimes\) \(\times\) Sets the number of prints. You can select up to 10 prints.
   - DATE (\(\odot\)) If you select WITH, pictures are printed with the date and time.
   - FILE NAME (\(\odot\)) If you select WITH, pictures are printed with the file name.
   - Crops part of a recorded picture so that only the enlarged section is printed. \(\otimes\) “Trim the picture” (P.197)
   • DATE and FILE NAME are not available in MULTI PRINT mode.

3. When you have finished all the settings for MORE, press \(\odot\).
   • The screen displayed in Step 5 appears.
   • To print more than one picture in PRINT and/or MULTI PRINT mode, repeat Steps 5 and 6 and make single and/or multiple print reservations for all the pictures you want to print.
   • \(\otimes\) is displayed in MULTI PRINT mode.

7. Press \(\odot\).
   • The PRINT screen is displayed.
8 Print the pictures.

- Press \( \text{OK/CANCEL} \) to select OK or CANCEL, then press \( \text{OK} \).

**OK** Printing starts.

**CANCEL** The settings are canceled and the monitor returns to the PRINT MODE SELECT screen.

- When printing is finished, the monitor returns to the PRINT MODE SELECT screen.

See “Exiting direct printing” (P.198)

---

**To cancel printing**

Pressing \( \text{OK/CANCEL} \) during print data transfer displays the screen for selecting whether to continue or cancel printing. To cancel printing, press \( \text{OK/CANCEL} \) to select CANCEL, then press \( \text{OK} \).

---

Direct printing (PictBridge)
ALL PRINT mode

1 In the PRINT MODE SELECT screen, press \( \text{ } \) to select ALL PRINT, then press \( \text{ } \).
- The PRINT PAPER screen is displayed.

2 Press \( \text{ } \) to select the paper size, then press \( \text{ } \).
- When the PRINT PAPER screen is not displayed, SIZE and BORDERLESS are set to \( \text{ } \) STANDARD. Go to Step 4.

3 Use \( \text{ } \) to select framed or unframed, then press \( \text{ } \).
- OFF ( ) The image is printed inside a blank frame.
- ON ( ) The image is printed filling the entire page.
- Print information settings screen is displayed.

4 Press \( \text{ } \) to select the item you want to set, then press \( \text{ } \).
- Press \( \text{ } \) to select the item, then press \( \text{ } \).
- If PRINT INFO cannot be set with your printer, go to Step 6.
- Only one print of each image can be made at a time.
- DATE ( ) If you select WITH, pictures are printed with the date and time.
- FILE NAME ( ) If you select WITH, pictures are printed with the file name.

5 Press \( \text{ } \).
- The PRINT screen is displayed.
6 Print the pictures.
• Press ◄ to select OK or CANCEL, then press ◄.

OK Printing starts.
CANCEL The settings are canceled and the monitor returns to the PRINT MODE SELECT screen.

• When printing is finished, the monitor returns to the PRINT MODE SELECT screen.
(p.198) “Exiting direct printing” (P.198)

● To cancel printing
Pressing ◄ during print data transfer displays the screen for selecting whether to continue or cancel printing. To cancel printing, press ◄ to select CANCEL, then press ◄.
ALL INDEX mode/PRINT ORDER mode

1 In the PRINT MODE SELECT screen, press ◀▶ to select ALL INDEX or PRINT ORDER, then press ◄.
   • The PRINT PAPER screen is displayed.

2 Press ◀▶ to select the paper size, then press ◄.
   • When the PRINT PAPER screen is not displayed, SIZE and BORDERLESS are set to STANDARD. Go to Step 4.

3 Use ◀▶ to select framed or unframed, then press ◄.
   OFF ( ) The image is printed inside a blank frame.
   ON ( ) The image is printed filling the entire page.
   • The print screen is displayed.
   • BORDERLESS is not available in ALL INDEX mode. Press ◄ and go to Step 4.
4 Print the pictures.
• Press \( \text{OK} \) or \( \text{CANCEL} \) to select OK or CANCEL, then press \( \text{OK} \).

  - **OK**  Printing starts.
  - **CANCEL**  The settings are canceled and the monitor returns to the PRINT MODE SELECT screen.

• When printing is finished, the monitor returns to the PRINT MODE SELECT screen.

  “Exiting direct printing” (P.198)

**To cancel printing**
Pressing \( \text{CANCEL} \) during print data transfer displays the screen for selecting whether to continue or cancel printing. To cancel printing, press \( \text{CANCEL} \) to select CANCEL, then press \( \text{OK} \).
Trim the picture

To set the trim by MORE in PRINT or MULTI PRINT mode (P.189), follow the procedure below.

1 **Use the arrow pad and zoom lever to select the trimming position and size.**
   - Press \( \rightarrow \) to move the trimming frame.
   - Use the zoom lever to decide the trimming size. The trimming frame changes from horizontal to vertical and vice versa when the maximum or minimum size is reached.
   - If trimming has already been set, the cutting line screen appears. Press \( \leftarrow \) to select RESET, then press \( \rightarrow \).

2 **Press \( \rightarrow \).**

3 **Press \( \leftarrow \) to select OK, then press \( \rightarrow \).**

   - **OK** Saves the current trimming size.
   - **RESET** Sets a new trimming size.
   - **CANCEL** Cancels the current trimming setting.

   - Press \( \rightarrow \) to complete trimming setting and return to the PRINT INFO screen.

**Note**

- The size of the printed picture varies depending on the printer settings. If the trimmed picture size is small, printing magnification increases accordingly, resulting in a printed picture with lower resolution.
- For the best results in enlarged prints, you are recommended to use the TIFF, SHQ or HQ mode.
Exiting direct printing

When you have finished printing, disconnect the camera from the printer.

1. In the PRINT MODE SELECT screen, select 3.

- The message is displayed.

2. Slide the power switch to OFF to turn the camera off.

3. Remove the USB cable from the camera.

4. Remove the USB cable from the printer.
If an error code is displayed

If an error code appears on the camera’s monitor during direct print setting or printing, see the following table. For more details, refer to the printer’s instruction manual.

<table>
<thead>
<tr>
<th>Monitor indication</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO CONNECTION</td>
<td>The camera is not connected to the printer correctly.</td>
<td>Disconnect the camera and connect it again correctly.</td>
</tr>
<tr>
<td>NO PAPER</td>
<td>There is no paper in the printer.</td>
<td>Load some paper in the printer.</td>
</tr>
<tr>
<td>NO INK</td>
<td>The printer has run out of ink.</td>
<td>Replace the ink cartridge in the printer.</td>
</tr>
<tr>
<td>JAMMED</td>
<td>The paper is jammed.</td>
<td>Remove the jammed paper.</td>
</tr>
<tr>
<td>SETTINGS CHANGED</td>
<td>The printer’s paper cassette has been removed or the printer has been manipulated while making settings on the camera.</td>
<td>Do not manipulate the printer while making settings on the camera.</td>
</tr>
<tr>
<td>PRINT ERROR</td>
<td>There is a problem with the printer and/or camera.</td>
<td>Turn off camera and printer. Check the printer and remedy any problems before turning the power on again.</td>
</tr>
</tbody>
</table>

**TIPS**

- If an error code other than those shown above is displayed, refer to “Error codes” (P.200).
## 11 Miscellaneous

### Error codes

<table>
<thead>
<tr>
<th>Monitor indication</th>
<th>Possible cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![NO CARD]</td>
<td>The card is not inserted, or it cannot be recognized.</td>
<td>Insert a card or insert a different card. If the problem persists, format the card. If the card cannot be formatted, it cannot be used.</td>
</tr>
<tr>
<td>![CARD ERROR]</td>
<td>There is a problem with the card.</td>
<td>Use a different card. Insert a new card.</td>
</tr>
<tr>
<td>![WRITE-PROTECT]</td>
<td>Writing to the card is prohibited.</td>
<td>The recorded image has been protected (read-only) on a PC. Download the image to a PC and cancel the read-only setting.</td>
</tr>
<tr>
<td>![CARD FULL]</td>
<td>The card is full. No more pictures, movies or information such as print reservations can be recorded.</td>
<td>Replace the card or erase unwanted pictures. Before erasing, download important images to a PC.</td>
</tr>
<tr>
<td>![NO PICTURE]</td>
<td>There are no pictures on the card.</td>
<td>The card contains no pictures. Record pictures.</td>
</tr>
<tr>
<td>![PICTURE ERROR]</td>
<td>There is a problem with the selected picture and it cannot be played back on this camera.</td>
<td>Use image processing software to view the picture on a PC. If that cannot be done, the image file is damaged.</td>
</tr>
<tr>
<td>![CARD-COVER OPEN]</td>
<td>The battery compartment/card cover is open.</td>
<td>Close the battery compartment/card cover.</td>
</tr>
<tr>
<td>![CARD SETUP]</td>
<td>The card is not formatted.</td>
<td>Format the card. All data on the card is deleted.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Preparatory operations

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The camera does not turn on or function buttons do not respond.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The power is off.</td>
<td>Slide the power switch to 📷 or 📷 to turn the camera on.</td>
<td>P.25</td>
</tr>
<tr>
<td>The battery is exhausted.</td>
<td>Charge the battery.</td>
<td>P.19</td>
</tr>
<tr>
<td>The battery is temporarily unable to function because of the cold.</td>
<td>Warm the battery by putting it in your pocket for a while.</td>
<td>—</td>
</tr>
<tr>
<td>The camera is in the sleep mode.</td>
<td>Operate the camera (press the shutter button or turn the zoom lever).</td>
<td>P.25</td>
</tr>
<tr>
<td>The camera is connected to a PC.</td>
<td>The camera will not operate while it is connected to a PC.</td>
<td>—</td>
</tr>
</tbody>
</table>

### Shooting

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>No picture is taken when the shutter button is pressed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The battery is exhausted.</td>
<td>Charge the battery.</td>
<td>P.19</td>
</tr>
<tr>
<td>The camera is in the playback mode.</td>
<td>Slide the power switch to 📷 or 📷.</td>
<td>P.25</td>
</tr>
<tr>
<td>The flash has not finished charging.</td>
<td>Remove your finger from the shutter button, and wait until the 📷 (flash standby) indication stops blinking. Press the shutter button again.</td>
<td>P.61</td>
</tr>
<tr>
<td>The card is full.</td>
<td>Erase unwanted pictures or insert a new card. Before erasing, download important images to a PC.</td>
<td>P.145</td>
</tr>
<tr>
<td>The battery ran out of power during shooting or while the images were being written to the card. (Monitor turns off or the battery check indicator blinks.)</td>
<td>Charge the battery. (Wait until the card access lamp turns off when flashing.)</td>
<td>P.19</td>
</tr>
<tr>
<td>The memory gauge is full.</td>
<td>Wait until there is room in the memory gauge.</td>
<td>P.17</td>
</tr>
<tr>
<td>There is a problem with the card.</td>
<td>Refer to “Error codes”.</td>
<td>P.200</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The viewfinder does not turn on.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The monitor is turned on.</td>
<td>Press 📷 to turn the viewfinder on.</td>
<td>P.51</td>
</tr>
<tr>
<td>The monitor does not turn on.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The viewfinder is turned on.</td>
<td>Press 📷 to turn the monitor on.</td>
<td>P.51</td>
</tr>
<tr>
<td>The viewfinder or monitor is hard to see.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The diopter is not adjusted properly.</td>
<td>Adjust the diopter so that the AF target mark is clearly visible.</td>
<td>P.32</td>
</tr>
<tr>
<td>There is condensation* inside the camera.</td>
<td>Wait until the camera dries before turning it on again.</td>
<td>—</td>
</tr>
<tr>
<td>The brightness of the viewfinder or monitor is not adjusted properly.</td>
<td>Select ⬇️ in the mode menu tab and adjust the brightness.</td>
<td>P.161</td>
</tr>
<tr>
<td>The monitor is exposed to direct sunlight.</td>
<td>Block the sunlight with your hand or use the viewfinder.</td>
<td>—</td>
</tr>
<tr>
<td>Vertical lines appear in the viewfinder or on the monitor screen during shooting.</td>
<td>Aiming the camera at a bright subject in sunlight may cause vertical lines to appear on the screen. This is not a malfunction.</td>
<td>—</td>
</tr>
<tr>
<td>The date recorded with the image data is wrong.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The date/time is not set.</td>
<td>Set the date/time. The clock adjustment is not factory-preset.</td>
<td>P.30</td>
</tr>
<tr>
<td>The camera has been left with the battery removed.</td>
<td>If the camera is left for one day with the battery removed, the date/time setting is canceled. Set the date/time again.</td>
<td>P.19, 30</td>
</tr>
<tr>
<td>The settings are returned to the factory default settings when the camera is turned off.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ALL RESET is set to ON.</td>
<td>Select the SETUP tab in the mode menu and set ALL RESET to OFF.</td>
<td>P.147</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The picture is out of focus.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The subject was too close.</td>
<td>Move further away from the subject. To take pictures closer than 7 cm (2.8&quot;) with the zoom in the maximum WIDE position, use the super macro mode.</td>
<td>P.90, 91</td>
</tr>
<tr>
<td>Auto focus is not possible.</td>
<td>Use manual focus or focus lock to focus on the subject and then shoot.</td>
<td>P.83, 54</td>
</tr>
<tr>
<td>There is condensation* on the lens.</td>
<td>Turn the camera off and wait until it dries before turning it on again.</td>
<td>—</td>
</tr>
<tr>
<td><strong>The monitor goes off.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The camera is in the sleep mode.</td>
<td>Operate the camera (press the shutter button or turn the zoom lever).</td>
<td>P.25</td>
</tr>
<tr>
<td>The power is turned off with the monitor off.</td>
<td>If ALL RESET in the mode menu is set to OFF, the camera settings before the power was turned off remain unchanged. Turn on the monitor, and turn off the power.</td>
<td>P.51, 147</td>
</tr>
</tbody>
</table>

*Condensation:* When it is cold outside, the water vapor in the air is rapidly cooled and turns to droplets of water. Condensation occurs when the camera is suddenly taken from a cold place into a warm room.
## Troubleshooting

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The flash does not fire.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The flash was closed.</td>
<td>Press the flash button to make the flash pop up.</td>
<td>P.61</td>
</tr>
<tr>
<td>The subject is illuminated.</td>
<td>If you want the flash to fire on a brightly illuminated subject, set the flash to fill-in mode.</td>
<td>P.61</td>
</tr>
<tr>
<td>Auto bracketing is set.</td>
<td>The flash does not fire in the auto bracketing mode. Set another mode in the DRIVE menu.</td>
<td>P.96</td>
</tr>
<tr>
<td>The camera is in the movie mode.</td>
<td>The flash does not fire in the movie mode. Slide the power switch to 📹.</td>
<td>P.56</td>
</tr>
<tr>
<td>FUNCTION is set to BLACK/WHITE BOARD.</td>
<td>The flash does not fire in the BLACK/WHITE BOARD mode.</td>
<td>P.102</td>
</tr>
<tr>
<td>Super macro mode is set.</td>
<td>The flash does not fire in the super macro mode. Cancel the super macro mode.</td>
<td>P.91</td>
</tr>
<tr>
<td>Panorama mode is set.</td>
<td>The flash does not fire in the panorama mode. Cancel the panorama mode.</td>
<td>P.98</td>
</tr>
<tr>
<td>The battery run time is brief.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>You are using the camera in a cold environment.</td>
<td>Battery performance deteriorates in low temperatures. Keep the camera warm by putting it inside your coat or clothing.</td>
<td>—</td>
</tr>
<tr>
<td>The remaining battery power is not indicated correctly.</td>
<td>When battery consumption fluctuates considerably, the camera may turn off without displaying the battery warning indicator. Charge the battery.</td>
<td>P.17, 19</td>
</tr>
</tbody>
</table>
## Playback of recorded images

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The picture is out of focus.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A subject unsuited to AF was taken.</td>
<td>Use manual focus or focus lock to focus on the subject and then shoot.</td>
<td>P.83, 54</td>
</tr>
<tr>
<td>The camera moved when the shutter button was pressed.</td>
<td>Hold the camera correctly and press the shutter button gently.</td>
<td>P.33</td>
</tr>
<tr>
<td>The flash was closed in a lighting condition requiring use of the flash.</td>
<td>Press the flash button to make the flash pop up. Camera movement occurs easily with slower shutter speeds. Use a tripod, or set the flash to AUTO.</td>
<td>P.61</td>
</tr>
<tr>
<td>The lens was dirty.</td>
<td>Clean the lens. Use a commercially available blower brush and then wipe with a lens cleaner to remove dust. Mold may form on the lens surface if the lens is left dirty.</td>
<td>P.215</td>
</tr>
<tr>
<td>The picture is too bright.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The flash was set to the fill-in flash mode.</td>
<td>Select a flash mode other than fill-in flash.</td>
<td>P.61</td>
</tr>
<tr>
<td>The center of the subject is too dark.</td>
<td>If the center of the subject is too dark, the surrounding area emerges as too bright. Adjust the exposure compensation toward minus (–).</td>
<td>P.112</td>
</tr>
<tr>
<td>The ISO is at a high setting.</td>
<td>Set the ISO to AUTO or to a low sensitivity: 64</td>
<td>P.111</td>
</tr>
<tr>
<td>The aperture value is small in A (M) mode.</td>
<td>Increase the aperture value or set the camera to P mode.</td>
<td>P.74</td>
</tr>
<tr>
<td>The shutter speed setting is too slow in S (M) mode.</td>
<td>Increase the shutter speed or set the camera to P mode.</td>
<td>P.75</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The picture is too dark.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The flash was blocked by your finger.</td>
<td>Hold the camera correctly, keeping your fingers away from the flash.</td>
<td>P.33</td>
</tr>
<tr>
<td>The subject was out of the working range of the flash.</td>
<td>Shoot within the flash working range.</td>
<td>P.62</td>
</tr>
<tr>
<td>The flash was closed.</td>
<td>Press the flash button to make the flash pop up.</td>
<td>P.61</td>
</tr>
<tr>
<td>The subject was too small and was backlit.</td>
<td>Set the flash to fill-in mode, or use the spot metering mode.</td>
<td>P.61, 85</td>
</tr>
<tr>
<td>The sequential shooting mode was used.</td>
<td>Higher shutter speeds are used when the sequential shooting mode is selected, which may result in pictures that are darker than usual. Set __ in the sequential shooting menu.</td>
<td>P.95</td>
</tr>
<tr>
<td>The center of the subject is too bright.</td>
<td>If the center of the subject is too bright, the image as a whole emerges darker. Adjust the exposure compensation toward plus (+).</td>
<td>P.112</td>
</tr>
<tr>
<td>The aperture value setting is too high in A (M) mode.</td>
<td>Decrease the aperture value or set the camera to P mode.</td>
<td>P.74</td>
</tr>
<tr>
<td>The shutter speed setting is too fast in S (M) mode.</td>
<td>Reduce the shutter speed or set the camera to P mode.</td>
<td>P.75</td>
</tr>
<tr>
<td><strong>The colors of pictures look unnatural.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Indoor lighting affected the picture's colors.</td>
<td>Set the white balance according to the lighting.</td>
<td>P.113</td>
</tr>
<tr>
<td>No white in the picture.</td>
<td>Include something white in the picture, or shoot using the fill-in flash mode.</td>
<td>P.61</td>
</tr>
<tr>
<td>The white balance setting is wrong.</td>
<td>Adjust the white balance according to the light source.</td>
<td>P.113</td>
</tr>
<tr>
<td><strong>Part of the picture is too dark.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The lens was partly blocked by your finger or the strap.</td>
<td>Hold the camera correctly, keeping your fingers and the strap away from the lens.</td>
<td>P.33</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Miscellaneous

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Halation produces unnatural colors in the picture.</strong></td>
<td>• Use a UV filter. As this may upset the overall color balance, it should only be used in the conditions described on the left. • Process the picture using a graphics application (Photoshop, Paint Shop Pro, etc.). For example, after picking up unnatural colors with a syringe tool, etc. you can select color areas, and try color conversion or saturation adjustment. For details, refer to the manual for the graphics application you are using.</td>
<td>—</td>
</tr>
</tbody>
</table>
| Pictures you have taken do not appear on the monitor.                         | **The power is off.** Slide the power switch to  
-  
. **P.124**

  **The camera is in the shooting mode.** Press the QUICK VIEW button or slide the power switch to  
-  
. **P.124, 125**

  **There are no pictures on the card.** NO PICTURE appears on the monitor. Record pictures. **—**

  **There is a problem with the card.** Refer to “Error codes”. **P.200**

  **The camera is connected to a TV.** The monitor does not function when the AV cable is connected to the camera. **P.137**

Single-frame erase and all-frame erase cannot be performed.

| **The pictures are protected.** | Display pictures with  
-  
 and press  
-  
 to cancel protection. **P.143** |
| No picture is displayed on the TV when connected to the camera.               | **The video output signal is incorrect.** Set the video output signal according to the region where used. **P.172**

  **The TV video signal setting is incorrect.** Set the TV to the video input mode. **P.137**

The viewfinder or monitor is hard to see.

| **The brightness of the viewfinder or monitor is not adjusted properly.** | Select  
-  
 in the mode menu and adjust the brightness. **P.161** |
| **The monitor is exposed to direct sunlight.** | Block the sunlight with your hand or use the viewfinder. **—** |
### When the camera is connected to a PC or printer.

<table>
<thead>
<tr>
<th>Possible cause</th>
<th>Corrective action</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer fails to connect.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PC was selected on the monitor after connecting to the printer with a USB cable.</td>
<td>Remove the USB cable, and start again from step 1 of “Connecting the camera to a printer”.</td>
<td>P.185</td>
</tr>
<tr>
<td>The printer does not support PictBridge.</td>
<td>Refer to the printer’s instruction manual or contact the manufacturer.</td>
<td>—</td>
</tr>
<tr>
<td>The camera is not recognized by the PC.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The USB driver has not been installed.</td>
<td>It is necessary to install the USB driver for Windows 98/98SE. For installation instructions, see “DIGITAL CAMERA-PC CONNECTION OPERATION MANUAL” on the CD-ROM.</td>
<td>—</td>
</tr>
<tr>
<td>The camera has not been turned on.</td>
<td>Slide the power switch to 📸 to turn the camera on.</td>
<td>P.25</td>
</tr>
</tbody>
</table>
The functions are set as follows when the camera leaves the factory.

### Shooting mode

<table>
<thead>
<tr>
<th>Function</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>F No</td>
<td>F2.8</td>
</tr>
<tr>
<td>SHUTTER</td>
<td>1/1000</td>
</tr>
<tr>
<td>Zoom</td>
<td>38mm</td>
</tr>
<tr>
<td>LCD</td>
<td>ON</td>
</tr>
<tr>
<td>AF/MF</td>
<td>AF</td>
</tr>
<tr>
<td>AF/MF</td>
<td>OFF</td>
</tr>
<tr>
<td>AF areas</td>
<td>ESP</td>
</tr>
<tr>
<td>DRIVE</td>
<td>OFF</td>
</tr>
<tr>
<td>BKT</td>
<td>±1.0 EV, 3</td>
</tr>
<tr>
<td>ISO</td>
<td>AUTO (A, S, M: 64)</td>
</tr>
<tr>
<td>A/S/M</td>
<td>A</td>
</tr>
<tr>
<td>MY MODE</td>
<td>MY MODE 1</td>
</tr>
<tr>
<td>SLOW</td>
<td>0.0</td>
</tr>
<tr>
<td>SLOW1</td>
<td></td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>OFF (SLOW: fixed on ON)</td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>OFF</td>
</tr>
<tr>
<td>FULLTIME AF</td>
<td>: OFF</td>
</tr>
<tr>
<td></td>
<td>: ON</td>
</tr>
<tr>
<td>AF MODE</td>
<td>: iESP</td>
</tr>
<tr>
<td></td>
<td>: fixed on iESP</td>
</tr>
<tr>
<td>PANORAMA</td>
<td>OFF</td>
</tr>
<tr>
<td>2 IN 1</td>
<td>OFF</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>OFF</td>
</tr>
<tr>
<td>AF AREA</td>
<td>Center</td>
</tr>
<tr>
<td>INFO</td>
<td>OFF</td>
</tr>
<tr>
<td></td>
<td>OFF</td>
</tr>
</tbody>
</table>
## List of factory default settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>(still pictures)</td>
<td>OFF</td>
</tr>
<tr>
<td>(movies)</td>
<td>OFF</td>
</tr>
<tr>
<td>SUPER ZOOM</td>
<td>OFF</td>
</tr>
<tr>
<td>TIFF</td>
<td>2288 x 1712</td>
</tr>
<tr>
<td>SHQ</td>
<td>2288 x 1712</td>
</tr>
<tr>
<td>HQ</td>
<td>2288 x 1712</td>
</tr>
<tr>
<td>SQ1</td>
<td>1280 x 960 NORMAL</td>
</tr>
<tr>
<td>SQ2</td>
<td>640 x 480 NORMAL</td>
</tr>
<tr>
<td>WB</td>
<td>AUTO</td>
</tr>
<tr>
<td>SHARPNESS</td>
<td>±0</td>
</tr>
<tr>
<td>CONTRAST</td>
<td>±0</td>
</tr>
<tr>
<td>SATURATION</td>
<td>±0</td>
</tr>
<tr>
<td>REDUCE FLICKER</td>
<td>OFF</td>
</tr>
<tr>
<td>REC VIEW</td>
<td>ON</td>
</tr>
<tr>
<td>SLEEP</td>
<td>3 MIN</td>
</tr>
<tr>
<td>FILE NAME</td>
<td>RESET</td>
</tr>
<tr>
<td>m/ft</td>
<td>m</td>
</tr>
<tr>
<td>SHORT CUT</td>
<td>A: ESP/éal, B: ő, C: ñ</td>
</tr>
<tr>
<td>CUSTOM BUTTON</td>
<td>AE LOCK</td>
</tr>
<tr>
<td>SHUTTER SOUND</td>
<td>1-LOW</td>
</tr>
</tbody>
</table>
### List of factory default settings

**Playback mode**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SWITCH FRAME</td>
<td>ALL</td>
</tr>
<tr>
<td>INFO</td>
<td>OFF</td>
</tr>
<tr>
<td>INFO</td>
<td>OFF</td>
</tr>
<tr>
<td>INFO</td>
<td>OFF</td>
</tr>
<tr>
<td>INFO</td>
<td>0°</td>
</tr>
<tr>
<td>INFO</td>
<td>OFF</td>
</tr>
<tr>
<td>INFO</td>
<td>9</td>
</tr>
<tr>
<td>INFO</td>
<td>OFF</td>
</tr>
<tr>
<td>VOLUME</td>
<td>3</td>
</tr>
</tbody>
</table>

**Others**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL RESET</td>
<td>ON</td>
</tr>
<tr>
<td>PW ON/OFF SETUP</td>
<td>ENGLISH</td>
</tr>
<tr>
<td>PW ON/OFF SETUP</td>
<td>1</td>
</tr>
<tr>
<td>PW ON/OFF SETUP</td>
<td>NORMAL</td>
</tr>
<tr>
<td>PW ON/OFF SETUP</td>
<td>Y-M-D 2004.01.01 00:00</td>
</tr>
<tr>
<td>VIDEO OUT</td>
<td>NTSC or PAL*</td>
</tr>
<tr>
<td>VIDEO OUT</td>
<td>1-LOW</td>
</tr>
</tbody>
</table>

* Settings differ according to the region where the camera is sold.
In **MY** mode, available functions vary depending on the modes set in the MY MODE SETUP menu.

<table>
<thead>
<tr>
<th>Function</th>
<th>AUTO</th>
<th>AUTO</th>
<th>A/S/M</th>
<th>A/S/M</th>
<th>P</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Zoom</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>DIGITAL ZOOM</strong></td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>SUPER ZOOM</strong></td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>AF MODE</strong></td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>FULLTIME AF</strong></td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>AF AREA</strong></td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>Manual focus</strong></td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>FLASH MODE</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AUTO</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>SLOW1</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>SLOW2</strong></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MULTI</strong></td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>AEL</strong></td>
<td>—</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AF LOCK</strong></td>
<td>—</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Miscellaneous

*1<br>When using MY mode, the flash is set to AUTO, except when the flash is set to 

*2<br>When using MY mode, 20 frames can be recorded in succession.
<table>
<thead>
<tr>
<th>Mode</th>
<th><strong>BKT</strong></th>
<th><strong>PANORAMA</strong></th>
<th><strong>2 IN 1</strong></th>
<th><strong>FUNCTION</strong></th>
<th><strong>BKT</strong></th>
<th><strong>PANORAMA</strong></th>
<th><strong>2 IN 1</strong></th>
<th><strong>FUNCTION</strong></th>
<th><strong>BKT</strong></th>
<th><strong>PANORAMA</strong></th>
<th><strong>2 IN 1</strong></th>
<th><strong>FUNCTION</strong></th>
<th><strong>BKT</strong></th>
<th><strong>PANORAMA</strong></th>
<th><strong>2 IN 1</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>auto</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>A/S/M</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>P</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>INFO</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>WB</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>iso</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>REDUCE FLICKER</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>INFO</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>ALL RESET</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>PW ON/OFF SETUP</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>REC VIEW</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SLEEP</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1: Marked for $P$ mode only

*2: Marked for $S$ mode only

*3: Marked for $M$ mode only
### Modes and Shooting Functions

**Table: Available Functions**

<table>
<thead>
<tr>
<th>Function</th>
<th>AUTO</th>
<th>📸</th>
<th>A/S/M (A/S/M)</th>
<th>P</th>
<th>🎥</th>
</tr>
</thead>
<tbody>
<tr>
<td>MY MODE SETUP</td>
<td>—</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FILE NAME</td>
<td>—</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PIXEL MAPPING</td>
<td>—</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🎨</td>
<td>—</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>m/ft</td>
<td>—</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIDEO OUT</td>
<td>—</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SHORT CUT</td>
<td>—</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUSTOM BUTTON</td>
<td>—</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SHUTTER SOUND</td>
<td>—</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- ✓: Available
- —: Not available

*1 Cannot be selected in 🎨 mode.
*2 Cannot be selected in 🎨 mode.
*3 Cannot be selected in 🎨 mode.
Camera maintenance

After use
Turn off the camera and fit the lens cap on the lens.
If you do not intend to use the camera for a long period, remove the battery.

Cleaning the camera
1. Turn off the camera. (P.25)
2. Remove the battery. (P.21) (If you are using an AC adapter, unplug the AC adapter from the camera first before removing the plug from the AC outlet.)
3. Exterior:
   → Wipe gently with a soft cloth. If the camera is very dirty, soak the cloth in mild soapy water and wring well. Wipe the camera with the damp cloth and then dry it with a dry cloth. If you have used the camera at the beach, use a cloth soaked in clean water and well wrung.
   Viewfinder and monitor:
   → Wipe gently with a soft cloth.
   Lens
   → Blow dust off the lens with a commercially available blower, then wipe gently with a lens cleaner.
   Card
   → Wipe gently with a soft, dry cloth.

Storage
• When storing the camera for extended periods, remove the battery and card, and keep in a cool, dry place that is ventilated well.
• Periodically, replace the battery, and test camera functions.

Note
• Do not use strong solvents such as benzene or alcohol, or chemically treated cloth.
• Cleaning should be done only after the battery has been removed or the AC adapter has been disconnected.
• Mold may form on the lens surface if the lens is left dirty.
• Avoid leaving the camera in places where chemical products are handled since this may result in corrosion.
How to replace the battery (CR2025) of the remote control device

1 Turn the screw on the bottom of the remote control device counterclockwise to loosen.

2 Turn the remote control device over, and remove the cover. With the battery facing up, remove the old battery and insert a new battery (CR2025) as shown.

3 Replace the cover, turn the remote control device over, and turn the screw on the bottom clockwise to tighten.

Note

- Do not apply excessive force to the remote control device.
- Never heat the remote control device or dispose of it in fire.
- The working temperature range for the remote control can be used is -10°C to 40°C (14°F to 104°F).
**Specifications**

**Product type**: Digital camera (for shooting and displaying)

**Recording system**

- **Still picture**: Digital recording, TIFF (non-compression), JPEG (in accordance with Design rule for Camera File system (DCF))
- **Applicable standards**: Exif 2.2, Digital Print Order Format (DPOF), PRINT Image Matching II, PictBridge
- **Sound with still pictures**: Wave format
- **Movie**: MPEG-4, QuickTime Motion JPEG support

**Memory**: xD-Picture Card (16 – 512 MB)

**Resolution**

- 3200 × 2400 pixels (ENLARGE SIZE: SHQ, HQ)
- 2288 × 1712 pixels (TIFF, SHQ, HQ)
- 2288 × 1520 pixels (3:2 TIFF, SHQ, HQ)
- 2048 × 1536 pixels (TIFF, SQ1)
- 1600 × 1200 pixels (TIFF, SQ1)
- 1280 × 960 pixels (TIFF, SQ1)
- 1024 × 768 pixels (TIFF, SQ2)
- 640 × 480 pixels (TIFF, SQ2)

**No. of storable pictures**

- when using a 16 MB card (without sound):
  - Approx. 1 frame (TIFF: 2288 × 1712)
  - Approx. 5 frames (SHQ: 2288 × 1712)
  - Approx. 16 frames (HQ: 2288 × 1712)
  - Approx. 49 frames (SQ1: 1280 × 960 NORMAL)
  - Approx. 165 frames (SQ2: 640 × 480 NORMAL)

**No. of effective pixels**: 4,000,000 pixels

**Image pickup device**: 1/2.5” CCD solid-state image pickup, 4,110,000 pixels (gross)

**Lens**: Olympus lens 6.3 mm to 63 mm, f2.8 to f3.7, 11 elements in 7 groups (equivalent to 38 mm to 380 mm lens on a 35 mm camera)

**Photometric system**: Digital ESP metering, spot metering system

**Aperture**: f2.8 to f8.0

**Shutter speed**: 15 to 1/1000 sec.
### Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shooting range</td>
<td>0.6 m (2 ft.) to ∞ (W), 2 m (6.6 ft.) to ∞ (T) (NORMAL)</td>
</tr>
<tr>
<td></td>
<td>0.07 m (0.2 ft.) to ∞ (W), 1.2 m (4 ft.) to ∞ (T) (macro mode)</td>
</tr>
<tr>
<td>Viewfinder</td>
<td>0.44&quot; TFT color LCD display, 240,000 pixels</td>
</tr>
<tr>
<td>Monitor</td>
<td>1.8&quot; TFT color LCD display, 118,000 pixels</td>
</tr>
<tr>
<td>Auto focus</td>
<td>TTL system autofocus</td>
</tr>
<tr>
<td></td>
<td>Contrast Detection Method</td>
</tr>
<tr>
<td>Outer connector</td>
<td>DC-IN jack, USB connector (mini-B), A/V OUT jack</td>
</tr>
<tr>
<td>Automatic calendar system</td>
<td>2000 up to 2099</td>
</tr>
</tbody>
</table>

**Operating environment**

- **Temperature**: 0°C to 40°C (32°F to 104°F) (operation)  
  -20°C to 60°C (-4°F to 140°F) (storage)
- **Humidity**: 30% to 90% (operation) /10% to 90% (storage)
- **Power supply**: Only an Olympus LI-10B lithium-ion battery  
  AC adapter specified by Olympus (optional)
- **Dimensions**: 104.5 mm (W) × 60 mm (H) × 68.5 mm (D)  
  (4.1" × 2.4" × 2.7") (excluding protrusions)
- **Weight**: 300 g (0.68 lb.) (without battery and card)

**SPECIFICATIONS ARE SUBJECT TO CHANGE WITHOUT ANY NOTICE OR OBLIGATION ON THE PART OF THE MANUFACTURER.**
Glossary of terms

A (Aperture Priority) Mode
You set the aperture yourself and the camera automatically varies the shutter speed so that the picture is taken with the best exposure.

AE (Automatic Exposure)
The camera automatically sets the exposure. The 3 AE modes available on this camera are P mode, in which the camera selects both the aperture and shutter speed, A mode, in which the user selects the aperture and the camera sets the shutter speed, and S mode, in which the user selects the shutter speed and the camera sets the aperture. In M mode, the user selects both the aperture and the shutter speed.

Aperture
The adjustable lens opening which controls the amount of light that enters the camera. The larger the aperture, the shorter the depth of field and the fuzzier the background. The smaller the aperture, the greater the depth of field and the sharper the background. Larger aperture values indicate smaller apertures, and smaller aperture values indicate larger apertures.

CCD (Charge-Coupled Device)
This converts light passing through the lens into electrical signals. On this camera, light is picked up and converted into RGB signals to build a single image.

Contrast Detection Method
This is used to measure the distance to the subject. The camera determines if the image is focused by the level of contrast in the subject.

Conventional Photograph
This refers to recording images using silver halide (the method for recording images in conventional, non-digital photography). This system is in contrast to still video and digital photography.

DCF (Design rule for Camera File system)
A standard for image files by the Japan Electronics and Information Technology Industries Association (JEITA).

Depth of field
The subject itself as well as some area to the front and rear of the subject are focused. The entire depth of this focused area, from the front to the rear of the subject, is called “depth of field”.

DPOF (Digital Print Order Format)
This is for saving desired print settings on digital cameras. By entering which images to print and the number of copies of each, the user can easily have the desired images printed by a printer or print lab that supports the DPOF format.
Eclipsing (Vignetting)
This refers to when an object obscures part of the field of view so that the whole subject is not photographed. Vignetting also refers to when the image seen through the viewfinder does not exactly match the image shot through the objective lens, so the photographed image includes objects not seen through the viewfinder. In addition, vignetting can occur when an incorrect lens hood is used, causing shadowing to appear in the corners of the image.

ESP (Electro-Selective Pattern) Light Metering/Digital ESP Light Metering
This determines the exposure by metering and calculating the light levels in the center and other areas of the image separately.

EV (Exposure Value)
A system for measuring exposure. EV0 is when the aperture is at F1 and the shutter speed is 1 second. The EV then increases by 1 each time the aperture increases by one F stop or the shutter speed increases by one increment. EV can also be used to indicate brightness and ISO settings.

Exposure
The amount of light used to capture an image. The exposure is determined by the time the shutter is open (shutter speed) and the amount of light that passes through the lens (aperture).

Flash Bracket
A mount used to attach an external flash to the camera. Shadows on the subject can be changed by detaching the flash. The flash is used in combination with the flash cable.

ISO
A method for indicating film speed by the International Organization for Standardization (ISO) (e.g. “ISO100”). Higher ISO values indicate greater sensitivity to light, so images can be exposed even in low-light conditions.

JPEG (Joint Photographic Experts Group)
A compression format for still images. Photographs (images) shot using this camera are recorded onto the card in JPEG format when the Record mode is set to SHQ, HQ, SQ1 or SQ2. By downloading these images to a personal computer, users can edit them using graphics application software or view the images using an Internet web browser.

M (Manual) Mode
The user sets both the aperture and shutter speed.
MPEG (Motion Picture Experts Group)
A compression format for movies. When the record mode is set to MPEG4, movies are recorded in MPEG4 format. The recording speed of 30 frames per second produces high quality movies.

NTSC (National Television Systems Committee) / PAL (Phase Alternating Line)
Television formats. NTSC is mainly used in Japan, North America and Korea. PAL is mainly used in Europe and China.

P (Program) Mode
Also called Program AE mode. The camera automatically sets the best shutter speed and aperture for the shot.

PictBridge
A standard for connecting digital cameras and printers of different makers and printing out pictures directly.

Pixels
A pixel is the smallest unit (dot) used to make up an image. Clear large-sized printed images require millions of pixels.

Resolution
The size of an image expressed by the number of pixels that make up the image. For instance, a picture taken in 640 × 480 resolution is the same size as the screen when the monitor setting is 640 × 480. However, if the monitor setting is 1024 × 768, the picture only takes up part of the screen.

Ring Flash
A flash unit that uses a circular xenon fluorescent tube as its light source. It is used for taking close-ups.

S (Shutter Priority) Mode
Also called Shutter Priority AE mode. The user selects the shutter speed and the camera automatically varies the aperture so that the picture is taken with the best exposure.

Sleep Mode
A mode designed to save battery life. The camera automatically enters the sleep mode if you do not operate it for a certain time. To get out of the sleep mode, use any button on the camera (shutter button, arrow pad, etc.).

Synchro Terminals
Terminals on an external flash unit for connecting it to the camera.
**TFT (Thin-Film Transistor) Color Monitor**
A transistor color monitor constructed using thin-film technology.

**TIFF (Tagged Image File Format)**
A format used for saving highly detailed black and white or color image data. TIFF image files can be handled by software programs for scanners and graphics applications. This camera uses TIFF in an uncompressed format.

**TTL (Through-The-Lens) System**
To help adjust exposure, a light receptor built into the camera directly measures the light passing through the lens.

**TTL-AUTO**
For use with an external flash. Light emitted by the flash is measured by the light receptor in the camera as it passes through the lens. A signal is then sent to adjust the external flash intensity.
### List of menus

#### • Mode (AUTO)

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Setting</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>DRIVE</td>
<td>( \text{Hi}, \text{Hi}, \text{Af} )</td>
<td>P.95</td>
</tr>
<tr>
<td></td>
<td>SHQ 2288 × 1712, HQ 2288 × 1712,</td>
<td>P.106</td>
</tr>
<tr>
<td></td>
<td>SQ1 1280 × 960, SQ2 640 × 480</td>
<td></td>
</tr>
<tr>
<td>CARD SETUP</td>
<td>YES, NO</td>
<td>P.158</td>
</tr>
</tbody>
</table>
### List of menus

**mode (Auto/Manual Mode)**

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Setting</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>CAMERA</td>
<td>ESP (Esp)</td>
<td>ESP, ESP, MULTI</td>
<td>P.85,86</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DRIVE*1</td>
<td>OFF, DRIVE, HI, AF BKT*5</td>
<td>P.95</td>
</tr>
<tr>
<td>ISO</td>
<td></td>
<td>AUTO, 64, 100, 200, 400</td>
<td></td>
<td>P.111</td>
</tr>
<tr>
<td>A/S/M*2</td>
<td></td>
<td>A/S/M</td>
<td></td>
<td>P.73</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MY MODE 1 – MY MODE 4</td>
<td></td>
<td>P.77</td>
</tr>
<tr>
<td></td>
<td></td>
<td>-2.0 – +2.0</td>
<td></td>
<td>P.68</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SLOW1, SLOW2</td>
<td></td>
<td>P.67</td>
</tr>
<tr>
<td>NOISE REDUCTION*4</td>
<td></td>
<td>OFF, ON</td>
<td></td>
<td>P.120</td>
</tr>
<tr>
<td>DIGITAL ZOOM*6</td>
<td></td>
<td>OFF, ON</td>
<td></td>
<td>P.60</td>
</tr>
<tr>
<td>FULLTIME AF</td>
<td></td>
<td>OFF, ON</td>
<td></td>
<td>P.79</td>
</tr>
<tr>
<td>AF MODE</td>
<td></td>
<td>iESP, SPOT</td>
<td></td>
<td>P.78</td>
</tr>
<tr>
<td>PANORAMA *7</td>
<td></td>
<td></td>
<td></td>
<td>P.98</td>
</tr>
<tr>
<td>2 IN 1</td>
<td></td>
<td></td>
<td></td>
<td>P.100</td>
</tr>
<tr>
<td>FUNCTION</td>
<td></td>
<td>OFF, BLACK &amp; WHITE, SEPIA, WHITE BOARD, BLACK BOARD</td>
<td></td>
<td>P.102</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AF AREA</td>
<td></td>
<td>P.80</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INFO</td>
<td>OFF, ON</td>
<td>P.160</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(still pictures)</td>
<td>OFF, ON</td>
<td>P.122</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SUPER ZOOM</td>
<td>OFF, ON</td>
<td>P.103</td>
</tr>
<tr>
<td>PICTURE</td>
<td></td>
<td><strong>TIFF, SHQ, HQ, SQ1, SQ2</strong></td>
<td></td>
<td>P.106</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WB</td>
<td>AUTO, PRESET, WB</td>
<td>P.113</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WB*3</td>
<td>RED7 – BLUE7</td>
<td>P.116</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SHARPNESS</td>
<td>-5 – +5</td>
<td>P.117</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CONTRAST</td>
<td>-5 – +5</td>
<td>P.118</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SATURATION</td>
<td>-5 – +5</td>
<td>P.119</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CARD</td>
<td>CARD SETUP</td>
<td>YES, NO</td>
</tr>
</tbody>
</table>

To the next page
### List of menus

**[Camera mode]**

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Setting</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>SETUP</td>
<td>ALL RESET*8</td>
<td>OFF, ON</td>
<td>P.147</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PW ON/OFF SETUP</td>
<td>OFF, 1, 2</td>
<td>P.167</td>
</tr>
<tr>
<td></td>
<td></td>
<td>REC VIEW</td>
<td>OFF, ON</td>
<td>P.162</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SLEEP</td>
<td>30 SEC, 1 MIN, 3 MIN, 5 MIN, 10 MIN</td>
<td>P.163</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MY MODE SETUP</td>
<td>CURRENT, RESET, CUSTOM</td>
<td>P.155</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FILE NAME</td>
<td>RESET, AUTO</td>
<td>P.169</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PIXEL MAPPING</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>m/ft</td>
<td>m, ft</td>
<td>P.171</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VIDEO OUT</td>
<td>NTSC, PAL</td>
<td>P.172</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SHORT CUT</td>
<td>A, B, C</td>
<td>P.152</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CUSTOM BUTTON</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SHUTTER SOUND</td>
<td>OFF, 1, 2</td>
<td>P.164</td>
</tr>
</tbody>
</table>

---

*1 Not available in [Recording mode](#).
*2 Only available in A/S/M modes.
*3 Only available in [Continuous shooting mode](#).
*4 Not available in [Video mode](#).
*5 Not available in M mode.
*6 Not available in [Movie mode](#).
*7 Not available in A/S/M modes.
*8 Not available in [Video mode](#).
### List of menús

#### 226

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Setting</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>CAMERA</td>
<td>ESP/</td>
<td>ESP,</td>
<td>P.85</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFF,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>AUTO,</td>
<td>64, 100, 200, 400</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>FULLTIME AF</td>
<td>OFF, ON</td>
<td>P.79</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FUNCTION</td>
<td>OFF, BLACK &amp; WHITE, SEPIA</td>
<td>P.102</td>
</tr>
<tr>
<td></td>
<td></td>
<td>REDUCE FLICKER</td>
<td>OFF, ON</td>
<td>P.104</td>
</tr>
<tr>
<td></td>
<td>PICTURE</td>
<td>WÍB</td>
<td>RED7 – BLUE7</td>
<td>P.116</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SHARPNESS</td>
<td>-5 – +5</td>
<td>P.117</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CONTRAST</td>
<td>-5 – +5</td>
<td>P.118</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SATURATION</td>
<td>-5 – +5</td>
<td>P.119</td>
</tr>
<tr>
<td></td>
<td>CARD SETUP</td>
<td>YES, NO</td>
<td></td>
<td>P.158</td>
</tr>
<tr>
<td></td>
<td>ALL RESET</td>
<td>OFF, ON</td>
<td></td>
<td>P.147</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ENGLISH, Franzés, Deutsch, Español, Italiano, Русский, Portugues, 日本語</td>
<td>P.28</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PW ON/OFF SETUP</td>
<td>OFF, 1, 2</td>
<td></td>
<td>P.167</td>
</tr>
<tr>
<td></td>
<td>FILE NAME</td>
<td>RESET, AUTO</td>
<td></td>
<td>P.169</td>
</tr>
<tr>
<td></td>
<td>PIXEL MAPPING</td>
<td></td>
<td></td>
<td>P.170</td>
</tr>
<tr>
<td></td>
<td>VIDEO OUT</td>
<td>NTSC, PAL</td>
<td></td>
<td>P.172</td>
</tr>
<tr>
<td></td>
<td>DIGITAL ZOOM</td>
<td>OFF, ON</td>
<td></td>
<td>P.60</td>
</tr>
<tr>
<td></td>
<td>WB</td>
<td>AUTO, PRESET,</td>
<td></td>
<td>P.106</td>
</tr>
</tbody>
</table>

**Miscellaneous**

11
## List of menus

### ● mode (still pictures)

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Setting</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>PLAY</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OFF, ON</td>
<td>P.173</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>START</td>
<td>P.122</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>EDIT</td>
<td></td>
<td>640 × 480, 320 × 240, CANCEL</td>
<td>P.140</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NEW FILE, CANCEL</td>
<td>P.141</td>
</tr>
<tr>
<td></td>
<td>CARD</td>
<td></td>
<td>ALL ERASE, FORMAT</td>
<td>P.146, 158</td>
</tr>
<tr>
<td></td>
<td>SETUP</td>
<td></td>
<td>OFF, ON</td>
<td>P.147</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ALL RESET</td>
<td>ENGLISH, FRANCAIS, DEUTSCH, ESPAÑOL, ITALIANO, РУССКИЙ, PORTUGUES, 日本語</td>
<td>P.28</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PW ON/OFF SETUP</td>
<td>OFF, 1, 2</td>
<td>P.167</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SCREEN SETUP</td>
<td></td>
<td>P.168</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>P.161</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VIDEO OUT</td>
<td>NTSC, PAL</td>
<td>P.172</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4, 9, 16</td>
<td>P.128</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VIDEO OUT</td>
<td>OFF, 1, 2</td>
<td>P.164</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VOLUME</td>
<td></td>
<td>P.166</td>
</tr>
<tr>
<td></td>
<td>INFO</td>
<td></td>
<td></td>
<td>P.129</td>
</tr>
<tr>
<td></td>
<td>SWITCH FRAME</td>
<td>ALL, 0n</td>
<td></td>
<td>P.160</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>P.144</td>
</tr>
</tbody>
</table>
### List of menus

#### mode (movies)

<table>
<thead>
<tr>
<th>Top menu</th>
<th>Tab</th>
<th>Function</th>
<th>Setting</th>
<th>Ref. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE MENU</td>
<td>CARD</td>
<td>CARD SETUP</td>
<td>ALL ERASE, FORMAT</td>
<td>P.146, 158</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SETUP</td>
<td>ALL RESET</td>
<td>P.147</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ENGLISH, FRANÇAIS, DEUTSCH, ESPAÑOL, ITALIANO, Русский, ПОРТУГУЗЕ, 日本語</td>
<td>P.28</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PW ON/OFF SETUP</td>
<td>OFF, 1, 2</td>
<td>P.167</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PW ON/OFF SETUP</td>
<td>P.161</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PW ON/OFF SETUP</td>
<td>P.30</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VIDEO OUT</td>
<td>NTSC, PAL</td>
<td>P.172</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>VIDEO OUT</td>
<td>P.128</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VOLUME</td>
<td>OFF, 1, 2</td>
<td>P.166</td>
</tr>
<tr>
<td>MOVIE PLAY</td>
<td>MOVIE PLAYBACK</td>
<td>PLAYBACK, FRAME BY FRAME, CAPTURE, EXIT</td>
<td>P.130</td>
<td></td>
</tr>
<tr>
<td></td>
<td>INDEX</td>
<td>OK, RESET, CANCEL</td>
<td>P.133</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EDIT</td>
<td>OK, RESET, CANCEL</td>
<td>P.135</td>
<td></td>
</tr>
<tr>
<td>INFO</td>
<td></td>
<td></td>
<td>P.160</td>
<td></td>
</tr>
<tr>
<td>SWITCH FRAME</td>
<td></td>
<td>ALL, ON</td>
<td>P.144</td>
<td></td>
</tr>
</tbody>
</table>
## Index

<table>
<thead>
<tr>
<th>letter</th>
<th>page</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>144</td>
</tr>
<tr>
<td>1st curtain SLOW1</td>
<td>65</td>
</tr>
<tr>
<td>1st curtain with red-eye reduction SLOW1</td>
<td>66</td>
</tr>
<tr>
<td>2 IN 1 2 IN 1</td>
<td>100</td>
</tr>
<tr>
<td>2nd curtain SLOW2</td>
<td>66</td>
</tr>
<tr>
<td>3:2</td>
<td>107</td>
</tr>
</tbody>
</table>

### A

**A/S/M.** 73
A/V OUT jack. 12, 137
AC adapter 24
AE 219
AE lock AEL 88
AE Lock/Custom button AEL/ 13, 81, 86, 88, 149
AE memory MEMO 89
AF 83
AF AREA 80
AF LOCK 81
AF MEMORY 82
AF MODE 78
AF sequential shooting AF 95
AF target mark 51, 80
ALL RESET 147
All-frame erase 146
All-frame reservation 175
Aperture priority shooting A 49, 74
Aperture value 74
Arrow pad 13, 34, 124
Auto bracketing BKT 96
Auto white balance 113
Auto-flash 64
AV cable 137

### B

Battery 19
Battery check 17
Battery compartment/card cover 13, 21
Beep sound 164
BLACK & WHITE 102
BLACK BOARD 102

### C

Camera movement warning 52, 63
CAPTURE 132
Card 20
Card access lamp 13, 52
Card check 27
CARD SETUP 158
CCD 219
Charger 19
Close-up playback Q 126
Cloudy day 114
Compression 106
Connector cover 12, 24, 137, 185
CONTRAST @ 118
Creating an index 133
CUSTOM BUTTON 149

### D

Date and time 30
DCF 219
DC-IN jack 12, 24
DIGITAL ZOOM 60
Dioptr adjustment dial 13, 32
Direct printing 184
DPOF 173, 219
DRIVE 95

### E

Editing a movie 135
ENLARGE SIZE 107
Erase button 13, 145
Erasing pictures 145
Error codes 199, 200
ESP metering 85, 220
Index

EV .......................... 220
Exposure ...................... 88, 220
Exposure compensation ...... 112
Exposure differential ...... 76
External flash ................ 69

F
File name ......................... 169
FILE NAME ...................... 169
File No ......................... 169
Fill-in flash  .................. 64
Flash ......................... 12, 61
Flash button ................... 13, 61
Flash charging ................. 63
Flash intensity control ....... 68
Flash mode ...................... 61
Flash mode button  .......... 13, 61
Flash off  ....................... 65
Flash stand-by ................. 52
Fluorescent lamp .............. 114
Focus .................. 52, 54, 78
Focus Lock  ....................... 54
FORMAT ......................... 158
Frame number .................. 16
Full-auto shooting AUTO .... 47
FULLTIME AF .................... 79
FUNCTION ....................... 102

G
Green lamp ....................... 52

H
HIGH ..................... 106
High speed sequential shooting HI .......................... 95
Histogram display .......... 122
Hot shoe ......................... 12, 69
HQ ............................. 106, 110
I
iESP .......................... 78
Index display INFO ............. 127
Information display INFO ...... 160
ISO ....................... 111, 220

J
JPEG ....................... 108, 220

L
Landscape + Portrait shooting ........................................... 48
Landscape shooting .......... 48
Language ........................ 28
Lens ......................... 12
Lens cap ......................... 18, 25
Lens cap string ................. 18
Lithium ion battery .......... 19

M
Macro mode shooting .......... 90
Manual focus MF .......... 83
Manual shooting M .......... 50, 76
Measurement Unit m/ft (meters/feet) .................................. 171
Memory gauge .................. 17
Metering ......................... 85
Microphone ...................... 12, 103, 105, 139
Mode dial ......................... 12, 47
MODE MENU ..................... 40
Monitor ...................... 13, 14, 51, 124, 161
Monitor brightness adjustment ....................................... 161
Monitor button .......... 13, 51
MOVIE PLAY .................... 130
MOVIE PLAYBACK .............. 130
Movie record ............... 56
MPEG4 ......................... 107, 221
Multi-metering MULTI .... 86
My Mode ......................... 50, 77
MY MODE SETUP .......................... 155

N
Night Scene shooting ........................ 48
NOISE REDUCTION .......................... 120
NORMAL (Record mode) ...................... 106
NTSC ............................................. 172, 221
Number of storable still pictures ............ 51, 108

O
OK/Menu button ................................ 13, 34
One-touch white balance ...................... 114
Optical zoom ...................................... 58

P
PAL .................................................. 172, 221
PANORAMA ........................................ 98
PictBridge ........................................ 184, 221
Picture rotation .................................. 138
PIXEL MAPPING .................................. 170
Pixels ............................................... 221
Playback .......................................... 25, 124
Playback on TV .................................... 137
Portrait shooting .................................... 47
Power switch ...................................... 13, 25
Preset white balance ............................. 114
Press Fully ......................................... 52
Press Halfway ...................................... 52
Print setting ........................................ 173
Program shooting ................................. P
Protect ............................................. 143
Protect button ..................................... 13, 143
PW ON/OFF SETUP ............................... 167

Q
QUICK VIEW ....................................... 125
QUICK VIEW button .............................. 13, 125

R
REC VIEW ............................................. 162
Record mode ...................................... 106
Recording sound .................................. 103, 104, 105, 139
Recording sound with movies ................. 104
Recording sound with still pictures .......... 103
Red-eye reduction flash ......................... 64
REDUCE FLICKER .................................. 121
Remaining recording time ...................... 56, 109
Remote control .................................... 93
Remote control receiver ....................... 12, 93
Resizing ........................................... 140
Resolution .......................................... 106, 221
Rotation button ................................... 13, 138

S
SATURATION ....................................... 119
SCREEN SETUP ..................................... 168
Self-portrait shooting ......................... 48
Self-timer .......................................... 92
Self-timer/Remote control button ............ 13, 92, 93
Self-timer/Remote control lamp ............... 12, 92, 93
SEPIA ............................................. 102
Sequential shooting ............................. 95
SHARPNESS ..................................... 117
Shoe cover ......................................... 69
Shooting mode ..................................... 25, 47
SHORT CUT ........................................ 152
Shortcut Menus .................................... 37
SHQ .................................................. 106, 110
Shutter button ..................................... 12, 52, 56
Shutter priority shooting ....................... S 50, 56
SHUTTER SOUND .................................. 165
Shutter speed ....................................... 75
Single-frame erase ..................................... 145
Index

Single-frame reservation □ . . . . 177
Single-frame shooting □ . . . . 95
SLEEP . . . . . . . . . . . . . . . 163
Sleep mode . . . . . . . . . . . . 163, 221
Slideshow □ . . . . . . . . . . . . 129
Slow synchronization
SLOW . . . . . . . . . . . . . . 65, 67
Speaker . . . . . . . . . . . . . . . . 12
Sports shooting . . . . . . . . . . 48
Spot (AF mode) . . . . . . . . . . 78
Spot metering □ . . . . . . . . . 85
SQ . . . . . . . . . . . . . . . . . . 106, 110
Standard □ STANDARD . . . . 184
Startup/Shutdown screen . . . . . 26
Strap . . . . . . . . . . . . . . . . . . 18
Strap eyelet . . . . . . . . . . . . . . 12, 18
Sunny day ☀ . . . . . . . . . . . 114
Super macro shooting s . . . . 91
SUPER ZOOM . . . . . . . . . . . . . . 59
SWITCH FRAME . . . . . . . . . . . . 144

T
Taking still pictures . . . . . . . . 51
TIFF . . . . . . . . . . . . . . 106, 110, 222
Top menu . . . . . . . . . . . . . . 34
Trimming □ . . . . . . . . . . . . 141
Tripod socket . . . . . . . . . . 13
Tungsten light . . . . . . . . . . 114

U
USB cable . . . . . . . . . . . . . . 185
USB connector . . . . . . . . 12, 185

V
VIDEO OUT . . . . . . . . . . . . 172
Viewfinder . . . . . . . . . . . . 13, 14, 32, 51, 161
VOLUME . . . . . . . . . . . . . . . . 166

W
White balance WB . . . . . . . . 113
Thank you for purchasing an Olympus digital camera. This manual provides instructions on how to install the USB driver. To ensure correct installation, refer only to these installation procedures.
This manual explains in detail how to connect your Olympus digital camera to a computer. Read it carefully and keep it in a safe place for future reference.

About this manual

● The information contained in this manual may be subject to change without notice. For the latest information on the product, please consult your local Olympus representative.
● The information contained in this manual has been compiled by taking all possible measures to ensure its accuracy. However, if you find any errors or incomplete information, please contact your local Olympus representative.
● It is prohibited by copyright laws to duplicate in part or in whole the information contained in this manual, except for personal use. Reproduction without permission of the copyright owner is prohibited.
● The PC screens shown in this manual may differ slightly from the actual displays on some PC models.

Trademarks

● Microsoft and Windows are registered trademarks of Microsoft Corporation.
● Macintosh is a trademark of Apple Computer Inc.
● All other company and product names are registered trademarks and/or trademarks of their respective owners.
INDEX

Flowchart .......................... 4

Identifying the OS .................. 6

Windows (98/Me/2000/XP) .......... 8

Macintosh (OS 9/X) .................. 23

Downloading image files using other OS (For other OS users) .............. 31
By connecting the camera to a computer with the provided USB cable, images on a card can be transferred to the computer. Some OS’s (operating systems) may need a special setup before connecting to the camera for the first time. Follow the chart below.

For details, see the Olympus Corporate Site or phone customer support.

* Even if your computer has a USB connector, data transfer may not function correctly if you are using one of the operating systems listed below or if you have an add-on USB connector (extension card, etc.).
  - Windows 95/NT 4.0
  - Windows 98/98 SE upgrade from Windows 95
  - Mac OS 8.6 or lower (except Mac OS 8.6 equipped with USB MASS Storage Support 1.3.5 installed at the factory)
  - Data transfer is not guaranteed on a home-built PC system or PCs with no factory installed OS.
When connecting the camera to the computer, make sure that there is sufficient remaining battery power. When connected (transmitting) to the computer, the camera does not enter the sleep mode nor will the camera’s power turn off automatically. Depending on the camera model, when the battery power runs out or the internal temperature rises, the camera may stop operating automatically. This could cause the computer to malfunction, and any image data (file) being transmitted may be lost. Be careful when downloading files for a long period of time. Use the AC adapter (optional) when downloading files.

If you connect or disconnect the AC adapter when the camera is connected to the computer and is running on battery power, it may result in the loss of image data on the card or cause a malfunction in the computer. Before connecting or disconnecting the AC adapter, disconnect the camera from the computer and make sure that the camera is turned off.

To avoid computer malfunctions, do not turn off the camera when the camera is connected to a computer.

If the camera is connected to the computer via a USB hub, operation may not be stable if there are any compatibility problems between the computer and the hub. In such cases, do not use the hub and connect the camera directly to the computer.

You can view images using: graphics applications that support the JPEG file format (Paint Shop Pro, Photoshop, etc.); Internet browsers (Netscape Communicator, Microsoft Internet Explorer, etc.); CAMEDIA Master software; or other software. For details on using commercial graphics applications, refer to their instruction manuals.

QuickTime is needed for playing back movies. QuickTime is included on the provided software CD.

If you want to process images, make sure to download them to your computer first. Depending on the software, image files may be destroyed if the images are processed (rotated, etc.) while they are on the card.
Identifying the OS

Identify the OS on your computer before connecting the camera. How to identify the OS depends on the computer.

● Windows

1. **Double-click the “My Computer” icon on your desktop.**
   
   When the “My computer” icon is not on your desktop, click “Control Panel” from the “Start” menu.

2. **Double-click the “Control Panel” icon.**

3. **Double-click the “System” icon.**

   The way the file icons inside the folder appear may vary depending on your version of Windows. If you don't see the icon you are looking for, click on “view all Control Panel options” on the left of the window.
4 A System Properties window will appear. Note and record the “System:” information. Confirm that your system is Windows 98, 98 SE, Me, 2000 Professional or Windows XP, then press “OK” to close the window.

If your OS is Windows 98/98 SE, proceed to “Installing the USB driver for Windows 98” (p.9).
Users running Windows Me/2000/XP p.11
Users running other OS p.31

● Mac OS (Macintosh)

Select “About This Computer” from the Apple menu on the menu bar. A window appears with the name of the computer’s OS. Confirm that the OS is OS 9.0-9.2 or OS X.

Users running Mac OS 9/X p.23
Users running other OS p.31
Make sure that:

● Your computer is turned on and Windows is running.
● If you are running any applications, quit them all.
● You are recommended to power the camera using the optional AC adapter. If the battery power runs out while the computer is accessing the card in the camera, the camera will turn off in the middle of the operation and this could destroy image files (data). If you are using batteries, make sure that there is sufficient remaining battery power.

Installing the USB driver for Windows 98 (When using Windows 98/98 SE) .......................................................... 9
Connecting the camera to the computer .......................... 11
Confirming the computer recognizes the camera ............... 14
Confirming the USB driver is installed .............................. 15
Downloading images to your computer ............................ 17
Disconnecting the camera from your computer ............... 20
Installing the USB driver for Windows 98
(When using Windows 98/98 SE)

If your OS is Windows 98/98 SE, you must install the USB driver. Follow the instructions below to install the USB driver in your computer. Once it is fully installed, you do not need to repeat the procedure again.

If your OS is Windows Me/2000/XP, you do not need to install the USB driver. Proceed to “Connecting the camera to the computer” (p. 11).

1. Insert the provided software CD into your CD-ROM drive.

2. The Olympus Windows Installer should automatically launch. Click “USB Driver”.
   If the USB driver is already installed in your computer, this option will not appear.
   - This option will not appear if you are using Windows Me/2000/XP.

   If the installer is not automatically launched, select “Run..” on the “Start” menu and then execute “(drive letter):/ Information.exe”.

   **Note**
   The drive letter of the CD-ROM varies depending on the computer.
   To identify the drive letter, double-click “My Computer” on the desktop.
Installing the USB driver for Windows 98 (When using Windows 98/98 SE)

3  Click “Continue”. The installation of the USB driver will start.

4  Click “OK” to restart your computer and the installation is complete.

5  When the computer has restarted, installation is complete. If the Olympus Windows Installer screen appears, click “Close” and remove the CD-ROM from the CD-ROM drive.
Connecting the camera to the computer

Users running Windows 98/98SE need to install the USB drive before connecting the camera to your computer for the first time. (p.9)

1 Some camera models have a “USB” setting in the menu. Make sure that “PC” is selected before connecting. This is not required if your camera does not have this setting. For details on how to operate the menu, refer to your camera’s reference manual.

2 Insert the marked end of the provided USB cable into the USB port on your computer as shown below.

Note The location of the USB port varies depending on the computer. For details, refer to your computer’s manual.

3 After making sure that the camera is turned off, connect the end of the USB cable to the USB connector on the camera.

The location of the USB connector or multi connector varies depending on the camera model. Refer to the camera manual for details.
4 **Turn the camera on in **[playback] **mode.**

- Most cameras with a lens barrier turn on automatically in Step 3, with the exception of some models which require you to press the  (monitor) button or  button.

5 **When the screen shown right appears on the monitor in Step 4, use the arrow pad to select “PC” and press the OK button.**

6 **The computer recognizes the camera as a new device.**

- Depending on the camera model, when you connect the camera to the computer, the lamp on the right of the viewfinder or the self-timer lamp may light.

When you connect the camera to the computer for the first time, the computer automatically recognizes the camera. Click “OK” when the message saying that the installation is completed appears. The computer recognizes the camera as a “Removable Disk”.

Windows

---

**USB**

- P C
- PRINT
- EXIT

**Lens barrier**

**Button or** button

**Power switch**

**Mode dial**

**Arrow pad**

**OK button**

**Lamp**
Windows XP

You can download image files from the camera easily. Select “Copy pictures to folder on my computer using Microsoft Scanner and Camera Wizard”, then follow the on-screen instructions. You may also select “take no action” to bypass the Microsoft Scanner and Camera Wizard. You may then use a more advanced image viewing/editing program such as Olympus CAMEDIA Master software. For detailed instructions on downloading, refer to the CAMEDIA Master software user’s guide.

When the camera is connected to the computer, none of the camera buttons are functional.
Confirming the computer recognizes the camera

1. **Double-click the “My Computer” icon on the desktop.**
   For users running Windows XP, click “My Computer” from the “Start” menu.

2. **Make sure the “Removable Disk” icon appears in the window.**
   There may already be other “Removable Disk” icons for other devices, such as a removable media drive or USB SmartMedia Reader/Writer. In this case, the digital camera is recognized as another “Removable Disk”.
   If you cannot find the icon, the camera and computer are not connected properly. Turn the camera off, disconnect the camera from the computer and connect again, or proceed to “Confirming the USB driver is installed” (p.15) to make sure that the USB driver is fully installed.
If the computer does not recognize the camera as a Removable Disk, follow the procedure below to check whether the USB driver has been fully installed.

1. Open “My Computer” and double-click the “Control Panel” icon. For users running Windows XP, open “Control Panel” from the “Start” menu.

2. Double-click the “System” icon.

3. The System window will appear. Click the “Device Manager” tab.
4 Confirm that “OLYMPUS Digital Camera” is in the “Universal Serial Bus Controller” category.

If you cannot find the “OLYMPUS Digital Camera”, turn the camera off, disconnect the camera from the computer and start again.

Users running Windows 98/98 SE start again from “Confirming the USB driver is installed”, and Users running Windows Me/2000/XP start from “Connecting the camera to the computer”.

If the USB driver was successfully installed, you can find the following in the “Device Manager”.

– the name of the camera you have connected listed under “Disk drives”
– “OLYMPUS Digital Camera” listed as one of the items in the “Universal Serial Bus Controller” category
1  Double-click the “My Computer” icon on the desktop.
   For users running Windows XP, click “Control Panel” from the “Start” menu.

2  Double-click the “Removable Disk” icon.
   A new “Removable Disk” icon appears when the camera is connected to the computer, as the digital camera is recognized as a “Removable Disk”.

   If an error message appears when you double-click the icon, there may be a problem with one of the following:
   ① the camera’s power source (the AC adapter is not properly connected or the battery power is low)
      Make sure that the AC adapter is correctly connected or that the batteries are not running low.
   ② the card (there is no card in the camera or there is a problem with the card)
      Check that you can play back pictures stored on the card on the monitor of your digital camera.

3  Double-click the “Dcim” folder.
4 Double-click the “100olymp” folder. Image files (JPEG files) with file names such as “P1010001.jpg” are displayed.

Note
• The camera automatically assigns folder names and file names according to the following rules.

<table>
<thead>
<tr>
<th>Folder name</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Example) 100olymp</td>
<td>(Example) P1010001.jpg</td>
</tr>
<tr>
<td>Serial number</td>
<td>Month / Day / Serial number</td>
</tr>
</tbody>
</table>

• Serial numbers of image files run from 0001 to 9999.
• Serial numbers of folders run from 100 to 999.
• When file number 9999 is reached, a new folder is created and assigned the next number.
• Months January through September are expressed by the numbers 1 through 9, October by the letter A, November by B and December by C.

5 Double-click the “My Documents” icon on the desktop.
If you cannot find the icon on the desktop, select “Explorer” on the Start menu and double-click the “My Documents” icon.
The “My Documents” window is displayed.

6 **Drag & drop the image you want to save in the computer (in this case, P1010012.jpg) to the “My Documents” window.**

The image is saved in the computer (in My Documents folder).
- To select all files, choose Edit > Select all.

---

**Note**

When the image file has been downloaded to the computer, you can view images by double-clicking the image files downloaded to your computer. The files will be opened in the default image viewer of the operating system. If you want to view the image a different size or process it, you will need to open the image with software that supports JPEG or TIFF images files, such as Paint Shop Pro, Photoshop or CAMEDIA Master software.

---

**Caution**

The lamp on the right of the viewfinder or the card access lamp blinks while the image is being copied. Never open the card cover on the camera, load or remove the batteries, or connect or disconnect the AC adapter while the lamp is blinking as the image files may be destroyed.
Disconnecting the camera from your computer

If your OS is Windows Me/2000, proceed to “Windows Me/2000/XP” (p.21).

Windows 98

1. Make sure that the lamp on the right of the viewfinder or the self-timer lamp (which on some models light while the camera is connected to the computer) or the card access lamp is not blinking. The lamps and their location vary depending on the model. Refer to your camera’s reference manual.

2. Double-click the “My Computer” icon and right-click the “Removable Disk” to display the menu.

3. Click “Eject” on the menu.
4  Make sure that the lamp on the right of the viewfinder or the self-timer lamp (which on some models light while the camera is connected to the computer) or the card access lamp is not blinking.
   Depending on the camera model, the green lamp may light or lamps that were lit while the camera was connected to the computer may go off. If the lamp is not flashing, then the cable can be removed.

5  Remove the USB cable from the camera.

6  Remove the USB cable from your computer.

**Windows Me/2000/XP**

1  Make sure that the lamp on the right of the viewfinder or the self-timer lamp (which on some models light while the camera is connected to the computer) or the card access lamp is not blinking.
   The lamps and their location vary depending on the model. Refer to your camera’s reference manual.
Disconnecting the camera from your computer

2 Click the “Unplug or Eject Hardware” icon on the task bar. The message saying that the drive has been stopped appears.

3 Click on the message. The “Unplug or Eject Hardware” window appears.

4 When a message appears, click “OK”.

5 Remove the USB cable from the camera.

6 Remove the USB cable from your computer.

Caution

If the window returns the following message when you click “Unplug or Eject Hardware”, first make sure that no image data is being downloaded from the camera, and then remove the USB cable.
Make sure that:

- Your computer is turned on and Mac OS is running.
- If you are running any applications, quit them all.
- You are recommended to power the camera using the optional AC adapter.
  If the battery power runs out while the computer is accessing the card in the camera, the camera will turn off in the middle of the operation and this could destroy image files (data). If you are using batteries, make sure that there is sufficient remaining battery power.

If you are running Mac OS X, the connection to the computer and downloading the image data are verified. Restrictions such as the following may occur due to the OS.
- The image file properties are not displayed correctly.
- Images in the camera cannot be opened without first downloading them. etc.
For more details, visit the Olympus web site.

Connecting the camera to the computer ................................. 24
Downloading images to your computer................................... 26
Disconnecting the camera from your computer ..................... 30
Connecting the camera to the computer

1 Some camera models have a “USB” setting in the menu. Make sure that “PC” is selected before connecting. This is not required if your camera does not have this setting. For details on how to operate the menu, refer to your camera’s reference manual.

2 Insert the marked end of the USB cable into the USB port on your computer as shown below.

Look for this mark.

The location of the USB port varies depending on the computer. For details, refer to your computer’s manual.

3 After making sure that the camera is turned off, connect the end of the USB cable to the USB connector on the camera.

The location of the USB connector or multi connector varies depending on the camera model. Refer to the camera manual for details.
4 Turn the camera on in (playback) mode.
   • Most cameras with a lens barrier turn on automatically in Step 3, with the exception of some models which require you to press the button or button.

5 When the screen shown right appears on the monitor in Step 4, use the arrow pad to select “PC” and press the OK button.

6 The computer recognizes the camera as a new device.
   • Depending on the camera model, when you connect the camera to the computer, the lamp on the right of the viewfinder or the self-timer lamp may light.

The computer recognizes the camera automatically and an “Untitled” icon appears on the desktop. If you cannot find this icon, turn off the camera and connect again.

● Mac OS X
   When the computer has recognized the camera, the Apple Image Capture software automatically launches. p.29

When the camera is connected to the computer, none of the camera buttons are functional.
Download images to your computer

Mac OS 9

You can download images from the camera and save them in your computer (in this case, in the Hard Disk).

1. Double-click the “Untitled” icon displayed on the desktop when the camera is connected to the computer.

   ![Untitled Icon](untitled.png)

   **Note**

   If you cannot find this icon, or if an error message appears when you double-click the icon, there may be a problem with one of the following:
   - the camera’s power source (the AC adapter is not properly connected or the battery power is low)
   - the card (there is no card in the camera or there is a problem with the card)
     Check that you can play back pictures on the monitor of your camera.
   - the USB cable (the camera is not properly connected to the computer by the USB cable).
   - Apple “File Exchange” extension is not enabled.
     - Please refer to your Apple operating system manual for instructions on how to enable this extension.

2. Double-click the “Dcim” folder.

3. Double-click the “100OLYMP” folder.
Image files (JPEG files) with file names such as "P1010001.JPG" are displayed.

- The camera automatically assigns folder names and file names according to the following rules.

```
Folder name  File name
(Example)    (Example)
100OLYMP     P1010001.jpg
Serial number Month / Day / Serial number
```

- Serial numbers of image files run from 0001 to 9999.
- Serial numbers of folders run from 100 to 999.
- When file number 9999 is reached, a new folder is created and assigned the next number.
- Months January through September are expressed by the numbers 1 through 9, October by the letter A, November by B and December by C.

---

4 Double-click the "Macintosh HD" icon on the desktop.
The “Hard Disk” window is displayed.

5 Drag & drop the image you want to save in the computer (in this case, P1010012.JPG) to the “Hard Disk” window.

The image is saved in the computer (in the Hard disk).
• To select all images, click Edit > Select all.

---

When the image file has been copied to the computer, you can view images by double-clicking the image files in the “Hard Disk” folder. The files will be opened in the default image viewer of the operating system. If you want to view the image a different size or process it, you will need to open the image with software that supports JPEG or TIFF images files, such as Paint Shop Pro, Photoshop or CAMEDIA Master software.

---

The lamp on the right of the viewfinder or the card access lamp blinks while the image is being copied. Never open the card cover on the camera, load or remove the batteries, or connect or disconnect the AC adapter while the lamp is blinking as the image files may be destroyed.
Mac OS X

Malfunctions such as the following may occur due to the OS.
• If the camera is not connected correctly, a malfunction occurs in the computer.
• Date and time information of image files is not accurately displayed.
• If the card cover of the camera is opened while connecting to the computer, the “untitled” icon does not disappear from the desktop, etc.

When the computer has recognized the camera, the Apple Image Capture software dialog appears.

1. From the “Download To” menu, select a destination folder.

2. To download all images, click “Download All”.
   To selectively download images, click “Download Some” and highlight the desired images.
   The images are transferred from the camera to your computer.

**Note**
If you are operating Mac OS X and you want to download images using the same procedure as for Mac OS 9, select “File > Close” and exit the Apple Image Capture software. At this time, the camera is indicated as “unlabeled”.

**Caution**
If you use the Apple Image Capture software, images downloaded to your computer and transferred back to a card may not play back on the camera or may have other problems.
Disconnecting the camera from your computer

1. Make sure that the lamp on the right of the viewfinder or the self-timer lamp (which on some models light while the camera is connected to the computer) or the card access lamp is not blinking. The lamps and their location vary depending on the model. Refer to your camera’s reference manual.

2. Drag the “untitled” icon on the desktop to “Trash”.

3. Make sure that the lamp on the right of the viewfinder or the self-timer lamp (which on some models light while the camera is connected to the computer) or the card access lamp is not blinking. Depending on the camera model, the green lamp may light or lamps that were lit while the camera was connected to the computer may go off. If the lamp is not flashing, then the cable can be removed.

4. Remove the USB cable from the camera.

5. Remove the USB cable from your computer.
Downloading image files using other OS
(For other OS users)

Users running other OS cannot connect the camera directly to a computer.
- Windows 95
- Windows NT
- Mac OS before OS 9

For an OS listed above, you can download images directly to your computer using an optional floppy disk adapter or PC card adapter.

For details, see the Olympus Corporate Site or phone customer support.

Is your computer one of the following?
- Windows 98
- Windows 2000
- Windows Me
- Windows XP
- Mac OS 9/X

Connect the camera directly to your computer using the provided USB cable.

Use the optional USB reader/writer.*
*Certain card readers may not be compatible with Mac OS X. Check the Olympus website for the most up-to-date compatibility information.

Consult your nearest Olympus representative.